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Hub Managers

The Managers' Guide is a user manual for managing the web content and functionality of a Hub.
It progresses step-by-step through various common tasks and familiarizes the manager with the
administrative back-end interface. Managers will learn how to accomplish tasks such as:

How to get started with a new Hub
Become familiar with daily maintenance
Manage site members
Handle support tickets
And more...
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Introduction

Overview

The Managers' Guide is a user manual for managing the web content and functionality of a
HUB. It progresses step-by-step through various common tasks and familiarizes the manager
with the administrative back-end interface. Managers will learn how to accomplish tasks such
as:

Manage (add/edit/delete) site members
Manage site settings
Handle support tickets
And more ...

Community development does not end with support tickets. Check out our tutorial about how to
engage with your community.
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Administrator Area

Logging In

The Administrator Interface ( or back-end) of the HUB is where you do most of the work to set
up, configure and maintain your website. As such it must be protected from access by casual
visitors and will request a valid username and password before access to the Administrator
Interface is granted.

 

Access the Administrator Interface of the HUB by entering a special URL into the address bar of
your web browser.  If the HUB is located at https://www.example.com then you will enter the
address https://www.example.com/administrator will be shown the Administrator Interface login.

 

Enter your username and password into the relevant fields.  Click the Login button. If you login
successfully, you will  see the Administrator control panel.

Logging Out

To log out of the Administrator Interface, locate the Logout link in the top-right corner of the
Administrator Interface and click on it. Logging out will return you to the Administrator Interface
login screen. If the Logout link is grayed out and nothing happens when you click on it, then
you are probably in a screen where you have a page locked for your exclusive use. Please
close out of the page by clicking Save and Close or Close to release the page, then click on
the Logout link.
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Spam

Overview

Things to look for:

Unprofessional profile pictures
Non-Hub related information in the Bio
Unprofessional URLs/links to outside websites
Inappropriate language
Selling ads or promotional information
Non-Hub related content
Components on the Hub with links in the text box

Disable Accounts for Spam

1. Find the account that created the Spam, and then on the backend of the Hub navigate to
Users and then click on Members. Click on the name to open up account details

a. Note: You can usually be sure that the account is a spammer if they have a Hub
nonrelated website link in the URL and an unprofessional profile picture.

2. If the Public Profile box is checked, uncheck it. It is important to make the profile not
available to the public incase they have Spam links in their account

3. Uncheck the Confirmed box if the user had confirmed their account. If it is not checked
leave it unchecked

4. Change the Contact me drop-down to the Receive email updates? option
5. Change the spam account password by typing into the New Password field a long and

random password that the spammer could not figure out
6. Check the box beside the user’s name and then click Block to block the user from the

Hub
7. Click save and close
8. After disabling the spammer’s account, find the spam that the individual has put on the

Hub and delete it
9. Make sure that they account has been deactivated prior to deleting the Spam. This way

the spammers will not receive emails about their content being deleted

Antispam Plugins

To keep your Hub from being abused by spammers, enable these antispam plugins to give your
site the fighting edge.
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How It Works

For most content on the site, when a user presses save to submit a new entry—be it a blog post,
forum comment, wish, etc.— a before save event is triggered. That event allows the system to
validate and run any desired pre-processing or checks on the content before it is stored within
the database. When any anti-spam plugins are enabled, the content is handed off to each
plugin, in their defined order (see the Plugins Manager), where the plugin in turn has a chance
to evaluate the content for likelihood of being spam. If a plugin flags the content as being spam,
the process stops (i.e., the content is not passed along to the next plugin), an error is raised,
and the content fails to be stored to the database.

 

Enabling

To enable these plugins, follow these steps: 

1. Navigate to the backend of the Hub and locate the Extensions tab
2. Click on Plug-in Manager from the drop-down
3. Inside of the Plug-in Manager, locate a plugin through search and click on the title
4. Inside the plugin, change the status to Enabled and provide any API keys or change the

settings then click Save & Close

 

Available Antispam Plugins:

Antispam-Akismet: This plugin uses the remote Akismet service to scan posted
content and determine if the content has a high probability of being spam. Akismet
digests massive amounts of data from hundreds of sites a day to learn about how to
protect sites from spammers. Learn more at: http://akismet.com.

Usage of this plugin requires API credentials provided by having an Akismet account.

 

Antispam-Baba Ji Spam Detector: This plugin provides content spam section of the
mass spammer Baba Ji.

 

Antispam-Bayesian Filter: This is a spam detector that employs a basic Bayesian filter
which looks for spam headers and character strings.
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Antispam-Black List: This is a spam detector that detects black-listed words; inside the
plugin words can be added to a list to build the black list inventory.

 

Antispam-Link Rife: This is a spam detector that detects link frequency in a body of
text. This spam detector has three configuration options for determining if submitted
content is likely spam:

1. Link Frequency - Maximum number of links allowed in a text before it is
considered spam.

2. Link to Text Ratio - Ratio (In Percentage) of the number of links to the number
of words in the string. If the percentage ratio is greater than the specified ratio, it
is considered a Link Overflow.

3. Link validation - Check found links against known blacklists.

 

Antispam-Mollom: This plugin uses the remote Mollom service to scan posted content
and protect a Hub from users who post abusive content like profanity and will learn as it
grows. Learn more at: https://www.mollom.com.

Usage of this plugin requires API credentials provided by having a Mollom account.

 

Antispam-SpamAssassin: This plugin scans posted content with SpamAssassin to
determine if the content has a high probability of being spam. SpamAssassin is an Open
Source antispam platform which allows administrators to filter and classify bulk spam.
Learn more at: http://spamassassin.apache.org.

 

Testing Content

Sample content may be tested against enabled plugins to further examine which plugin may
have flagged content as potential spam and why. The testing interface may be found by:

1. Navigate to the /administrator interface of the Hub and locate the Components tab
2. Click on Support from the drop-down
3. Inside of the Support Manager, locate the sub-menu item for Abuse
4. Inside of the Support Manager > Abuse panel, locate the sub-sub-menu item for Spam

Check

A form with a single text box will be present. Paste content into the box and click the 
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Check button in the toolbar. The interface should update to display a list of all anti-spam plugins
the content was passed through and the results of said plugins.

 

Not a spammer but a normal user what was flagged as one?

Sometimes when a user repeats actions on a Hub in a rapid function or tries to submit a flagged
item multiple times, they end up in Spam jail. In order to reset the Spam jail count and free
them, follow these steps:

1. Navigate to the /administrator interface of the Hub and locate the Users tab
2. Click on Members from the drop-down
3. Locate the user and click on their name
4. Locate the Lifetime Spam Incidents and click Reset
5. Click Save & Close and notify the user that they are out of Spam jail

If this user is a habitual offender and you are tired of bailing them out of Spam Jail or you would
like to whitelist the Administrator user group, you can Whitelist a user group or a specific user by
completing these steps:

1. Navigate to the /administrator interface of the Hub and locate the Extensions tab
2. Click on Plug-in Manager from the drop-down
3. Inside of the Plug-in Manager, locate the Content - Antispam plugin and click on the

plugin's title
4. Click on the Whitelist section and change the access group or add the user's username

to the list in order to Whitelist all users in that access group or that specific user
5. Click Save & Close
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Categories

Overview

Sections and categories in Joomla! provide an optional method for organizing your articles.
Here's how it works. A Section contains one or more categories, and each Category can have
articles assigned to it. One Article can only be in one Category and Section. 

For example, you might have a Section called "Pets", and categories called "Dogs" and "Cats".
Articles about dogs would be assigned to the "Dogs" Category, ones about cats the "Cats"
Category. So an Article about dogs would be in the "Pets" Section and the "Dogs" Category.
You could not have one Article that is in both the "Cats" and "Dogs" categories. To work around
this, you could either (1) create a new Category called "Cats and Dogs" or (2) create a second
Article to put in the second Category. 

Why Use Sections & Categories?

There are two main reasons you might want to organize your Articles in sections and
categories. 

List and Blog Layouts

First, there are built-in Menu Item Types in Joomla! that take advantage of this organization.
These are the Section Blog, Section List, Category Blog, and Category List. These Menu Item
Types (also called "layouts") make it very easy to show articles that belong to sections or
categories. As new articles are created and assigned to sections and categories, they will
automatically be placed on these pages according to the parameters you set for each page. 

For example, say you have a Section Blog layout for the "Pets" section, and say you have it set
to order articles starting with the most recent one first. When you add a new Article to the "Pets"
Section, it will automatically show on the "Pets" blog page as the first Article. You don't have to
do anything other than add the Article and assign it to the "Pets" Section. 

Organizing Articles in Article Manager

If you will have a large number of articles on your site, a second reason to use sections and
categories is to simply group the articles so you can find them. For example, in the Article
Manager, you can filter articles based on Section or Category. So if you have 200 articles in
your site, you can more easily find an Article if you know it's Section or Category. 

Sections and Categories vs. Menu Organization

It is important to understand that, just because Joomla! uses a 3-tier organization level for
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articles (Section ? Category ? Article), this has nothing to do with the structure of the menus on
your site. For example, your site could have one menu level or six menu levels. 

Other Types of Categories

There is also a potential for confusion about categories. Sections are only used for articles.
However, categories are also used for other components, including Banners, Contacts, News
Feeds, and Weblinks. These categories are completely different from Article categories and are
set up in different screens in the back end of Joomla!. So when you see something about
categories, it might refer to Article categories or it might refer to categories for these other
components. 

Creating a Section & Category Hierarchy

Coming soon. 

                            9 / 270



HUB MANAGERS
 

Creating/Editing

Creating an Article

1. First login to the administrative back-end.
2. Once logged in, find “Content” in the main menu bar located toward the top of the page.

You should be presented with a drop-down menu containing items such as “Article
Manager”, “Article Trash”, etc.

3. Choose “Article Manager” from the available options.

4. Then click the "New" toolbar button.
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5. The New Article screen contains options for categorizing and naming the article, editing
content and selecting parameters.

Enter a title in the "Title" field. This is used when the article title is displayed.
Enter an alias in the "Alias" field. The alias is used to refer to the title and is
important for the URL of the page. If you do not enter anything Joomla! will
generate it for you.
Select a "Section" and "Category" using the drop down menus.
Choose whether the article is published or not using the "Published" radio
buttons.
Choose whether the article will be displayed by the Frontpage component using
the "Front Page" radio buttons.

6. You may also choose Parameters for the article. Click on each section to view the
parameters and change the settings to suit your requirements.

7. Click the "Save" or "Apply" toolbar button to save your article.

The "Save" toolbar button will save your changes and return you to the Article
Manager screen.
The "Apply" button will save your changes but leave you in the Article Edit
screen.
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Editing an Article

1. First login to the administrative back-end.
2. Once logged in, find “Content” in the main menu bar located toward the top of the page.

You should be presented with a drop-down menu containing items such as “Article
Manager”, “Article Trash”, etc.

3. Choose “Article Manager” from the available options.

4. You should now be presented with a list of all the content articles on your site. There are
a variety of methods to find the specific entry you wish to edit: you can filter by selecting
section, category, author, or even state (published, unpublished, archive). The about
page should be in the section “about” and category “about”. You may also search for
“About” in the filter search box or scroll to the bottom of the page and navigate your way
through the entire list. Once found, click the article title to edit it.
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5. You may then edit the page title, content, etc.

6. Once you feel ready to save your changes, scroll back to the top of the page and click
“Save” (the icon that looks like a floppy disk) in the upper right portion of the page.

Adding an Image

Images are added to articles using the Editor Buttons below the content editor window in the
Edit Article screen. Note: It is possible to insert images using the editor in Joomla! however this
feature provides a simple way of inserting images stored in the images/stories directory of
Joomla!

1. Open the Article for editing either by:
Click the Content > Article Manager menu item to go to the Article Manager,
select the Article and click the Edit toolbar button.
Clicking the Add New Article button in the Control Panel.
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If logged in to the Front-end, you have appropriate permissions and are viewing
the Article you wish to edit: Click the Edit toolbar button.

2. Choose where you would like your image placed in the flow of the text by moving the
cursor and click the Image editor button at the bottom of the screen.

3. The Insert Image screen will open over the top of the Edit Article screen. Choose an
image by clicking on it.

You may also move directory by clicking on the folder icons.
Use the drop down Directory field to quickly select a directory and click the Up
button to go up a directory level.

4. Set the image properties as required:
Image Description: This becomes the alt attribute for the image, an important
feature for accessibility and compliance with web standards.
Image Title: Used for the optional caption and also becomes the title attribute in
HTML.
Align: Sets the image alignment. If left blank the align attribute is not set.
Caption: Enables the caption which displays the Image Title below the image.

5. Click the Insert button to insert the image. The Insert Image screen will close and the
image will be displayed in the editor.

Click the Cancel button to leave the Insert Image screen.

Uploading images using the Insert Image screen

You may also upload new images using the Upload section of the Insert Image screen.

1. Click the Browse button to open a file browser.
2. Select the image files you wish to upload. Click Open in the file browser to confirm the

selection. Note: The file browser style and layout depends on the browser and operating
system you are using.

To remove selected files before uploading click the red icon next to the listed
files.
If you are uploading multiple files in batches you can clear the list of completed
files by clicking the Clear Completed button.

3. The selected file(s) appear as a list at the bottom of the Insert Image screen. Click Start
Upload to begin uploading files.

When the upload is complete a green tick will appear next to the file.
4. You may now select and insert the uploaded image as before.
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Metadata

Overview

Metadata are data about data, for instance a description of a website. Metadata are important
for search engines and are written in HTML. Exactly how important metadata are in the rating by
search engines is debatable. However, metadata represent a good way to describe your
website in short and precise words. 

Note: Google does not use the keywords meta tag in web ranking. See the following article for
details. 

Available Tags

If you check out the HTML source code of a Joomla! site, you will see the following meta tags in
the top area: 

<meta name="generator" content="HUBzero - The open source platform for
 scientific and educational collaboration" />
<meta name="description" content="Help and documentation for HUBzero, 
the Platform for Scientific Collaboration" />
<meta http-equiv="Content-Type" content="text/html; charset=utf-8" />
<meta name="robots" content="index, follow" />
<meta name="keywords" content="cyberinfrastructure, middleware, resear
ch, education" />

Of these, the two attributes description and keywords can be set on an article-by-article basis. 

description
This description of site content is often displayed by search engines. You should pay
special attention to this tag, since the user who has entered a search term often uses
this information to make a decision of whether to visit a site or not. You can add further
information about every individual page to the global description.

keywords
Keywords are very important for a document. You should list the most important
concepts of your website with them. Some search engines index keywords in particular.
The individual words are separated by commas; several words can be entered between
two commas with normal spaces in between. The keywords should be limited to a
maximum of 1000 characters; more than that will not be read by the search engines.
Note that the use of fewer keywords helps each individual word get a higher priority in
the search engine. Deliberate carefully about which are the most often used keywords
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and which are likely to be searched for most. You can add more keywords to the global
keywords for every individual page of your website.

Each article may also specify, in its parameters, whether to include a title or author attribute. 

Show Title Meta Tag
This parameter will insert the following meta tag with the title of the article: 

<meta name="title" content="Welcome to HUBzero" />

Show Author Meta Tag
This parameter will insert the following meta tag with the author of the article: 

<meta name="author" content="Administrator" />
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Archiving

Archiving an Article

Archiving is useful if you publish a lot of articles and which you still want to be published on the
site, but have been displaced in priority by new ones. 

1. Login to the Joomla! Administrator Back-end.
2. Go to "Content" ? "Article Manger" on the toolbar menu.

3. Check the box next to the article you want to archive.  

  

4. Then click "Archive" button.  
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Unarchiving an Article

1. Login to the Joomla! Administrator Back-end.
2. Go to "Content" ? "Article Manger" on the toolbar menu.

3. Check the box next to the article you want to unarchive.  

  

4. Then click "Unarchive" button.  
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The Home Page

Setting a Home Page

The home page is determined by a "default" menu item that has been marked as the default.  

If you wish to change the current home page to a different article, you must add the desired
article to the default menu and mark it as "default". 

Edit

First login to the administrative back-end. 

Once logged in, find “Content” in the main menu bar located toward the top of the page. You
should be presented with a drop-down menu containing items such as “Article Manager”,
“Article Trash”, etc. 

Choose “Article Manager” from the available options. 
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You should now be presented with a list of all the content articles on your site. There are a
variety of methods to find the specific entry you wish to edit: you can filter by selecting section,
category, author, or even state (published, unpublished, archive). The home page should not
be in a section or category (uncategorized). You may also search for the title of your home page
in the filter search box or navigate your way through the entire list. Once found, click the article
title to edit it.

The home page may look a little different than other pages you’ve edited, such as the “About”
page. Some of the content you see on the front page doesn’t appear to be in the page you’re
editing! This is because the home page embeds modules to output some of its content. This is
done with {xhub} tags: 

{xhub:module position="frontLeft"} 

You may assign multiple modules to a position. The {xhub} tag will output all active (published)
modules assigned to the position specified. The style attribute determines if the module(s)
should be wrapped in a containing div or not and is optional. 
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Note: The animated banner and welcome message on the front page are also modules and
managed through Joomla’s “Module Manager” found under the “Extensions” menu item.

Once you feel ready to save your changes, scroll back to the top of the page and click “Save”
(the icon that looks like a floppy disk) in the upper right portion of the page.

Welcome

The “welcome” text, typically found to the right of the Flash banner on the home page is a
module. To edit this module (or any module):

First login to the administrative back-end.

Once logged in, find “Extensions” in the main menu bar located toward the top of the page. You
should be presented with a drop-down menu containing items such as “Module Manager”,
“Plugin Manager”, etc.

Choose “Module Manager” from the available options.
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You should now be presented with a list of all the modules installed on your site. There are a
variety of methods to find the specific module you wish to edit: you can filter by selecting
position, type, or even state (enabled, disabled). The welcome module would be in position
“welcome” and of type “mod_custom”. You may also search for “welcome” in the filter search
box or scroll to the bottom of the page and navigate your way through the entire list. Since
modules are alphabetically sorted by their position by default, “welcome” will most likely be on
the last page of results. Once found, click the module name to edit it.

Once in edit mode you will be presented with some options such as the title, position, etc. To
edit the actual content of the module, scroll down until you see a large text area called “Custom
Output”.
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Edit the HTML/text to be outputted.

Scroll back to the top of the page and click “Save” (the icon that looks like a floppy disk) in the
upper right portion of the page.

Your changes should now be applied and immediately viewable on the front page.
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Content Modifiers

Loading Modules in Articles

Modules may be loaded in an article by including a specific {xhub:module} tag. This tag requires
one attribute: position, which specifies the position that you wish to load. Any modules assigned
to the specified position (set via the administrative Module Manager) declared in the position
attribute will have their output placed in the article in the location of the {xhub:module} tag.  

{xhub:module position="footer"}

Note: To use this feature, the xHUB Tags plugin for content must be installed and active.  

Including CSS or JavaScript

Sometimes we need to load a stylesheet or script for a specific article. HUBzero allows this
through the use of the xHUB content plugin. CSS and JavaScript may be loaded in an article by
including a specific {xhub:include} tag. This tag has a few attributes, each with multiple options: 

type
Required. Determines what sort of file to be included. Accepts "script" or "stylesheet".

filename
Required. The name of the file to be included.

component
Optional. The name of the component the file is to be included from. If not specified, the
file will be included from the template's directory.

<!-- A stylesheet called "home.css" from the current template's /css f
older -->
{xhub:include type="stylesheet" filename="home.css"}

<!-- A script called "resources.js" from the com_resources component -
->
{xhub:include type="script" filename="resources.js" component="com_res
ources"}

Note: To use this feature, the xHUB Tags plugin for content must be installed and active. 
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Outputting Hub Configurations

Sometimes we need to output the value of a specific hub configuration setting. HUBzero allows
this through the use of the xHUB content plugin. HUBzero based configurations (not Joomla!)
may be loaded in an article by including a specific {xhub:getCfg} tag. This tag has one attribute:
the name of whatever configuration variable you wish to output. 

{xhub:getCfg hubShortName}

Note: To use this feature, the xHUB Tags plugin for content must be installed and active.

We also advise extreme caution when using this particular {xhub} tag. 

See Hub Configuration for more information on what configurations are available and how to set
them. 

Getting The Template Directory

Sometimes we need to include content (images, javascript, etc.) from the active template's
directory. HUBzero allows this through the use of the xHUB content plugin. The name of the
active template will be outputted in an article by including the templatedir xhub tag. This tag has
no attributes. 

<img src="{xhub:templatedir}/images/logo.png" alt="Our Logo" />
<!-- outputs: -->
<img src="/templates/mytemplate/images/logo.png" alt="Our Logo" />

Note: To use this feature, the xHUB Tags plugin for content must be installed and active. 
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Deleting

Moving To The Trash

1. Login to the Joomla! Administrator Back-end.
2. Go to "Content" ? "Article Manger" on the toolbar menu.

3. Check the box next to the article you want to trash.  

  

4. Then click "Trash" button. This will move the article to a trash bin so that it can be
retrieved later if needed. It does not permanently delete the article.  
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Permanently Deleting

1. If you want to make sure the Article is completely gone from the system (so no further
roll back is available), go to "Content" ? "Article Trash" on the toolbar menu.

2. Check the box next to the article you want to delete.  

  

3. Then click "Delete" button. This will permanently delete the article. Recovery is not
possible after this action.  
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Note: Articles in the Trash Manager are not the same as Archived Articles. 
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Extensions

Overview

HUBzero is already a rich featured content management system but if you're building a website
and you need extra features which aren't available by default, you can easily extend it with
extensions. There are five types of extensions: Components, Modules, Plugins, Templates, and
Languages. Each of these extensions handle specific functionality. 

Components

The largest and most complex of the extension types, a component is in fact a separate
application. You can think of a component as something that has its own functionality, its own
database tables and its own presentation. So if you install a component, you add an application
to your website. Examples of components are a forum, a blog, a community system, a photo
gallery, etc. You could think of all of these as being a separate application. Everyone of these
would make perfectly sense as a stand-alone system. A component will be shown in the main
part of your website and only one component will be shown. A menu is then in fact nothing more
then a switch between different components.  

Modules

Modules are extensions which present certain pieces of information on your site. It's a way of
presenting information that is already present. This can add a new function to an application
which was already part of your website. Think about latest article modules, login module, a
menu, etc. Typically you'll have a number of modules on each web page. The difference
between a module and a component is not always very clear for everybody. A module doesn't
make sense as a standalone application, it will just present information or add a function to an
existing application. Take a newsletter for instance. A newsletter is a module. You can have a
website which is used as a newsletter only. That makes perfectly sense. Although a newsletter
module probably will have a subscription page integrated, you might want to add a subscription
module on a sidebar on every page of your website. You can put this subscribe module
anywhere on your site. 

Another commonly used module would be a search box you wish to be present throughout your
site. This is a small piece of re-usable HTML that can be placed anywhere you like and in
different locations on a template-by-template basis. This allows one site to have the module in
the top left of their template, for instance, and another site to have it in the right side-bar. 

Plugins

Plugins serve a variety of purposes. As modules enhance the presentation of the final output of
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the Web site, plugins enhance the data and can also provide additional, installable functionality.
Plugins enable you to execute code in response to certain events, either core events or custom
events that are triggered from your own code. This is a powerful way of extending the basic
functionality. 

Templates

A template is a series of files within the CMS that control the presentation of the content. The
template is not a website; it's also not considered a complete website design. The template is
the basic foundation design for viewing your website. To produce the effect of a 
complete website, the template works hand-in-hand with the content stored in the database.

Languages

Probably the most basic extensions are languages. Languages can be packaged in two ways,
either as a core package or as an extension package. In essence, these files consist key/value
pairs, these pairs provide the translation of static text strings which are assigned within the
source code. These language packs will affect both the front and administrator side. Note: these
language packs also include an XML meta file which describes the language and font
information to use for PDF content generation. 

Conclusion

If the difference between the three types of extensions is still not completely clear, then it is
advisable to go to the admin pages of your installation and check the components menu, the
module manager and the plugin manager. HUBzero comes with a number of core components,
modules and plugins. By checking what they are doing, the difference between the three types
of building blocks should become clear.
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Modules Manager

Overview

The Module Manager is where you add and edit Modules. In HUBzero, Modules are used to
display content and/or media around the main content.

The Module Manager can be found by selecting Extensions > Module Manager from the drop-
down menu on the back-end of your HUB installation.

 

Module Facts:

1. All hubs require at least 1 Menu Module
2. All Other Module Types are Optional. (Examples: News, Banner, Latest News, Polls)
3. Every Menu is accompanied by a menu module. (Example mod_mainmenu)
4. Multiple occurrences of similar module types.
5. Some Modules are linked to components. For example, each Menu Module is related to

one Menu component. To define a Menu, you need to create the Menu and Menu Items
using the Menus screens and then create the Module for the Menu using this screen.
Other Modules, such as Custom HTML and Breadcrumbs, do not depend on any other
content.

An installation is accompanied with over 20 default module types.

Column Headers

 

Click on the column heading to sort the list by that column's value.

Number (#): An indexing number automatically assigned by Joomla! for ease of
reference.
Checkbox: Check this box to select one or more items. To select all items, check the
box in the column heading. After one or more boxes are checked, click a toolbar button
to take an action on the selected item or items. Many toolbar actions, such as Publish
and Unpublish, can work with multiple items. Others, such as Edit, only work on one
item at a time. If multiple items are checked and you press Edit, the first item will be
opened for editing.
Module Name: The name of the Module. You can click on the name to open the Module
for editing.
Enabled: A green tick or a red X showing whether the use of the component is
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enabled/disabled. Click the icon to toggle the item between enabled and disabled.
Order: The order to display modules within a Position. If the list is sorted by this column,
you can change the display order of modules within a Position by selecting a Position in
the Select Position filter and then clicking the arrows or by entering the sequential
order and clicking Save Order.
Access Level: Who has access to this item. You can change an item's Access Level by
clicking on the icon in the column. Current options are:

Special: Only users with author status or higher have access
Registered: Only registered users have access
Public: Everyone has access

Position: The position on the page where this module is displayed. Positions are
locations on the page where modules can be placed (for example, left or right).
Positions are defined in the Template in use for the page. Positions can also be used to
insert a Module inside an Article using the syntax {loadposition xxx}, where xxx is a
unique position for the module.
Pages: The Menu Items where this Module will be displayed. Options are All for all
Menu Items, None for no Menu Items, and Varies for selected Menu Items. A Module
will only display on Menu Items where it is selected.
Type: The system name of the Module. Joomla! installs 20 standard Modules. Many
Joomla! Extensions contribute additional Modules.
ID: The ID number. This is a unique identification number for this item assigned
automatically by Joomla!. It is used to identify the item internally, for example in internal
links. You can not change this number.
Display Number: The number of items to display on one page. If there are more items
than this number, you can use the page navigation buttons (Start, Prev, Next, End, and
page numbers) to navigate between pages. Note that if you have a large number of
items, it may be helpful to use the Filter options, located above the column headings, to
limit which items display (where applicable).

Toolbars

Primary Toolbar

Enable: To enable one or more items, select them using the Checkbox and press this
button. You may also toggle between Enabled and Disabled by clicking on the icon in
the Enabled column.
Disable: To disable one or more items, select them using the Checkbox and press this
button. You may also toggle between Enabled and Disabled by clicking on the icon in
the Enabled column.
Copy: To copy one or more Modules, select them using the Checkbox and press this
button. A new Module will be created for each selected Module. The new Module will
have the name Copy of plus the original Module name. Note that the new copies are
initially disabled.
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Delete: To delete one or more items, select them and click this button. The selected
items will be deleted. Note: only empty items can be deleted.
Edit: Select one item and click on this button to open it in edit mode. If you have more
than one item selected (where applicable), the first item will be opened. You can also
open an item for editing by clicking on its Title or Name.
New: To create a new instance of a Module, press this button. You will be taken to a
screen that lists all of the available Modules. See Create/Edit Modules for information
about adding Modules.
Help: Opens this Help Screen.

Site and Administrator Links: At the top left, above the Filter.

Site: Opens the Site tab. This is the default tab and allows you to manage the Modules
for the front end of the web site.
Administrator: This tab allows you to manage the Modules for the back end
administration of the web site. If you do not need to change the Joomla! administrator
menus, no modifications are required here.

List Filters

Filter by Template, Position, Type, and Published State

You can filter the list of items by typing part of the title or the ID number. Or, you can select a
combination of Category and Published State.

Filter: In the upper left corner just above the column headings is a Filter field and two
buttons, as shown below:

If you have a large number of items on the list, you can use this filter to find the
desired item(s) quickly. Enter either part of the title or an ID number and press 
Go to display the matching items. You can enter in whole words or part of a
word. For example, ero will match all titles with the word Hubzero in them.

 

Filter by Template, Position, Type and Published State

In the upper right area, above the column headings, are following drop-down list boxes as
shown below. The selections may be combined. Only items matching both selections will
display in the list.

Site
Select Status
Select Template: Select the Template from the drop-down list box of available
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Templates. Only Templates that are enabled for this site will display.
Select Position:Select a Position from the drop-down list box of available Positions.
Select Type: Select the Module Type from the drop-down list box of available Module
Types. HUBzero installs with 20 available Module types. Additional ones may be
available if you have installed any Extensions.
Select State: Use the drop-down list box to select the published state: Enabled or
Disabled.
Select Access
Select Language

Create/Edit Modules

When you create a new Module, you will select the Module Type. This will determine what type
of content this Module can display. If you edit an existing Module, the Module Type will already
be determined. 

Note: You cannot change the Module Type of an existing Module.

All Modules have two sections that are the same: Details and Menu Assignment. The
Parameters are different for each Module Type.

Module Type: This displays the system name of the module. No entry is allowed.

Title: The Title of the Module.
Show Title: Whether or not to show the Title of the Module.
Enabled: Whether or not the Module is enabled. If No, the Module will not be shown on
the page.
Position: The Position on the page to show the Module. There are two types of
Positions you can use.

You can select a Position from the drop-down list box. The Positions in the list
box are those provided by your Template. You can see the available Positions
on the page by adding the letters ?tp=1 to the end of any front-end URL. For
example, if your home page is www.mysite.com, you can type the URL 
www.mysite.com?tp=1. The page will display with labeled rectangles indicating
each pre-defined Position for the current Template.
You can type in a Position that is different from the pre-defined positions (for
example, myposition1). This type of Position can be used to insert a Module
into an Article. If you enter the code {loadposition xxx} inside the text of an
Article, where xxx matches the Position of a Module, and if the Module is
assigned to the the Menu Selection where the Article is displayed (see Menu
Assignment below), then the Module will be displayed at that point in the Article.

Order: The Order that this Module will be displayed within the Position. If more than one
Module is displayed at the same position, this will determine the order of display. The
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drop-down list box shows all Modules displaying at the current Position. Select the
Module that you want the current Module to follow.

You can also change the order of display in the Module Manager. The Module
Order is only important when two or more Modules are displaying at the same
Position and on the same Menu Selections.

Access Level: Who has access to this item. Enter the desired level using the drop-
down list box. Current options are:

Public: Everyone has access
Registered: Only registered users have access
Special: Only users with author status or higher have access

ID: The ID number. This is a unique identification number for this item assigned
automatically by Joomla!. It is used to identify the item internally, for example in internal
links. You can not change this number.
Description: A description of what the Module does. No entry is allowed.

 

Menu Assignment

This is where you tell the CMS which pages to show this Module on. This Module will show on
the page when this Menu Item is selected. If the Menu Item allows the user to navigate to sub-
pages, then this Module will also show on these sub-pages. For example, if the Menu item is a
Blog Layout, the Module will also show when the user clicks on a Read more... link, an Article
Link, or a Page Navigation link from that Blog Layout.

 

Menus: All means show the current Module on all Menu Items. None means don't show
the Module on any Menu Items. Select Menu Item(s) from the List allows you to select
which Menu Items to show the Module on.
Menu Selection: If Select Menu Items(s) from the List above is selected, select
individual Menu Items that will display the Module.

Use Ctrl+Click to select multiple Menu Items.
Use Shift+Click to select a range of Menu Items.
If you want to select most of the Menu Items, first click All above under Menus
and then click Select Menu Items(s) from the List. All of the Menu Items will be
selected. Then use Ctrl+Click to deselect the Menu Items you don't want to
include.

Parameters: This will vary between modules.
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Turning on Site Notices

Use this module to announce Hub wide events or scheduled upgrade dates.

1. Navigate to the /administrator interface
2. Hover over Extensions and from the drop-down select Module Manager
3. Click New and look for "mod_notices"
4. Click on the title of "mod_notices" to open up this new module

1. Only complete steps 3 - 4 if you have not created this module previously
5. Fill in the needed information:

1. Title: Add the title for this module, Example - "Upgrade Notices"
2. Position: Set the position to "notices"
3. Ordering: Set the ordering to "Site Notices"
4. Status: Set the status to "Publish"
5. Access: Set to the user access level this announcement pertains to
6. Start Publishing: Select the date to start publishing this announcement
7. Finish Publishing: Select the date to finish publishing this announcement
8. Languages: Set lanugages to "All"
9. Alert Level: Determine the alert level (Low, Medium, High)

10. Message: Add the message you want to announce to your users
6. Scroll to the bottom of the form to check what pages you want this message appearing

on through out the site
7. Click Save & Close once you are done
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Templates Manager

Overview

The Template Manager is where you assign a default Template to your web site. You can also
edit and preview Templates here.

The visual layout of both the Front-end and Back-end of your site is controlled by the Template.
Templates are extensions that contain layout and style information that tells the CMS exactly
how to draw each page of your site.

When you first install a hub, one Back-end Template and one or more Front-end templates are
included. Other Templates can be installed from third-party developers as Extensions.

If you want to use the same Template for all of the pages on your site, you just assign one
Template as the Default Template. You can also assign different Templates to different pages.

Select Extensions ? Template Manager from the drop-down menu in the back-end of your
installation.

Column Headers

#: An indexing number automatically assigned by Joomla! for ease of reference.
Template Name: The name given to each Template by the Template author. Click the
Name to open the Template for editing. If you hover the mouse over the Template
Name, a small preview for the Template displays in a pop-up window. The Template
Name normally corresponds to the sub-directory name that contains the Template in the
<path-to-app>/templates/ directory. For example, the files for the kimera Template are
in the directory <path-to-app>/templates/kimera
Default: Indicator of Default Template.
Assigned: Shows whether this Template has been assigned to any specific menu
items. To assign a template to menu items, open the Template for editing.
Version: The version number of the Extension.
Date: The date this extension was released.
Author: The author of this extension.
Display #: The number of items to display on one page. If there are more items than
this number, you can use the page navigation buttons (Start, Prev, Next, End, and page
numbers) to navigate between pages. Note that if you have a large number of items, it
may be helpful to use the Filter options, located above the column headings, to limit
which items display (where applicable).
Location
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Toolbars

Default: Select the Template that you want to be the default Template. Then click this
button. The default star symbol will show in the Default column, indicating that this is
now the default Template.
Edit: Select one item and click on this button to open it in edit mode. If you have more
than one item selected (where applicable), the first item will be opened. You can also
open an item for editing by clicking on its Title or Name. See the section below called 
Changing Text and Color for information on the edit screen.
Help: Opens this Help Screen.
Duplicate
Delete

Changing Text and Color

(Note: You have to be logged into your hub in order to complete the following tasks)

 

1. Click the Extensions tab and then select the Template Manager button located in the
drop-down

2. On the Template Manager: Styles page, check the box of the kameleon
(admin) template and then click the Edit button

3. Change the Header to Light or Dark from the drop-down
4. Change the Theme or main color of the backend by either choosing a color from the

drop-down or by selecting Custom (color specified below) and fill in a color code in
the Custom color box

5. Save the changes by clicking Save & Close and a pop-up will appear saying Style
successfully saved

Kimera: Adding a Background Image

1.
2.
3.
4.
5.
6.
7.
8.
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Plugins Manager

Overview

The Plugin Manager allows you to enable and disablePlugins and to edit a Plugin's Details and
Parameters.

The Plugin Manager can be accessed by selecting Extensions > Plugin Manager from the
drop-down menu on the Back-end of your HUBzero installation.

Plug-in Name: The name of the plug-in. The name explains where the plug-in is located
and what the plug-in is for.

For example: Dashboard-Collections means that the plug-in is on the user’s
Dashboard with a module for Collections.

Status: If the plug-in is viewable on the Hub or not.
Enabled: The plug-in is available on the frontend and on the backend of the Hub.
Disabled: The plug-in has been removed from the frontend of the Hub but is still
accessible on the backend.

Ordering: Where the plug-in is on the master list of plug-ins. This list can be seen when
plug-ins are being enabled the ordering determines how the plug-in is displayed in the
drop-down.
Type: The location of the plug-in.

This is the first part of the plug-in’s title.
Element: What the plug-in is implementing.

This is the second part of the plug-in’s title.
Access: Who is able to view or use the plug-in.

Public: All visitors or users on the Hub are able to view and use the plug-in.
Registered: Only registered users are able to view and use the plug-in.
Special: Only users given special permissions can access and use the plug-in.

ID: The identification number given to the plugin after it was created on the Hub. This
allows for easier search results.

Column Headers

 

#: An indexing number automatically assigned by Joomla! for ease of reference.
Checkbox: Check this box to select one or more items. To select all items, check the
box in the column heading. After one or more boxes are checked, click a toolbar button
to take an action on the selected item or items. Many toolbar actions, such as Publish
and Unpublish, can work with multiple items. Others, such as Edit, only work on one
item at a time. If multiple items are checked and you press Edit, the first item will be
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opened for editing.
Plugin Name: The Name of the Plugin. Click on the Name to open the Plugin for
editing.
Enabled: A green tick or a red X showing whether the use of the component is
enabled/disabled. Click the icon to toggle the item between enabled and disabled.
Order: The order to display items. If the list is sorted by this column, you can change the
order by clicking the arrows or by entering the sequential order and clicking Save Order.
Note that the display order on a page is set in the Parameters - Advanced section for
each Menu Item. If that order is set to use something other than Order(for example, 
Title - Alphabetical), then the order value in this screen will be ignored. If the Menu
Item Order parameter is set to use Order, then the items will display on the page based
on the order in this screen.
Access Level: Who has access to this item. You can change an item's Access Level by
clicking on the icon in the column. Current options are:

Public: Everyone has access
Registered: Only registered users have access
Special: Only users with author status or higher have access

Type: The Type of the Plugin. Possible types are: authentication, content, editors,
editors-xtd, search, system, user, and xmlrpc. These are also the names of the
subfolders where the Plugin files are located. For example, Plugins with a Type of 
authentication are located in the folder plugins/authentication.
File: The name of the Plugin files. Each Plugin has two files, a .php file and a .xml file.
So, for example, the Authentication - Facebook plugin has two files: facebook.php and 
facebook.xml.
ID: The ID number. This is a unique identification number for this item assigned
automatically by Joomla!. It is used to identify the item internally, for example in internal
links. You can not change this number.
Display #: The number of items to display on one page. If there are more items than
this number, you can use the page navigation buttons (Start, Prev, Next, End, and page
numbers) to navigate between pages. Note that if you have a large number of items, it
may be helpful to use the Filter options, located above the column headings, to limit
which items display (where applicable).

Toolbars

Enable: To enable one or more items, select them using the Checkbox and press this
button. You may also toggle between Enabled and Disabled by clicking on the icon in
the Enabled column.
Disable: To disable one or more items, select them using the Checkbox and press this
button. You may also toggle between Enabled and Disabled by clicking on the icon in
the Enabled column.
Edit: Select one item and click on this button to open it in edit mode. If you have more
than one item selected (where applicable), the first item will be opened. You can also
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open an item for editing by clicking on its Title or Name.
Help: Opens this Help Screen.
Check-in
Options

List Filters

You can filter the list of items by typing in part of the Title or the ID number. Or you can select a
combination of Category and Published State.

Filter: If you have a large number of items on the list, you can use this filter to find the
desired item(s) quickly. Enter either part of the title or an ID number and press Go to
display the matching items. You can enter in whole words or part of a word. For
example, ooml will match all titles with the word Joomla! in them.
Filter by Type and State: The selections may be combined. Only items matching both
selections will display in the list.
Select Type: Select a Type from the drop-down list box to select only Plugins of this
Type.
Select State: Select a state (Enabled or Disabled) from the drop-down list box to select
only Plugins with this state.
Select Access

Edit Plugins

You can edit details and parameters for Plugins. Some Plugins have several parameters, while
others don't have any.

Details: The Details section is the same for all Plugins, as follows:
Name: The Name of the Plugin.
Enabled: Whether or not this Plugin is enabled.
Type: The Type of the Plugin. This value cannot be changed.
Plugin File: The name of the Plugin file. Each Plugin has two files with this name. One
has the file extension .php and the other has the file extension .xml.
Access Level: Who has access to this item. Enter the desired level using the drop-
down list box. Current options are:

Public: Everyone has access

Registered: Only registered users have access
Special: Only users with author status or higher have access

Order: The order this item will display in the Manager screen. Use the drop-down list

                           43 / 270



HUB MANAGERS
 

box to change the Order. You can select First or Last to make this the first or last item.
Or you can select an item from the list. In this case, the current item will be listed just 
after the item you select. Note that the Order can also be changed in the Manager
screen.
Description: The description of what this Plugin does. This cannot be changed.
Parameters: This will vary between plugins.

Reordering

1. Log in to the backend of the Hub and access the Extensions tab
2. Click on the Plugin-in Manager navigate to the Plug-in Manager: Plug-ins page
3. Locate the column labeled Ordering and then click on the title of the column
4. Arrows will appear on the left side of the numbering
5. To begin reordering click the arrows up or down to reorder the plug-ins
6. Save the changes by clicking the Save icon

Enabling a Plug-in

1. Log in to the backend of the Hub and access the Extensions tab and then click on Plug-
in Manager

2. Locate the plug-in that needs enabling and select the box beside the plug-in’s name
3. Click Enable to enable the plug-in
4. The plug-in will now be useable on the frontend of the Hub

Editing a Plug-in

1. Log in to the backend of the Hub and access the Extensions tab and then click on Plug-
in Manager

2. Locate the plug-in that needs editing and select the box beside the plug-in’s name
3. Click Edit to begin editing the plug-in
4. Click Save & Close to save the newly edited content

Disabling a Plug-in
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1. Log in to the backend of the Hub and access the Extensions tab and then click on Plug-
in Manager

2. Locate the plug-in that needs disabling and select the box beside the plug-in’s name
3. Click Disable to disable the plug-in
4. The plug-in will now be removed from the frontend of the Hub, but still accessible from

the backend
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Extension Manager

Overview

A Hub administrator can manage extensions (i.e.: plugins, components, modules, templates,
etc.), from the /administrator interface. Extensions are categorized into two sections - "Hubzero
Core" and "Custom Extensions". Hubzero Core extensions are the core codeset of Hubzero and
may be disabled or enabled but never completely removed. Hubzero Core extensions, however,
can be overridden by a Custom Extension of the same name. See the Web Developer
documentation section for instructions on how to create your own.

Enabling Hubzero Core Extensions

1. Navigate to /administrator.
2. Hover over Extensions and select Extension Manager.
3. Click Hubzero Core to view the list of extensions.
4. Check the box beside the extension that you would like to enable.
5. Click the Enable button in the upper right corner.

Disabling Hubzero Core Extensions

1. Navigate to /administrator.
2. Hover over Extensions and select Extension Manager.
3. Click Hubzero Core to view the list of extensions.
4. Check the box beside the extension that you would like to disable.
5. Click the Disable button in the upper right corner.

Adding Custom Extensions

1. Navigate to /administrator.
2. Hover over Extensions and select Extension Manager.
3. Click Custom Extensions to view the list of extensions if available.
4. Click the New button in the upper right corner.
5. Complete the form.
6. Click the Save & Close button in the upper right corner.
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Editing Custom Extensions

1. Navigate to /administrator.
2. Hover over Extensions and select Extension Manager.
3. Click Custom Extensions to view the list of extensions.
4. Check the box beside the extension that you would like to disable.
5. Click the Edit button in the upper right corner.
6. Complete the form.
7. Click the Save & Close button in the upper right corner.

Enabling Custom Extensions

1. Navigate to /administrator.
2. Hover over Extensions and select Extension Manager.
3. Click Custom Extensions to view the list of extensions.
4. Check the box beside the extension that you would like to enable.
5. Click the Enable button in the upper right corner.

Disabling Custom Core Extensions

1. Navigate to /administrator.
2. Hover over Extensions and select Extension Manager.
3. Click Custom Extensions to view the list of extensions.
4. Check the box beside the extension that you would like to disable.
5. Click the Disable button in the upper right corner.

 

Additional Info:
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Installing and Updating a Custom Extension

From the Custom Extension tab in the Extension manager, select a Custom Extension from the
list and the click the "Update" button at the top right of the page.
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Incoming commits will be displayed, if you wish to process, click the Merge button at the top
right.

 

You should now see a see a confirmation page that the code has been succesfully updated.
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Authentication

Why it matters?

By default, your hub comes configured to allow local account creation and authentication. In
addition to this default option, HUBzero gives you the ability to extend the authentication
process by adding support for third party services, like Facebook, Google, and LinkedIn. Using
one or more of these providers, users are given a single sign-on experience, while easing the
barriers to entry caused by the account creation process. Plus, as more social networking
features are developed for the hubs - like posting new resources to your Facebook wall - users
will already have that link setup between their hub and Facebook identities.

In brief, that's the principle behind offering multiple authentication options to users. Keep
reading to find out how to set it up on your hub!

Setup

Prior to starting this process, you will have to register an app for your hub on a given provider's
website. A few examples include:

https://developers.facebook.com/apps
https://developer.linkedin.com/ (go to API Keys)
https://developers.google.com/ (go to the API console)

NOTE: the information above is accurate as of Aug 2012. It will undoubtedly change. Exact
steps and terminology differs between providers.

Whichever provider you're interested in, you'll need to register a new app to obtain an app
ID/key and secret (terminology may be slightly different between providers). Once you've
completed the registration process and obtained the API key and secret, you can jump over to
the hub.

NOTE: the Oauth protocol requires the specification of a redirect URI. Most of the providers
mentioned above require you to specify the redirect domain (usually just your hub URL). The
Google API requires you to specifically list any redirect URI's that will be used. These should be
as follows:
(HUBzero 1.1 - see image below)
https://yourhub.org/index.php?option=com_user&task=login&authenticator=google
https://yourhub.org/index.php?option=com_user&task=link&authenticator=google
(HUBzero 1.2)
https://yourhub.org/index.php?option=com_users&task=user.login&authenticator=google
https://yourhub.org/index.php?option=com_users&task=user.link&authenticator=google
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Setup begins in the administrative interface for your hub.

1. First, navigate to Extensions -> Plugin Manager, and filter the results to the 
authentication type

2. Next, select the plugin you desire to enable (we'll use Facebook in this example)

In the plugin edit screen, fill in the appropriate values for App ID and Consumer Secret
as obtained above. Also be sure to enable the plugin.
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That's about it! Now, when you go to your hub's login page, you'll see a new option for
Facebook login.

More details

What happens if someone already has a local hub account, but wants to start using a
new third party provider?

Users that already have hub accounts can go to the accounts tab of their members page. From
there, they can link their existing account with external providers. Additionally, if a user tries to
log in with an external account that doesn't match one used on the hub before, we check to see
if we can match them with an already existing hub account prior to talking them through the new
account creation process.

Purdue Hubs

In addition to the authentication options mentioned above, HUBzero has also developed an
authentication plugin for the Purdue Central Authentication Service (CAS). If you're interested in
taking advantage of this service, follow the instruction here: 
https://www.purdue.edu/apps/account/docs/CAS/CAS_information.jsp to register your hub with
the Identity and Access Management Office at Purdue. Once this is done, simply turn the plugin
on and you'll be all set.

Other institutions or universities may find the Purdue CAS plugin a good template for developing
their own CAS authentication plugin. If you're developing a plugin that uses Oauth, consider
using the Facebook plugin as a starting point.
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Components

What are components?

We have used the phrase, components, as a way to define all of the features that come with the
Hub platform. We consider all of these elements of the larger whole of the platform. Each
component focuses on a specific task that allows users to submit content. As an administrator, it
is up to you to set up all of the Hub's components to fit the needs of the community.
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Answers

What is the Answers component?

Answers, or Questions and Answers in the front end, is a place to exchange knowledge
about things that are not found in the Knowledge Base. Ask a question that's relevant to your
community or help other users by providing an answer to their questions.

Note: You must be logged in on the backend in order to perform the tasks below.

 

Deleting an Answer

1. In the backend, navigate to Answers under the Components tab
2. Go to the Answers tab and find the answer to be deleted
3. Click on the check box for the answer to select it
4. Click the Delete button symbolized by a trash can

The answer will be fully deleted
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Submitting a Question

1. In the backend, navigate to Answers under the Components tab
2. While on the Questions tab, click the New button symbolized by a plus sign
3. Fill in the details of the question being submitted. Check the box for Anonymous to

remove your name from the question. Select the Notify of responses box to get
emailed about new responses to the question. Fill in the title and the description of the
question. Add tags to the question using the tag box

4. Click Save & Close to save the new question to the hub
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Projects

Enabling Plug-in to Projects

1. Login to the backend of the Hub and click on the Extensions tab
2. Click on the Plug-in Manager under the Extensions tab
3. Search Projects- Databases in the search field to locate the Data Store plug-in
4. After locating the correct plug-in, check the box beside the Plug-in Name
5. Click the Enabled button to allow the plug-in to be used on the frontend of the Hub

If the Menu Item for Databases does not display, the MySQL Configuration may not be correct
for DataViewer.

Restricting Plug-in to Specific Projects

1. Login to the backend of the Hub and click on the Extensions tab
2. Click on the Plug-in Manager under the Extensions tab
3. Search Projects- Databases in the search field to locate the Data Store plug-in
4. After locating the correct plug-in, click on the title of the plug-in under the Plug-in

Name column
5. Inside the plug-in details, type in the names of the Projects in the Restricted to

projects field
6. Save the changes by click the Save & Close button

Uploading Large Files Using SFTP Clients

Create a Local Password

1. If you use a non-Hub related account, then you must first create a local password
2. Login to the HUB
3. On the Dashboard, click Account on the left menu
4. Under Local Password, type in the password in the New Password and Confirm

password text boxes
5. Click Save

 

Setup SFTP Client

1. Download an SFTP client like Cyberduck or Filezila
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2. Add a new site by either clicking the Plus sign icon (+) or File -> Site Manager ->
New Site

3. Provide the following information
a. Host: hubname.org
b. Protocol: Change to SFTP
c. User: Provide the same username used to login to the Hub

4. Click Connect
5. When prompted for password, provide the local password that was created above
6. Once connected, open up the Data file and then the Projects file and double click on

the project that you would like to upload the files to
7. Drag and drop the files into this folder and then check inside of the site and confirm that

these files are uploaded to the right project

Enable Grant Collection Information

If you are working on a Hub that will be creating projects based on grants, then you can enable
a new step to be added in the Project creation to collect grant information. By collecting grant
information for grant funded projects, project quotas can be increase based on the project
budget and this information can help support annual reviews of the Hub. To enable this feature,
follow these steps:

1. Navigate to the backend of the Hub 
2. Hover over Components and from the drop-down click Projects
3. Click the Options button in the upper right corner of the screen
4. Inside of Options, click the Setup tab
5. Find the Collect grant info at Setup and change the drop-down to Yes
6. Click Save & Close 
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Project File Connectors

Project File Connectors

HUBzero allows for files to be shared either on a repository owned by the Hub or connect to
other file management platforms. Project File Connectors allow for these third-party file
management systems to enable files uploaded on the Hub yet stored in their system. Follow
these instructions to set-up and provide Project File Connectors to your users:

1. Navigate to the third party file management system of your choosing, such as Google
Drive or Dropbox

2. Set-up either a new project or application and fill in information about the Hub in order to
obtain an API key and API secret upon saving

3. Make sure you set the callback address to your Hub and indicate the appropriate file
system

1. Example: When setting up a Google Drive API connector to redirect to YourHub,
the following callback should be used
- https://yourhub.org/developer/callback/googledriveAuthorize

4. Once the API key and API secret have been created successfully, navigate back to
the /administrator interface and login

5. Hover over Extensions and select from the dropdown Plug-in Manager
6. Search or locate the appropriate plugin connected to the file system

1. Example: If the file system chosen is Google Drive, one would select
the Filesystem - Google Drive plugin

7. Click on the title of the plugin and change the status to Enabled
8. Insert the API Key in the Client ID and the API Secret in the Client Secret
9. Fill in an further information as necessary then click Save & Close

10. While still at the Plug-in Manager, search for and click the Projects - Files plugin.
11. Scroll down until you see an option for Default Action, and set it to Connections (view

available connections).
12. Navigate to a Project you would like to setup a new file system

1. Note: You must be a manager of the Project in order for you to set-up the File
System

13. Click on Files and then click on New Connection and choose the file system from the
dropdown

14. Choose to bypass the secondary step of connecting to the same API..... 

Setting up an External Application (Dropbox, Google Drive, AWS S3)

For using external services via OAuth2 the Hub needs a client identifier and secret for use with
that service.  The methods of obtaining these values vary from service to service and are
subject to change at the provider's discretion.  Below are the instructions for setting up a
developer application on some services (adapting the instructions with some searching should
yield similar results for other services or services that have changed their process in the future).
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[Creating an application on Dropbox]

1. Navigate to https://www.dropbox.com/developers
2. Sign in using the Dropbox credentials that you would like your Hub (the server itself) to

authenticate against, this is usually an account owned by the group or organization.
3. On the left menu, click "My Apps".
4. On the top right, click "Create App".
5. Select the access level you would like to grant your Hub to your users Dropbox

accounts.
6. Give the application a name (this name will be displayed to users when they authorize

access to their Dropbox account).
7. Read and agree (or disagree) to Dropbox's terms.
8. Click "Enable additional users".
9. In the redirect URIs section, add the URI of

"https://<yourhub.org>/developer/callback/dropboxAuthorize".
10. At this point you should save the "App key" and show and save your "App secret", you

will need to input these on cdmHUB in a later step.
11. You can now click on the branding tab and brand the application to your Hub's needs

(adding icons, links to the website, etc.).  These are all used when a user is asked to
enter their Dropbox credentials on behalf of your Hub.

Dropbox currently limits development accounts to 500 users per id/key, this can be
raised by contacting Dropbox support and applying for a production key once that limit
has been reached.

 

[Creating an application on Dropbox]

1. Log in to your Google account and go to the APIs & services
2. Navigate to "Credentials" using the left-hand menu 
3. On the "Credentials" page, click "Create credentials" and choose "OAuth client ID"
4. Create "New Credentials"
5. On the "Create client id" page, select "Web application". In the new fields that display,

set the following parameters:
1. Field:   Description
2. Name:    The name of your web app
3. Authorized JavaScript origins:   

1. https://yourhub.org
4. Authorized redirect URIs:       

1. https://yourhub.org/projects/auth  
2. https://yourhub.org/developer/callback/googledriveAuthorize

5. Web App Credentials: Configuration
6. Click "Create" to proceed

1. Your "Client Id" and "Client Secret" will be displayed
7. Save your Client Id and Client Secret to enter into the Connection settings into
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"Filesystems - Google Drive" plugin
1. Additional documentation can be found here: 

1. https://cloud.google.com/docs/authentication/api-keys
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Publications

Minting DOI's through DataCite (previously EZID)

DOI (digital object identifier) service is available on the HUBzero platform through integration
with DataCite, an international member organization that provides persistent identifiers for data
and other scholarly resources. For Purdue, this service is managed locally by the Purdue
Libraries. To inquire, contact them at datacite@purdue.edu.

Curation Workflow

Turning on Curation:

1. From the backend, navigate to Components -> Publications
2. Click the Options button
3. Click the Curation tab
4. Select ON in the Curation field
5. In the Name of Group of curators field, type in the CN of the group you want to give

curation rights to
6. Optionally, select 1 month in the Grace period for changes box if needing to give users

the ability to change the publication after it has been published
1. Note: mkAPI will not run until the one month grace period if set.  

7. Click Save & Close to ensure the changes and are submitted
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Auto-Approve Publications

If you would like certain users to have their new Publications by pass the Curation steps, you
can add them to a list where their Publications are auto-approved. To add users to this list,
follow these steps:

1. Navigate to the backend of the HUB and click on Publications underneath the 
Components drop-down

2. Inside of Publications, click on the Options button
3. Click on the Curation tab and then insert the usernames of the users who's Publications

are to be auto-approved
4. Click Save & Close to save the changes

Enabling Databases

To enable databases within Publications:

1. Log onto the administrative backend
2. Go to Components
3. Go to Publications
4. Go to Master Types submenu item
5. Select the checkbox next to the Database table row
6. Click the Edit Button
7. Find the Content block for the Databases Type
8. Click the [Edit] button next to Block Elements
9. Locate the Type drop-down, change file to data

10. Change the Maximum count to 1
11. Save the Block Element

 

 

Creating a Publication License

1. Navigate to the backend of the Hub and click on Components and from the drop-down
click on Publications

2. Open up the Licenses tab and then click the New button in the upper right hand corner
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of the page
3. Start filling out the License Information:

a. Title: The title of the license
b. Name: The name of the license, full name if the license is an acronym
c. URL: The webpage that all the legal license information
d. About: The background information about this license
e. Content: The parameters of the license such as what content this license

supports
f. Icon: Path to icon image that lives in the Media Manger on the HUB

4. Once you have filled out the License Information, begin filling out the License
Configuration:

a. Active: If this license should be automatically published and available on the
frontend for users to use after saving

b. Customizable: Should the license text be customizable for publication authors
to edit

c. Agreement required: Forces publication authors to
5. Once you have finished filling out the information for the license, click Save & Close

Selecting a Default Publication License

1. Navigate to the backend of the Hub and click on Components and from the drop-down
click on Publications

2. Open up the Licenses tab and locate the Default column
3. Locate the license that should become the new default and select the box beside the

license title
4. Click the Make Default button (star icon) and the license will be made the new default

Publishing/Unpublishing a Publication License

1. Navigate to the backend of the Hub and click on Components and from the drop-down
click on Publications

2. Open up the Licenses tab and locate the license you want to publish or unpublish
3. In the Status column you can click on the check-mark or cancel sign to change the

status of the license
4. After clicking on the status icon the new status will be automatically saved

Reordering Publication Licenses
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1. Navigate to the backend of the Hub and click on Components and from the drop-down
click on Publications

2. Open up the Licenses tab and locate the Order column
3. Rearrange the licenses by clicking the arrows facing up and down
4. The final ordering you leave the licenses in will appear the same inside of Publications

on the frontend of the Hub inside the License drop-down when creating a new
publication

Creating Publication Categories

1. Navigate to the backend of the Hub and click on Components and from the drop-down
click on Publications

2. Open up the Categories tab and then click the New button
3. Begin filling out the Category Information:

a. Name: The name of the new category
b. Alias: The shortname of the new category
c. URL Alias: The URL name for the category
d. dc:type: The Dublin Core Meta Data type
e. About: A short introduction describing what type of publication files and content

are stored in this category
4. Determine what plugins you want to connect to the this new Publication Category
5. Fill out the Item Configuration:

a. Status: Determine if the category is active (publish) or inactive (unpublished)
b. Contributable: Determine if the category can be contributed to

6. Determine the Custom Fields by creating new fields or managing the preexisting files.
The fields determine the layout of the Publication overview page:

a. Reorder: Drag and drop the different field rows to change the order
b. Field name: Change the name of the field title
c. Input Type: Determine the amount of text that can be inputted in this field from

the drop-down
d. Required: Check the box to make the field required for the publication author to

fill out before publishing the publication
7. Review the information and then click Save & Close

Publishing/Unpublishing a Publication Category

1. Navigate to the backend of the Hub and click on Components and from the drop-down
click on Publications

2. Open up the Categories tab and locate the license you want to publish or unpublish
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3. In the Status column you can click on the check-mark or cancel sign to change the
status of the license

4. After clicking on the status icon the new status will be automatically saved

 

Handling Publication Options

1. Navigate to the backend of the Hub and click on Components and from the drop-down click
on Publications

2. Open up the Publications tab and then click the Options button in the upper right hand corner of the
page

3. Inside the Publication Options, the different areas of Publications can be managed and adjusted as
needed:

4. Defaults:
1. Component ON/OFF: Turning on or off Publications
2. User Contributaions Outside of Projects: Allow users to contribute to Publications outside

of Projects
3. Email Notifications: Allow component to send out emails
4. Default Category: Newly created Publications will automatically be defaulted to this category

if not selected by the publication author
5. Default Publication Thumbnail: Path to default publication, used as a placeholder
6. Default Video Thumbnail: Path to default video, used as a placeholder
7. Default Image Thumbnail: Path to default image, used as a placeholder
8. Default Master Image: Default image for Publication page cover, used as a placeholder
9. Publication Files: Master path for restoring published data

10. URL to Documentation: URL to page with Publication information
11. URL to Terms of Deposit: URL of Terms of Deposit page on the HUB

5. Curation:
1. Name of Curators:(Hub) group members authorized to perform pre-publication curation (all

publication types) and manage curation assignment
2. Grace Period for Changes:Allow authors to make changes to a published resource within

the grace period after approval
3. Auto-approve:Automatically approve new submissions
4. Auto-approved Users:A comma-separated list of usernames to be auto-approved

3. DOI Configuration:
1. About DOI Link: a link to an explanation of what Digital Object Identifiers (DOI) are [optional]
2. DOI Namespace Start: First part of DOI namespace (what goes right after DOI: and before

/,e.g. 10.5072)
3. DOI Namespace End: Hub-specific DOI namespace end (usually 2-3 characters going after

/, e.g. F2K
4. DOI Service URL: DOI service address
5. DOI Service User/Password: DOI Service/Password
6. DOI Publisher: Publisher name (may use full HUB name) for DOI service
7. DOI Resolve URL: URL for resolving DOI's
8. DOI Verification URL: URL for verifying DOI's
9. Issue master DOI for Publication?: Master DOI links to /main page listing all previously
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published versions
4. Sections:

1. Contributors: Show/Hide the list of authors on publication page
2. Format Author Display: Format list of authors on publication page
3. Ranking: Show/Hide the ranking
4. Rating: Show/Hide the rating
5. Date: Show/Hide the date on the publication page
6. Linked Data: Show/Hide a link to an OAI-ORE compliant linked data representation in the

HTML source for each publications
7. Citation: Show example/instructions for citing this publications.
8. Suggest License: Allow users to suggest licenses
9. Citation Format: Choose format for citations

10. Supported Tag: A tag to display to indicate Org supported tools
11. Supported Link: A link display to describe Org supported tools
12. Audience Link: URL to a page describing audience levels.

5. AIP:
1. Trusted Digital Repository: Trusted Digital Repository
2. AIP Path: AIP path (for trusted digital repos)
3. MkAIP Admin Group: Group of administrators to get notification about archived dataset

Master Types: Editing Block Information

1. Navigate to the backend of the HUB and click on the tab Components
2. From the drop-down click on Publications
3. Inside of Publications, click on the tab Master Types
4. Click on the name of the Master Type that you want to edit block information in
5. Locate the Block you wish to edit

1. A Block is a section of the Publication that holds information about the materials
being published (i.e. description, abstract, etc.)

6. Find the Block Elements section and click the Edit in brackets 
7. Change the block information as fit, for example below is a use case of a small issue

that occurs in some Master Types with the abstract switching with the description:
1. In this case the abstract and description mappings are incorrect. There is a

section that tells the block which field the Publication versions table what to map
from the content block. Here, one would switch the description alias and name
from abstract to description and vise versa. 

8. Click Save & Close to save these changes

Setting Up Group Association with a Publication

Groups can be associated with a Publication that was not published from a Project owned by
any groups. Only one group can be given association rights. Usually a group is associated with
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a Publication if the group contributed materials or resources that helped with the Publication's
development or if the group helped fund this Publication. To set up the ability for users to
associate groups with their Publications, follow these steps:

1. Navigate to the backend of the Hub
2. Hover over Components and click Publications from the drop-down
3. Inside of Publications click the Master Types tab
4. Click the title of the Master Type that you want this feature to be enabled on
5. Under the section called Blocks and Configuration locate the Authors block
6. Locate the Show group ownership and allow to be assign group ownership and change

the drop-down to be Yes
7. Click Save & Close and this feature will be enabled on this Master Type 
8. Enable this on each Master Type that you wish for this feature to be enabled

Can attaching a license to a Publication be made optional?

Yes, it can be set up in specific Master Types:

1. Navigate to the backend of the Hub
2. Hover over Components and select Publications from the drop-down
3. Select Master Types tab
4. Select the Master Type you would like to manage this setting
5. Inside the Master Type locate the License block and change "Input required" to No
6. Click Save & Close

Setting up minting DOIs as optional for a Publication

It can be set up in specific Master Types:

1. Navigate to the backend of the Hub
2. Hover over Components and select Publications from the drop-down
3. Select Master Types tab
4. Select the Master Type you would like to manage this setting
5. Inside the Master Type locate the Curation Configuration block and change "Require

DOI" to Offer choice to publish with DOI or post without DOI
6. Click Save & Close
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Batch Create

1. Navigate to administrator on the Hub
2. Hover over Components and select Publications from the drop-down
3. Select Batch Create tab
4. Select a project you would like to create publications in
5. Underneath Data, click Choose File and upload a .xml file with the publications.
6. Make sure the .xml file follows the schema provided by the link on your hub

7. Click Process data and review the record to add to the database as there may be
errors.

8. After verifying the data is correct, click the Create record(s) button
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DataCite

 DataCite MDS API Application

The DataCite Metadata Store (MDS) API[1] is going to be used for Hub dataset Digital Identifier
Object (DOI) and corresponding metadata creation and update.

1. Introduction 

The DataCite Metadata Store (MDS) API is the default API for registering DataCite DOIs and
associated metadata. Below shows the requirements for using the MDS API. 

(1) The API requires authentication. If your hub or university is member of DataCite and has
DataCite credentials then you can configure DataCite to mint DOIs for your hub's publications
and tools. DataCite also has a testing guide to help with troubleshooting.

(2) DataCite assigns the DOI prefix. 

(3) DOI request needs to transfer through HTTPS. 

(4) HTTP basic authentication is performed in the DataCite Metadata Store API usage. 

 

2. DOI register 

The DOI registration takes two steps, first is to register DOI metadata, and second is to register
the DOI name and dataset URL. 

 

2.1 Registering DOI metadata 

The DOI metadata for dataset includes title,
author, dates, description, and so on. All the
metadata that a hub collects for a dataset
shows in table 1. Metadata element 

Explanation 

Identifier Identifier type is doi, and the value of identifier
is the doi. 

Creators/creator/creatorName Author(s) of the dataset 
nameIdentifier nameIdentifierScheme is ORCID? and value is

the ORICID. 
titles/title Name of the dataset. 
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publisher Holder of the dataset 
publicationYear The year when the dataset is published 
Contributors/contributor/contributorName Project leader's name 
dates There are two metadata elements, one is when

dataType is Valid, the value is the date when
the dataset is submitted on the hub; Another is
when the datatype is Accepted, the value is the
date when the dataset is approved for publish
on the hub. 

language It is set to en by default 
resourceType resourceTypeGeneral is set to the

resourceType designated by the hub. The value
is the resourceTypeTitle. 

RelatedIdentifiers/relatedIdentifier relatedIdentifierType is DOI, relationType is
IsNewVersionOf, and the value is the
relatedDoi, which is DOI of the resource that
reference this dataset. 

version Publication version 
rights The license that user selects in the dataset

submission workflow on the hub 
Descriptions/description DescriptionType is Abstract, and the value is

the abstract of the dataset 

 

The metadata elements in table 1 are saved in xml format as showing below. 

<resource xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance"
xmlns="http://datacite.org/schema/kernel-4"
xsi:schemaLocation="http://datacite.org/schema/kernel-4
http://schema.datacite.org/meta/kernel-4.1/metadata.xsd"> 

<identifier identifierType="DOI">doi</identifier> 

<creators> 

<creator> 

<creatorName>name 1</creatorName> 

</creator> 

<creator> 

<creatorName>name 2</creatorName> 
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</creator> 

<creator> 

<creatorName>name 3</creatorName> 

</creator> 

<creator> 

<creatorName>name 4</creatorName> 

<nameIdentifier nameIdentifierScheme="ORCID">orcid goes here</nameIdentifier> 

</creator> 

</creators> 

<titles> 

<title>title</title> 

</titles> 

<publisher>YOUR HUB's NAME</publisher> 

<publicationYear>year</publicationYear> 

<contributors> 

<contributor contributorType="ProjectLeader"> 

<contributorName>name</contributorName> 

</contributor> 

</contributors> 

<dates> 

<date dateType="Valid">date</date> 

<date dateType="Accepted">date</date> 

</dates> 
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<language>en</language> 

<resourceType resourceTypeGeneral="Dataset">Datasets</resourceType> 

<version>1.0</version> 

<rights>Attribution 3.0 Unporte</rights> 

<descriptions> 

<description descriptionType="Abstract"> 

Description goes here 

</description> 

</descriptions> 

</resource> 

All the metadata elements conform to the DataCite metadata schema [2] standards. 

The MDS API can generate random DOI name when prefix is included in the metadata
registration. The identifier in the metadata xml can be left empty in this case. 

The curl package can be used to submit the metadata to MDS service, see example below.
Note that the [PREFIX] would need to be replaced with your hub's DataCite prefix. 

curl -H "Content-Type:application/xml;charset=UTF-8" -X PUT -i --user username:password -d
@[PREFIX].xml https://mds.test.datacite.org/metadata/10.5072 

The response to the call above is OK ([PREFIX]/XXXX-XXXX). We need take the DOI out from
there and use for further process. 

The identifier value in the metadata xml on DataCite will be replaced by the DOI name that is
created in this step. 

The DOI is set to Draft state [3] after the metadata are registered. 

 

1.2.2 Registering the URL 

The second step is to register the DOI name and the URL that refers to the dataset. Below is an
example of the curl command. Note that DOI name and URL to the dataset is included. 
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curl -H "Content-Type:text/plain;charset=UTF-8" -X PUT --user username:password -d
$'doi=[PREFIX]/0000-03VCnurl=http://example.org/publications/1'
https://mds.test.datacite.org/doi/10.5072/0000-03VC 

The DOI transits from Draft state to Findable state after the DOI name and URL is registered. 

Below table includes the endpoint and other
useful information that need to use in the DOI
registration in production. The endpoint, prefix,
username and password need to be configured
on the admin interface for any development and
production environments. 

Value 

DOI prefix [PREFIX]
MDS production endpoint https://mds.datacite.org 

 

2. Update DOI Metadata Records 

Update the DOI metadata is the same as storing a new version of the DOI metadata. According
to the MDS API document, we need to issue a post of the metadata xml to DataCite. Below is
an example on what the curl command should look like for such operation. 

$ curl -H "Content-Type: application/xml;charset=UTF-8" -X POST -i --user username:password
-d @[PREFIX]/JQX3-61AT.xml https://mds.test.datacite.org/metadata 

 

Reference list 

1. https://support.datacite.org/docs/mds-api-guide 

2. http://schema.datacite.org/ 

3. https://support.datacite.org/docs/doi-states 

4. https://support.datacite.org/docs/testing-guide

 

 

 

Switching from EZID to DataCite
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1. Navigate to /administrator and login to the backend of the Hub
2. Click on Components and then select Publications
3. Click on Options and then click on DOI Configuration

1. Note: You will only be able to access the Options button if you are a super user.
4. Locate Enable DataCite or EZID DOI Service and select from the drop-down the

appropriate option
1. Note: When the "DataCite" is selected, the DataCite DOI service is activated and

only DataCite related options on the configuration form are going to show up.
When "EZID" is selected, EZID DOI service is activated and only EZID related
options on the configuration form are going to show up. When "None" is
selected, all options related to DOI service will be hidden. When users publish a
dataset in this case, a message saying that "No DOI service is selected and
please contact site administrator" is popping up.

5. Click Save & Close

                           75 / 270



HUB MANAGERS
 

Resources

Creating a Resource

1. Log in to the backend of the Hub, hover over the Components tab and click Resources
2. Click New to create a new Resource
3. In Details insert the following details about the Resource

a. Title: This is the name of the Resource that users will see.
b. Type: The type is the classification of the Resource.
c. Alias: The title of the Resource that is used in the URL.
d. Location: The place where the Resource can be found.
e. Time: This is the creation date of the Resource.
f. Canonical: A separate URL can be added to the Resource to connect a

separate URL or link to the Resource.
g. Intro Text: This is the basic information of the Resource or the abstract of the

Resource.
h. Main Text: This is the main section of the Resource information.

4. In Contributors insert the authors of the Resource by inputting their User ID, name, or
username and click Add

a. Removing an Author: Click the trashcan beside the user’s name or Delete icon
to remove the user as an author on the Resource.

b. Changing the Affiliation: Click in the Affiliation text box and type in a new
affiliation or title that labels how this user is affiliated with the project, for example
Researcher.

5. In Publishing insert the following details about the state of publishing for the Resource
a. Standalone: Check the box to make the Resource easier to find or uncheck the

box to disable that access.
b. Status: This is the state of the Resource and it’s availability to the Hub.

i.Draft (user created): The Resource is in the process of being created by a user.

ii.Draft (internal): The Resource is in the process of being created by an administrator on the
back-end of the Hub.

iii.Pending: The Resource is waiting for approval by an administrator of the Hub.

iv.Unpublished: The Resource is not available to the front of the Hub.

v.Published: The Resource is available to the front of the Hub.

vi.Deleted: The Resource has been deleted from the front of the Hub.

c. Group: Select a group on the Hub to add the resource to the group.
d. Access Level: This determines what users can access the Resource.
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i.Public: The Resource is available to all users of the Hub and visitors of the Hub.

ii.Registered: Only registered users of the Hub can access the Resource.

iii.Special: Only administrators can view the Resource.

iv.Protected: The Resource’s abstract can be viewed, but only group members can access the
files. A group must own the Resource

v.Private: The Resource is only visible to group members. A group must own the Resource.

e. Change Creator: The drop-down can be used to change the creator to another user of
the Hub or administrator.

f. Start Publishing: The date that the Resource was published on the Hub.
g. Finish Publishing: The date that the Resource was unpublished from the Hub.
h. Hits: This is a number totaling all of the times a user has read to used a resource.

6. In Files upload the files for the Resource
a. Uploading a File: Add a file to the Resource by selecting a file and uploading it

to the Resource by clicking Upload.
b. Changing the File’s State: Select the file and use the drop-down to change the

visibility of the file by clicking Apply. For example, this allows images added to a
Resource the ability to open as an image instead of a download.

c. Create a Directory: This can create a file to add to the Resource by adding the
title of the directory in the text box.

7. In Tags type in words that affiliate the Resource with labels or titles. These tags can
connect the Resource with other parts of the Hub or words that can make searches on
the Hub easier to locate this Resource

8. In Parameters select the restrictions that can be set on this Resource to limit what is
visible, so parts of the Resource that are not filled out can be hidden from users

a. License: To connect this Resource with a license, type the license in the
provided text box.

9. Review the Resource, then click Save & Close

 

Editing a Resource

1. Log in to the backend of the Hub, hover over the Components tab and click on 
Resources

2. Locate the Resource, and check the box of the resource to select it
3. Click Edit to edit the content of the Resource
4. Once the content has been edited, click Save & Close
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Deleting a Resource

1. Log in to the backend of the Hub, hover over the Components tab and click Resources
2. Locate the Resource that is to be deleted
3. Select the Resource’s check box, and then click Delete
4. The Resource will be automatically deleted and removed from the Hub permanently

Creating Resource Types

The default list of types may not work for all Resources, thus any Hub administrator can create
a Resource Type. This can be done from the administrative backend of the site by following
these steps:

1. Log in to the backend of the Hub
2. Navigate to the Components tab and then click on Resources
3. Once the Resources Manager page has loaded, select Types from the sub-menu found

under the Resources Manager title
4. You should now be presented with a list of all the Main Types (selected by default).

There are multiple categories of types
1. If not already selected, select Main Types from the Categories option found

directly above the list or navigate the listing until you see those designated as 
Main Types. These are the primary types of resources users will be able to
contribute, browse, etc.

5. Click the title of a type to edit it or click New from the toolbar on the top right of the page
6. Fill in the title and alias of the new type
7. Select the category of the new Resource Type from the drop-down

1. Generally it is a best practice to select the Main Types option from the drop-
down if you want to give users easy access to the new Resource Type.

8. Decide if this resource type can be contributable from the frontend
by checking/unchecking the Contributable checkbox

9. Add a description in the Description text box to describe the new Resource Type
10. Decide what custom fields you wish to have filled in by the user for that resource type

1. Field Name: The name of the field where data about the resource is entered.
2. Input type: Options are single-line text boxes, multi-line text areas, checkboxes,

select list (pull down), radio options, pre-defined options (language list, etc.).
3. Required: A field may be required or not. By checking the Required box, this

field must be filled out by the user in order for them to submit the Resource
11. The Custom Fields can be reordered by selecting the multiple lines under Reorder and

dragging up or down depending on the preferred placement of the fields
12. Add a new custom field by clicking the Add new row button under the current fields
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13. Click Save in the toolbar on the top right of the page
14. New resource types should now be available as a resource option and changes to types

should take affect immediately

Creating a Series Resource

A series is a resource type that allows multiple resources to be placed under a parent resource.
This is especially useful for resources that are related and can be viewed together.
Administrators can create these resources on the backend of the Hub.

 

Create the Parent resource:

1. Log in to the backend of the Hub and under the Components tab select Resources
2. In the Resource Manager, create a new resource by clicking the New icon
3. Fill in the new resource details such as the title, location, and text
4. In the type drop down, select Series as the new resource type
5. Select the contributors by entering the user’s name or user ID and then add them to the

list of contributors
6. Fill in the publishing information by selecting the status as Published, the group the

resource will belong to, access level, creator of the resource, and the publishing dates
7. Click Save & Close to save the new resource series

 

Add the Child resources:

1. In the Resource Manager, find the new resource series and click on the + under the
column Children

2. Create a new resource to add under the parent resource or add in previously created
resources by clicking Add existing and typing in the resource ID, then click Next

2. Note: Only add one child resource at a time.
3. After one child has been created, you can continue adding children by clicking Add

Child under the Resource Manager: Child Resource. Repeat the process until you have
completed the series

4. View the new Resource series on the frontend of the Hub
a. On the Resource, click Series and you will be able to view all of the resources

under the parent resource.
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Installation & First Time Configuration

1. A system administrator must install the hubzero-solr RedHat or Debian Package using
a package manager such as yum or aptitude

1. On RedHat: sudo yum install hubzero-solr
2. On Debian: sudo apt-get install hubzero-solr

2. To start the service: sudo service hubzero-solr start OR sudo /etc/init.d/hubzero-
solr start>

3. A Hub administrator may configure the Hubzero CMS to use Solr instead of basic search
by going to Components > Search > Options > Engine > Apache Solr

4. A Hub administrator must further configure the service by clicking the “Solr” tab in the
Search Options. The default parameters will work out-of-the-box for Open Source Hubs.
HUBzero Managed Hubs will use the following port-numbering.

Development: 2090
Stage: 2091
Scan/QA: 2093
Production: 2093

Note: The default configuration should be acceptable. Running Solr on
another host, changing the core, the path, or the log path are at the Hub
Administrator's own risk.

5. Click Save & Close 
6. Return to the Search and you should see a status page like the one below:
7. If this is the first time the Hub has used Solr as its search engine, the index will need to

be filled with current data
1. This is a lengthy operation during the first run
2. Unless there is massive data corruption, this will only need to be performed once
3. To check the progress of the indexing process, you may click on the Index

Queue tab in the Administrative Search interface
8. Once the full index has been built, searching can be completed from the enabled search

interfaces

If there were any issues with configuration, please submit a support ticket and the HUBzero
team will assist you further.
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Maintaining the Index

There should be very little effort needed to maintain the index. Solr maintains the index and the
HUBzero CMS will instruct Solr to add, remove, or update records inside of its index.

Solr saves its index on the filesystem of the server which allows the retention of data if the
server needs to reboot or the Solr process crashes. This prevents having to rebuild the index
from scratch in such events.
 

IMPORTANT NOTE: Due to the large amount of processing power needed to convert database
content into a searchable document and the need to communicate with a system outside of the
CMS, changes to the index WILL NOT be reflected immediately. The queue will be worked on a
first-in-first-out basis. This means that the oldest item in the work queue will be processed first.
The amount of time it takes to perform indexing operations depends on the amount of data
contained on the hub. If there is a large amount of content, the time to perform a full index will
be greater. Once the full index is built, indexing operations should be noticeably quicker
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Plugins

Search plugins allow developers to add support for different component data in the hub. In order
to appear in the search index, the plugin must be enabled. This can be accomplished by going
to the Administrative backend > Plug-in Manager > [Filter by Type: Search] > and ensuring that
the types are enabled. For example Solr will index wiki pages when the “Search Wiki” plugin is
enabled.

The plugin provides some necessary information for indexing and other search-related
operation. By default, the categories in the search interface correspond with these plugins.

System Search Plugins

In order to keep the search index “fresh”, a couple of new system Events have been made that
capture when items using the Relational Class / ORM are created, edited, or deleted. Once the
system event fires, it calls an event in the Search - Index plugin which handles placing the newly-
updated data into the processing queue. A migration has been written to ensure that the System
- Content plugin and the Search - Solr plugin have been enabled. If you notice that the index is
not being refreshed with new content, check that both of these plugins are enabled.
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Blacklist

The blacklist allows Hub administrators to “strike” things from the search index. This may be
necessary to override  If Solr indexes something, it will be reindexed unless it is on the blacklist.

To remove an item from the seach index, go to the Administrative Backend > Component >
Search > Search Index  and Click on the name of the type of record you would like to remove.
Let’s say, for example, you needed to remove a Resource.

1. Click Resource

 

2. You will then see all resources indexed by Solr
3. You may use the search box to locate the record
4. Once you locate the record, click Add to Blacklist 

5. Once the button is pressed, the request to remove the record will be placed into the
queue 

6. Once the worker processes the record, it will no longer be searchable by anyone
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Administration

Restarting Solr

If Solr needs to be restarted, a system administrator can issues the following commands:

1. sudo service hubzero-solr restart
2. sudo /etc/init.d/hubzero-solr restart

Solr Index CRON Updater

In order to keep the Solr index up-to-date, the CMS will periodically call a routine to process the
queue. Although CRON is not the best tool for the job, it will dutifully process the queue every
minute if configured. There are plans to develop a background process which will make this
process more efficient.

To configure the CRON Task, follow these steps:

1. Navigate to /administrator
2. Hover over Components  and click Cron from the drop-down
3. Click Add a New Task and set the "Event:" to Process Queue

4. The New Cron Task should be configured to run every minute
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Breadth

The question is “What can I search for?”. The answer is “anything you have access to
contained within the list in Search Categories. To see all content within these categories
perform a simple query using the wildcard character “*” as shown below.

A better of what is currently inside Solr’s index can be viewed on the administrative backend by
going to Components >> Search >> Search Index Tab. The number of index items is located
next to each type. Clicking on the name of the hub type will perform a search on that type,
displaying all items that are within the index of that type.

For instance, clicking “Resources” shows the following screen:

One can perform additional searching using the “Filter” bar on top of the results listing.
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Boosting

Search boosting allows hub administrators to move categories of matching results higher or
lower in Solr search results.

Note: your hub must have Solr installed and enabled as boosting only affects Solr search
results.

To create a boost follow the steps below:

1. Access your hub's administrator portal
2. Click on Search under the Components drop-down menu
3. Click on the Boosts tab under the component title bar

1.  

4. Click on the plus in the upper right hand corner

1.  

5. Select a category from the Type drop-down

1.  

6. Enter a number for the boost strength
1. Positive value moves matching results higher
2. Negative value moves matching results lower

7. Save the boost

1.  
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Storefront

Overview

There are six main sections that must be completed in order to add a product to the storefront:
products, product options, product skus, collections, option groups, and options.

 

All actions listed here take place in the administrator interface of the hub, similar to 
https://hubname.org/administrator.  Proper administrator privileges and logging in are required.

 

Storefront component can be found by:

1. Log into the administrator interface (/administrator)
2. From the Main Menu point the mouse to Components -> Storefront 
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Some terms that will be helpful:

 

Control buttons:  Always at the top right of a page, but under the logout button.  Typical
actions include: Save, Save and Close, Cancel, New, Edit, etc.

 

Alias:  Refers to the short name of a name or title that appears in the URL.  Does not usually
include numbers or symbols.  For example, a collection entitled Antivirus & Security
Software has an alias of securitysoftware

 

SKU: Stock keeping unit.  Specifies a specific product after options have been selected.  For
example, the product is ArcGIS, and there may be many SKUs available: ArcGIS Trial Windows
10, ArcGIS Pro Windows 10, ArcGIS Pro Mac OS 10.4+, ArcGIS Pro Linus, etc.

Creating a Collection

1. From the Storefront administrator interface , click on the Collections tab
2. From the control buttons at the top right of the page, click on the plus icon button (+) to

add a new collection
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3. Enter a collection Title and alias and select it to be Published

4. From the control buttons click on the star icon to Save and Close

Creating a Option Group

1. Click on the Option Groups tab
2. Click on the control button with the plus icon to create a new Option
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3. Enter a Title and select it to be Published
4. From the control buttons click on the star icon to Save and Close

Creating Options

1. Creating Options
Click on the round plus icon in the Option (Published column) to create a new

option

 Enter a Title and select it to be Published

From the control buttons click on the star icon to Save and Close

Repeat as needed for additional options.

 

Note:Clicking the number in the options column will display the list of all created options that
option group.New option may also be added from that page by clicking on the plus icon control
button.

 

Creating a Product

1. Click on the Products tab
2. Click on the control button with the plus icon button to create a new product
3. Complete the required fields and any additional fields. Be sure to select the correct

options on the right column of the page
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4. From the control buttons, click the check icon to Save and for the additional options to
appear

5. Click on the Edit type-related options for the EULA , etc

6. Enter the desired text and if the EULA is required. When complete, click on the Save
and Close star from the control buttons to return to the Product page
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7. Click on the Save and Close star again to save and close the product

Creating a SKU

Click on the Products tab and then Click on the number under the SKUS (published) column.

Click the plus icon (+) to create a new SKU
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Enter a Title and Price.

Select the individual option created earlier for this specific SKU

Enter an override EULA or any additional product options

In the right column, select the desired options and select the SKU to be Published

Specify the download file. **See the section on uploading software files below. Be sure not to
include any spaces in, before, after the filename

From the control buttons click on the star icon to Save and Close
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Note: Clicking the number in the options column will display the list of all created options that
option group. New options may also be added from that page by clicking on the plus icon
control button.

Uploading Software Files

SFTP access only.  Please submit a support ticket to be granted access.

Restricting Products by I2A2 Characteristics

**Currently only for use with the Purdue Authentication plugin.

Setup:

1. Create appropriate access groups under the Members section for a one-to-one
relationship with an I2A2 characteristic.

2. Enable the "User - Purdue User Access" plugin.
3. Configure the plugin by pairing an I2A2 characteristic with an access group.
4. Save and close the plugin.

Configuring a product.

1. Edit a product from the Storefront
2. Select the access groups that you wish to have access to this product that are listed on

the right side of the page.  Selecting multiple checkbox combine the access groups via
OR.  Selecting an access group of "Students" and "Campus (W. Lafayette)" will allow
access to all students with Purdue credentials and everyone on the W. Lafayette
campus with Purdue credentials.

Direct SKU Linking

A direct link to a product SKU is available.  This link may be shared to allow someone quick
access to a specific item's description page.  The direct SKU link can be found when editing a
SKU in the info box on the top right of the page with a label of "Direct URL:".
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Entering list of serial keys for a product SKU

A single serial or multiple serial numbers (or License keys) can be added to be tracked as
inventory for a product SKU.

1. Edit a SKU
2. At the bottom right of the page find the "Serial numbers" section.
3. Select single or multiple.
4. Save the page.
5. A "Manage Multiple Serial numbers" button will appear.  You may enter serials number

via that interface or via CSV upload.

Notes:

The ability to enable to disable inventory tracking for the SKU is not available as tracking is
automatically and will deactivate serials numbers as they are distributed.

**A inventory notification threshold should also be set to be notified that an inventory of
available serial numbers are low.

Tracking Inventory of SKUs

Tracking or a count down of product SKUs is available.

1. Edit a SKU
2. On the right select the "Track Inventory:" to YES.  (if Serial Management is on, this

option will not be displayed)
3. Enter a value in "Inventory:" field. 
4. Enter a value in the "Inventory notification threshold:" field.

**To receive email notifications when an email address must be entered in the Cart component
option field of "Send notifications to".
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Restricting a list of usernames for a product SKU

A product SKU may be restricted by a specific list of username.

1. Edit a SKU.
2. Find the "Restrictions" section at the bottom right of the page.
3. Select "Restrict by users:" to YES.
4. Save the page.
5. A "Manage restrictions" button now appears.
6. Enter usernames via the Manage restrictions interface or via a CSV.

Notes.  Usernames must exist on the on hub before they can be added to the SKU restriction
list. A product access group must also be selected for the SKU's parent product to be able to
display in the collection list.

Download / Downloading limiting

The downloading of a SKU can be limited.

When editing a SKU, the "Total Downloads Limit:" will not allow user to download this SKU if the
number entered here has been exceed.  "Total Downloads" refers to all downloads by all users
for the SKU.

 

When editing a SKU, the "Downloads Limit per Single User:" will not allow a user to download
the SKU more than the number entered here.
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Support

Tickets

Users can create tickets when they experience a problem on the Hub that is not answered in
Questions and Answers or Knowledge Base. Tickets are ways to report bugs or issues that they
experienced with the Hub. Administrators are then able to access the Support component to
help solve these issues.

 

Answering Tickets

1. Navigate to https://yourhub.org/support and login to the hub
2. Access the Support and Ticket Tracking System
3. Select the tickets that are under the open tab on the side of the page
4. Select the ticket that has been unanswered
5. In the Comment Form, add tags to connect the ticket to search engines in the ticket

system
6. In the assignee dropdown select your name 

Note: You can only be an assignee if you have gained ACL access on the back-
end of the Hub.

7. Select the severity of the ticket. Critical and major are high priority tickets. Normal tickets
are common yet important tickets. Minor and Trivial tickets are low priority

8. Select the status of the ticket from the drop down. Open tickets are unanswered tickets; 
Awaiting User Action holds the ticket until they answer or respond. Closed tickets are
listed by the reason they are closed: Answered, Duplicate, Fixed, Invalid, Spam,
Transferred, Won’t fix, and Works for me

9. Answer or leave a canned response for the user that submitted the ticket. Canned
responses allow the assignee to respond using generic responses premade to fit various
situation such as: first response, second response, and closing ticket

10. In the bottom box CC any users or other assignees to the ticket to include in the
conversation on the ticket, then submit your response

 

Messages

To aid in responding to support ticket submissions, you may create custom message templates
for frequently used responses. Example responses include a Ticket resolved message sent
upon closing a ticket or a Request for more information message.

Messages may also include placeholders where information that changes can be specified. For
instance your message template may include references to the specific ticket ID number or site
name. A Ticket resolved template could look like this:
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“Thank you for using the (sitename), and for reporting this problem. We believe that your issue
(ticket#{ticket #} in our system) has been resolved. If you continue to have problems please let
us know.  You may reopen a closed issue at any time by following the link at the end of this
message and adding a comment to the ticket."

Thank you for helping us to improve (sitename)!

--the (sitename) team

Here we have two placeholders: {ticket#} and {sitename}. The placeholders are replaced with
their current value at the time of composition. When chosen from the select box under 
Comments of the response form, the comments text box will be filled with the following:

“Thank you for using the YourHUB, and for reporting this problem. We believe that your issue
(ticket #123 in our system) has been resolved. If you continue to have problems please let us
know. You may reopen a closed issue at any time by following the link at the end of this
message and adding a comment to the ticket."

Thank you for helping us to improve YourHUB!

--the YourHUB team

 

Resolutions

Resolutions give a report of how the ticket was solved once it is closed. For example if a ticket
was answered the resolution would be Answered or if the ticket was never answered because
the ticket owner did not respond with new information then the ticket could be closed with the
resolution Closed (No Answer). This system helps inform the support team or administrators
that search through closed tickets the necessary information on why the ticket was closed.

Open: unanswered ticket
Awaiting user action: waiting for user to respond
Closed: ticket has been answered or fixed
Answered: answered question of the user
Duplicate: the issue has already been reported
Fixed: the bug that was reported has been fixed
Invalid: this status is used for testing purposes and spam
Transferred: the issue was a enhancement request and moved to the wish list
Won’t fix: no solution to the issue
Works for me: the bug reported is not reoccurring for assignee of the ticket

 

Tags
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The tags allow tickets to be searched and tracked easily. Tags can also serve to inform the
support team about the problem without reading through the whole context of the ticket.

 

Stats

The stats page gives a basic overview of support ticket activity starting at the beginning of a
chosen year, defaulting to the current year if none is specified. Stats shown may also be filtered by

group.

The following data is shown:

Tickets opened for the given year
Tickets closed for the given year
Tickets opened for the current month of the year
Tickets closed for the current month of the year
Tickets opened for the current week of the year
Tickets closed for the current week of the year
Open tickets
Unassigned tickets
Average ticket lifetime
A list of administrators and the number of tickets closed

Closed for the given year
Closed for the current month of the year
Closed for the current week of the year

A line chart displaying Tickets Submitted (red) vs. Closed (green) on a monthly basis

Access Control Layer (ACL)

The ACL (Access Control Layer) works in conjunction with a user login system to allow or deny
a user access to support tickets and various information or features of a ticket.

Permissions may be set for individuals or entire groups of users. All members of a group will
inherit any permission set for the group. If a user is a member of multiple groups with ACL
settings, the highest permissions will take affect.

Individual ACL settings take precedence over any other settings.

 

ACL Options 
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1. Navigate to https://yourhub.org/administrator and log into the backend of the Hub
2. Click on the Components tab and then select the Support button from the drop-down
3. Inside of Support, click on Options to view details in the ticket submission process
4. There are three tabs that all define the parameters of tickets and available options for

the Hub ticket system
a. Defaults: displays the front page options when submitting and answering tickets
b. Files: controls the parameters of how documents and tickets are uploaded
c. Antispam: controls the words that can be used when submitting tickets to keep

spam out of the ticketing system
5. Click Save or Save & Close to allow the changes that were made in these tabs to be

saved on the Hub

 

Giving ACL Permission 

1. Navigate to https://yourhub.org/administrator and log into the backend of the Hub
2. Click on the Components tab and then select the Support button from the drop-down
3. Inside of Support, click on the ACL tab 
4. Under all of the available users that have permission for ACL access, there is a text box

to input alias or ID name
5. Input the name of the new ACL access, then select the sections that the user can have

control in
6. Click Add to confirm the new ACL access for the user 

Note: Super Administrators automatically receive ACL access and support
permissions.

Enabling Email Notification for Abuse Reports

1. Navigate to https: yourhub.org/administrator, and login as an administrative user on
the backend of the Hub

2. Click the Components tab and then select the Support button located in the drop-down
3. On the Support: Tickets page, select the Options button in the top-right corner of the

page
4. Select the Abuse Reports tab
5. Enable notifications to be sent when a report is created by selecting Yes from the drop-

down
6. Add the email address that the notification should be sent to by inserting it into the 

Notify when abuse report created box
7. Click the Save & Close button to save the changes and you will be navigated back to

the Support: Tickets page
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Enabling Privacy/Minimal Information Mode in Support Emails

Ticket content can be protected in emails by enabling privacy/minimal information mode to avoid
sending potentially sensitive data. This Support feature complies with FISMA and HIPAA
standards on restricting sensitive data.

In order to turn on this feature, follow these steps:

1. Navigate to the backend of the Hub and locate the Components tab
2. Click on the Components tab and from the drop-down click on Support
3. Inside of Support, locate the Options button
4. Locate Email Content and select from the drop-down the configuration of your choosing

1. Terse: Emails will only contain a notification that the ticket has been updated
and removes all sensitive information about the ticket.

2. Detailed: Emails will contain a notification that the ticket has been updated and
details about what was updated in the ticket

5. Click Save & Close to save the new changes
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Tags

Managing Tags

Tags are the Hub's way to highlighting and attaching key words to various content on the Hub.
Based off of hashtags, Tags allow users to connect various projects, groups, publications,
together by attaching the same tag to each piece of content. When creating or editing an area
on the Hub, you will be presented with a field to submit a tag.

You can simply add a tag by typing in the field a word and then click Enter. If you wish to
remove the tag, hover over the tag and an X will appear to the right of the word. Select the X 
and the tag will be removed.

How to Tag Tickets

Tags are essential in tracking tickets in the Support section of the Hub. Track various
component requests, broken sections and questions all by adding Tags to a ticket. For example,
when testing out a newly added feature or development item, you can tag your support tickets
with three tags conveying the information of where, what, and why. The following points define
each tag and have a list of examples under each point:

 

Where: The first tag should convey where the ticket is coming from.
Hub: Hub name
Development Environments: QA, dev, production

What: The second tag should convey what release the ticket involves.
Releases: The release number

Why: The third tag should convey why the ticket is being submitted.
Components: projects, collections, groups, super groups
Areas: backend, frontend, plugins, menus
Reasons: security, scripts,  hubupdate

Creating a Tag    

1. Log into /administrator interface of the Hub 
2. Hover over the Components tab and from the drop-down select Tags
3. Click on the New button
4. Check the box if the Tag will be viewable for administrators only or if the new Tag will

viewable by all users
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5. In the Tag text box write the Tag. Tags cannot have capitalized letters, non-
alphanumeric characters, spaces, or punctuation

6. In the Tag description box, write a detailed description of what the Tag represents
7. In the Alias box, write in a comma separated list the different Tags that the new Tag will

represent
8. Click Save & Close to save the new Tag

Deleting a Tag

1. Log into the /administrator of the Hub
2. Hover over the Components tab and from the drop-down and select Tags
3. Under the Tag tab, locate the tag that is to be deleted
4. Select the tab by checking the tag’s box
5. Once the tag has been selected, click Delete
6. The tag will be permanently removed from the Hub
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Usage

Overview

Hub usage statistics can be found on the /usage page. On this page the amount of user visits,
which calculates unique IP address visits identified by residence and organization as a graphic
along with downloads, also identified by IP address residence and organization. Tool simulation
users and jobs can be collected along with the total wall time, interaction time and CPU time.
Usage is collected each month and is a great resource to show community growth.

Usage Breakdown

Usage is a feature that gathers statistics about user registration, tool run, files downloaded and
more. 

The Usage breakdown can be divided up by these statistics:

Users - Visits: Amount of visits to the Hub and page hits by public visitors
Users - Downloads: Files downloaded by the user from Publications, Resources, Project
Files, etc.
Users - Residence: Location defined by a user's profile
Users - Organization: Organization defined by a user's profile
Simulation - Users: Total tool users running jobs on the Hub
Simulation - Simulation Jobs: Total tool jobs run on the Hub
Simulation - Total CPU Time: Total CPU time used
Simulation - Total Wall Time: Total wall time
Simulation - Total Interaction Time: Total time a tool jobs were interacted with
Simulation - Users with > 10 minutes of CPU Time: Users running more than 10 minutes
of CPU time
Simulation - Avg. Number of Simulation Jobs/User: Adverage number of simulation jobs
per user
Simulation - Avg. Time between First and Last Simulation: Adverage time between
simulations
Simulation - Repeat Users with > 10 Simulation Jobs: Users running more than 10 jobs
Simulation - Repeat Users with > 3 months: Users running jobs for more than 3 months

Usage Maps

The Usage Map provides an outlook on who is currently active and online through out the world.
This world view will add a location flag at the GPS location of that user. This location is defined
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by the address and location the user gives in their profile. By clicking on the location flag, one
can view the user's profile and location details.
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Wiki

Editing a Wiki Page

1. Log into the /administrator interface
2. Hover over the Components tab and from the drop-down select Wiki
3. Locate the wiki page that is to be edited
4. Click on the title of the wiki to open it up
5. Edit the wiki form then click Save & Close to save the changes 

Deleting a Wiki Page

1. Log into the /administrator interface
2. Hover over the Components tab and from the drop-down select Wiki
3. Locate the wiki page that is to be deleted
4. Check the box beside the wiki title
5. Click Delete to deleted the wiki page
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Wishlist

Terminology of Wishes

Active- open wishes where people can vote on the wish
Accepted- the wish has been accepted and will be activated
Rejected- the wish will be denied for now
Granted- the wish is already available or will be in the next update
Like- voting up the wish
Dislike- voting down the wish

Creating a Wish

1. Navigate to /administrator
2. Hover over Components and from the drop-down select Wishlist
3. Click the New button
4. Fill out the wish form
5. Click Save & Close

Editing a Wish

1. Navigate to /administrator
2. Hover over Components and from the drop-down select Wishlist
3. Search for the wish and then click on the wish's title
4. Click the Edit button
5. Edit the wish form
6. Click Save & Close

Deleting a Wish

1. Navigate to /administrator
2. Hover over Components and from the drop-down select Wishlist
3. Search and then click on the title of the wish
4. Click the Delete button and the wish will be deleted
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Publishing a Wish

1. Navigate to /administrator
2. Hover over Components and from the drop-down select Wishlist
3. Search and then check the box by the wish's title
4. Click the Publish button and the wish will be published

Unpublishing a Wish

1. Navigate to /administrator
2. Hover over Components and from the drop-down select Wishlist
3. Search and then check the box by the wish's title
4. Click the Unpublish button and the wish will be published
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Newsletters

Overview

Newsletters is a component where Hub Administrators and Managers can create and send
newsletters to your Hub's community, either sharing big news or the latest published resource.
Newsletters offers Administrators and Managers the option to create a template for the
newsletter copy, the opportunity to create a mailing list to send the newsletter to individuals
outside of the Hub, and the ability to schedule a newsletter to be sent out at a later date.

Displaying Newsletters on the Hub

1. Log in to the backend of the Hub and navigate to the Components tab and then click 
Newsletters

2. Locate the newsletter that is to be published to the Hub, and then select the newsletter
3. Click Edit to open up the newsletter and inside the Newsletter Details go to Show

Newsletter on HUB
4. Choose from the drop-down Show to publish the newsletter to show on the frontend of

the Hub
5. Click Save & Close to save the new changes

Creating a Newsletter Template

1. Log in to the backend of the Hub and access the Components tab and then click on 
Newsletters

2. Select the Templates tab and then click New to start a new template
3. Type in the name of the new template
4. Insert the primary title color, primary text color, secondary title color, secondary text

color
a. The colors are in HTML format. To find more colors and the related HTML codes,

go here: http://html-color-codes.info.
b. Note: If you don’t fill in HTML colors, black and gray default colors will be used.

5. Fill in the design by using HTML formatting to the template
a. Use the suggestions on the side of the page to add content to the template.

6. Click Save & Close to save the new template design

Editing a Newsletter Template

                         111 / 270

http://html-color-codes.info


HUB MANAGERS
 

1. Log in to the backend of the Hub and access the Components tab and then click on 
Newsletters

2. Select the Templates Tab and then check the box to select the template that needs
editing

3. Click Edit to begin editing the material
4. Click Save & Close to save the newly edited content

Deleting a Newsletter Template

1. Log in to the backend of the Hub and access the Components tab and then click on 
Newsletters

2. Check the box to select the template that is going to be deleted
3. Click Delete to permanently delete the template
4. The template will then be removed from the Hub

Creating a Newsletter

1. Log in to the backend of the Hub and access the Components tab and then click 
Newsletters

2. Click on New to create a new Newsletter to send out to your users about new updates
or news that is happening for the Hub

3. Under Newsletter Details fill in the title of the Newsletter or Name and the alias, what
appears in the URL, of the Newsletter

4. Fill in the issue number of the Newsletter
5. From the drop-down decide what email format the Newsletter will be sent in

a. HTML: The Newsletter will be formatted with HTML coding. HTML emails will
also auto build a plain text version to send along with the HTML version. This is
primarily for avoiding being marked a spammer.

b. Plain Text: The Newsletter will be formatted with plain text and no coding.
6. Select the template of the Newsletter
7. Select from the drop-down if the Newsletter is to show on the Hub right away

a. You may want to hide private email newsletters or plain text email newsletters
from showing on the Hub.

8. Select from the drop-down if the Newsletter is to track the emails
a. Learn more about email tracking here: http://kb.mailchimp.com/article/about-

open-tracking
9. Click Save to save the new changes and to add to the Newsletter the content

10. Add the Newsletter Mailing Details
11. Insert the main content of the Newsletter in the Newsletter Primary Stories

a. Title: Title of the article
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b. Order: Order of the Issue
c. Story: Content of the Newsletter

12. Insert the Newsletter Secondary Stories for content in the sidebar of the Newsletter.
Fill in the same sections of content as the primary stories

13. Click Save & Close to save all of the content and to finish the new completed
Newsletter

Editing a Newsletter

1. Log in to the backend of the Hub and access the Components tab and then click 
Newsletters

2. On Newsletter main page, select the box beside the Newsletter that is going to be edited
3. Click Edit to begin editing the Newsletter
4. Click Save & Close to save the newly edited content

Deleting a Newsletter

1. Log in to the backend of the Hub and access the Components tab and then click 
Newsletters

2. On the Newsletter main page, select the box beside the Newsletter that is going to be
deleted

3. Click Delete to permanently delete the Newsletter from the Hub

Copying a Newsletter

1. Log in to the backend of the Hub and access the Components tab and then click 
Newsletters

2. On the Newsletter main page, select the box beside the Newsletter that is going to be
copied

3. Click Copy to copy the Newsletter selected
4. The Newsletter and all its stories or content will be copied

Default Mailing List
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There is a default mailing list of every user who has agreed to receive emails from the Hub. This
mailing list is updated with new users who have modified their settings or who have been
blocked every time a new mailing is created. To send a newsletter to the default mailing list,
follow these steps:

1. Navigate to the /administrator interface
2. Hover over Components and from the drop-down select Newsletter
3. Click the checkbox next to the newsletter you wish to send
4. Click the Send button in the toolbar
5. Select the Default mailing list and determine the time when you want the newsletter to

be sent
6. Click the Send button in the toolbar and your newsletter will be sent to the users who

opted in at the time you selected

Creating a Mailing List

1. Log in to the backend of the Hub
2. Navigate to the Components tab and click on Newsletters
3. Under the Newsletters, click the Lists tab
4. Click the New button to start a creating a new mailing list
5. Fill in the name of the mailing list, and then choose if the mailing list is going to be

private or public
a. Private: Must be invited to join list.
b. Public: All Hub visitors can view the mailing list and can choose to join the

mailing list.
6. Fill in the description describing the purpose of this mailing list and indicate what types

of mailings this list will receive
7. Click Save & Close to save the basic details of the mailing list

Adding Emails to a Newsletter Mailing List

1.  Log in to the backend of the Hub
2. Navigate to the Components tab and click on Newsletters
3. Under the Newsletters, click the Lists tab
4. Select the mailing list that you would like to add emails to, then click the Manage button

(person icon) in the top right
5. Inside the list, click Add Emails to add emails to the mailing list
6. Determine if the user will be prompt into confirming the email or not having to confirm

the email
7. If all the emails are stored in an Excel file, upload the file and all the emails inside will be
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added to the list, or select the group from the Hub to add their emails to the mailing list
8. If any extra emails need to be added to the mailing list, manually enter them into the 

Enter Emails Here text box. Leave a comma after each email
9. Save the content by clicking Submit

Mailing Statistics Overview

1. Log in to the backend of the Hub and navigate to the Components tab and then click 
Newsletter

2. Select the Mailings tab in the Newsletter component
3. Select the newsletter the previously submitted mailings and then click Stats to access

the statistical report collected from the mailing
4. Inside the mailing statistics, you can view the follow details:

a. Open Rate: The percentage and total of viewers out of how many emails sent
out.

b. Bounce Rate: The percentage of emails that bounced back, thus the user did
not receive the email.

c. Forwards: The number of times viewers forwarded the Newsletter.
d. Prints: The number of times viewers printed off the Newsletter.
e. Top Locations: The top countries with the most Newsletter viewers.
f. World Map: A total count for each country highlighted on a global map of

Newsletter viewers. Hover over each country to view the number of who opened
the Newsletter.

g. Click throughs: The number of times views clicked a link in the Newsletter.

Publishing a Newsletter

1. Log in to the backend of the Hub and access the Components tab and then click 
Newsletters

2. Under the Newsletters tab, select the box beside the Newsletter that is going to be
published

3. Click Publish to publish the Newsletter
4. The Newsletter will appear on the frontend for all users to see

Un-publishing a Newsletter
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1. Log in to the backend of the Hub and access the Components tab and then click 
Newsletters

2. Under the Newsletters tab, select the box beside the Newsletter that is going to be
unpublished

3. Click Unpublish to unpublish the newsletter
4. The Newsletter will then be unpublished from the Hub
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Knowledge Base

What is the knowledge base?

The knowledge base houses helpful articles and frequently asked questions. Hub managers
can add their own hub specific articles to help their community understand how to use the
features.

 

Creating Knowledge Base Articles

1. Navigate to the Knowledge Base under the Component tab
2. Select the tab Articles
3. Select New to create a new article
4. Select the category or sub category where the article will be located
5. Fill in the title, URL alias, the body containing the article, and tags to connect the article

for easy search
6. Under State, select if the article is to be published to the Hub and the access level from

the dropdown
7. Select the parameters on what sections of the article that the users can view
8. Select the Save & Close to save the new article
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GeoSearch

How to Activate GeoSearch

GeoSearch is a component that allows users to view other members, organizations, events, and
even job postings on one map. Users can scroll over each pin and click a link to view the pin in
more detail.

 

1. Log into the administrator side of the Hub
2. Go to Extensions and click Plugin Manager from the drop-down
3. In the Plugin Manager search for CRON - GeoSearch
4. Open the plugin and then enable the plugin
5. Click Save & Close to save this change
6. In the Plugin Manager search for Geocode – Google Maps
7. Enable this plugin before moving on to the next step
8. Navigate back to the main page of the administrative side of the Hub
9. Go to Components and select CRON from the drop-down

10. Inside of the component CRON, click the Add button in the upper right hand corner of
the screen

11. Select the Event of the new CRON job to be Cron-Geosearch: Get Location Data
From Sources from the drop-down and then add the name of the new CRON job to
match the name of the event

12. Select the Frequency of the job to be Once a day, midnight
a. This is suggested to prevent overrunning Google Maps API request limit.

13. To save this new job, click Save & Close
14. Enable the new CRON job and then manually Run the job
15. Navigate to the GeoSearch main page and refresh the page
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Billboards

Overview

Billboards is a component that allows you to create a carousel effect on your home page. Slides
can be designed with an image in the background and a short piece of text that goes over the
image. Many use this feature to promote Super Groups or popular Tools.

Uploading an Image
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1. To upload an image, open the Billboard you would like to edit 
2. Click Upload Image, located underneath the Background Image field 
3. Click the Browse button located on the bottom of the Media Manager pop-up, and

locate  and select the picture you would like to upload 
4. Click Start Upload. You should then see your picture appear as an option
5. Copy the file name and paste it into the Background Image field
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Blogs

Backend Blog Manager Overview

Published - this icon means that the blog post can be viewed on the frontend of the
hub.
Unpublished - this icon means that the blog post cannot be viewed on the frontend of
the hub.
New - this button allows you to create a new blog post.
Edit - this button allows you to make changes to a blog post.
Delete - this button allows you to delete a blog post.

Creating a Blog Post

1. In the backend, navigate to Blog under the Components tab
2. On the Blog Manager, click the New (+) button in the top right to create a new blog post
3. In the details of the blog post, select the scope. The scope is the location of the blog

either on the site, member, or group. If you're creating a group blog, select the group
that the blog should belong to from the drop-down

4. Fill in at least the title and content for the blog post
5. In the publishing options of the blog post, select the state of publishing from the drop-

down, the dates of when the blog is available, and if you would like to allow comments
on the post, check the box for Allow comments

6. Click Save & Close

Editing a Blog Post

1. In the backend, navigate to Blog under the Components tab
2. Find the blog post you would like to edit and click on its title to open the post
3. Edit the content of the post
4. Click Save & Close to save the newly edited content

Deleting a Blog Post

1. In the backend, navigate to Blog under the Components tab
2. Find the blog post you would like to delete and click on the check box for that blog post
3. Click on the Delete button symbolized by a trashcan and the blog post will be deleted
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Publishing a Blog Post

1. In the backend, navigate to Blog under the Components tab
2. On the Blog Manager, select the location of the blog post from the following tabs: site,

members, or groups
3. Find the unpublished blog post you would like to publish and click on the checkbox next

to it to select it
4. Click Publish and the selected blog post will be visible to users

Unpublishing a Blog Post

1. In the backend, navigate to Blog under the Components tab
2. On the Blog Manager, select the location of the blog post from the following tabs:

site 
members
groups

3. Find the published blog post you would like to unpublish and click on the checkbox next
to it to select it

4. Click Unpublish and the selected blog post will be no longer be viewable on the front-
end
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Cart

Overview

All actions listed here take place in the administrator interface of the hub, similar to 
https://hubname.org/administrator. Proper administrator privileges and logging in are required.

 

Cart component can be found by:

1. Log into the administrator interface (/administrator)
2. From the Main Menu point the mouse to Components -> Cart

Receiving notfications

In the Cart component options, enter a email address or a comma separated list of emails to the
"Send notifications to " configuration option to receive email notifications.

Software Downloads - All Downloads

Product, Downloaded by, User Info, EULA, Downloaded date, IP, and Status can be viewed.  A
CSV can also be downloaded.

 

A SKU's status may be manually updated to "inactive" if another "active" download of that SKU
needs to be made available.  This only apply when limitations are configured for downloads. 
For example, if a user is only allow to download a SKU once, but report that there was an issue
with the download an administrator may make the previous download as inactive to allow for
another download of that SKU.

 

History is retained for each record in this report.  If a user changes status, the new status will
not be updated in previous download records.
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Software Downloads - SKU

Product and Downloaded count can be viewed.  A CSV can also be downloaded.

Orders - All orders

Order ID,  Order total, Items ordered, Order placed date, and Purchased by, can be viewed.  A
CSV can also be downloaded.

Orders Items ordered

SKU ID, Product Decription, QTY, Price, Order ID ,Order placed date, and  Purchased by may
be viewed.  A CSV may also be downloaded.
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Citations

Deleting a Citation

1. In the backend, navigate to Citations under the Components tab
2. Find the citation to be deleted, and click on the check box for that citation
3. Click on the Delete icon on the top of the page and the selected citation will be deleted
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Collections

Module for Collecting

The hub comes with a module, mod_collect, for collecting a number of content types on the
hub: resources, wiki pages, forum threads, courses, publications, and content articles. This
module can be enabled via the administrative Module Manager. Once the module is enabled, a 
Collect button will appear on the single view pages for the various types of content. Users can
then collect resources, wiki pages, etc. The collected material will be saved as a post with a link
back to the original content.

Collectible content types:

To enable the module:

Wiki pages
Forum threads
Courses
Resources
Publications

1. Navigate to https://yourhub.org/administrator/ and login as an administrative
user

2. In the backend, under the Extensions tab, select Module Manager
3. Find the module, and then select the module by clicking the small check box
4. Once the module has been selected, click Enable to enable the module
5. The module will now be active on the hub and users will be able to collect

content for collections

Editing Collection Items

Note: You have to be logged into your hub in order to complete the following tasks

1. Navigate to https://yourhub.org/administrator/
2. Locate the Components tab and then select the Collections button located in the drop-

down
3. On the Collection page, click the Items tab
4. Locate the item and then check the box beside the title of the item
5. Click the Edit button to edit the item
6. Make the changes to the item and then click Save & Close to save the changes and

you will be navigated back to the Collection: Items page
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Courses

Creating a Course

1. On the /administrator interface, navigate to Courses under the Components tab
2. At the top of the Courses panel, click the + sign to add a new course
3. Fill in the details of the course. (See below for field/option descriptions.)
4. Click on the drop-down section under Publishing, and determine if you want your

course to be a Draft or Published
5. Click on Save to save the work that you have completed. You can only further edit your

course, such as add an image or managers, after you have saved the initial details
6. Under the Managers area, add course administrators (Instructors, Managers, etc.)
7. Under the Image area, add a course image by dragging an image file into the upload

box
8. Click Save & Close to save all the details of the course and to go back to the Courses

main page, where your course will now be listed

 

Field/Option Descriptions

Course Alias: Your course alias. This will be part of the URL.
Course Title: The official name of your course. This name will be what users see when
browsing the hub.
Interests (tags): Helps categorize your course in search results. These tags can help
your course be discovered more effectually.
Blurb: A short description of the course.
Description: A longer description of the course. Here you can personalize what the goal
or concept is in further detail to your students.
Unpublished: The course is taken off the front end of the hub.
Published: The course can be found in the front end. Anyone can find the course
through searches.
Draft: The course is being drafted. The course is accessible only to course
administrators. This allows instructors and managers to build a course before it is
available to students.
Deleted: The course is deleted permanently. Once a course is deleted nothing can be
retrieved from the course after this action.

Creating Course Overview Pages (tabs)

1. In the backend, navigate to Courses under the Components tab
2. Find your course in the list. Under the Pages column, click on the + sign to add a new
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page 

Note: If there are already existing pages, you will see a number in place of the + sign.

3. Enter the title, URL, and content into the page details. In the published parameters
choose Yes to make the page active on the Course Overview 

Note: Note: A new page must be saved before files can be uploaded.

4. Click Save & Close and your new page will appear in the course pages list in the
backend. On the frontend, your new page will show as another tab in the Course
Overview

Opening up Enrollment into a Course

1. In the backend, navigate to Courses under the Components tab
2. Locate the course and click the number of offerings for that course in the 

Offerings column
3. Locate the offering and click the number of sections for that offering in the 

Sections column
4. Click the section’s title
5. Under the Details tab, locate Enrollment and select a response from the drop-down

a. Open (anyone can join): Any user on the Hub can join this section of the
course.

b. Restricted (coupon code is required): Only users with a coupon code can gain
access to this section of the course.

c. Closed (no new enrollment): This section of the course is closed and cannot be
accessed by new students.

Editing Parameters in an Offering

1. In the backend, navigate to Courses under the Components tab
2. Locate the course and click the number of offerings for that course in the 

Offerings column
3. Locate the offering and click the title
4. Locate the Parameters section and select the parameters for Progress Calculation

Inherit from course defaults- means that all of the parameters preset on the
hub will be the same for this offering.

5. Click Save & Close to save the parameters for that offering
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Editing Parameters in a Section

1. In the backend, navigate to Courses under the Components tab
2. Locate the course and click the number of offerings for that course in the 

Offerings column
3. Locate the offering and click the number pf sections for that offering in the 

Sections column
4. Click the section's title
5. Under the Details tab, locate the Parameters section and select the parameters for 

Progress Calculation
Inherit from course defaults- means that all of the parameters preset on the
hub will be the same for this section.

6. Click Save & Close to save the parameters for that section

 

Editing Discussion Parameters

1. In the backend, navigate to Courses under the Components tab
2. Find the course and the click the number in the Offerings column
3. Locate the offering and click the number of sections for that offering in the 

Sections column
4. Click the title of the section that you would like to change the discussions settings in
5. Under the Details tab, locate the Discussions Parameters area. In the drop-down,

choose All sections to show discussion threads across all sections in this offering, or
choose This section only to show discussion threads only by this specific section

6. Click Save & Close to save the changes to the parameters

Deleting Assets

Note: You must be logged into your hub in order to complete the following tasks.

 

1. Click the Components tab and then select the Courses button located in the drop-
down

2. On the Courses page, locate the course
3. After locating the course, under the Offerings column, select the number of offerings
4. On the Courses: Offerings page, locate the offering
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5. Locate the Units column and select the number of units
6. Locate the Unit, then under the Asset Groups column select the number of under the

column
7. Inside Asset Groups, check the box of the offering
8. Click the Delete button to permanently remove the content and asset from the course
9. A pop-up will appear asking Are you sure you want to remove these items?

10. Proceed to click OK, and the items will be removed from the course

Creating Certificates

Note: You must be logged into your hub in order to complete the following tasks.

 

1. Click the Components tab and then select the Courses button located in the drop-
down

2. On the Courses page, locate the course
3. After locating the course, under the Cert. or certificate column click on the No

Certificate Set button
4. On the Courses: Certificate: Create page, upload a PDF certificate file by choosing the
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file from your files and then clicking Upload
5. Once the file is uploaded, a preview will appear

a. The preview is where you can place, drag, and resize various placeholders for
elements such as the user’s name, course name, etc. to be dynamically filled in
when a certificate is claimed.

6.  Click the Save & Close button in order to navigate back to the Courses page

Deleting Certificates

Note: You must be logged into your hub in order to complete the following tasks

1. Click the Components tab and then select the Courses button located in the drop-
down

2. On the Courses page, locate the course
3. After locating the course, under the Cert. or certificate column click on the Certificate

Set button (checkmark icon ?)
4. On the Courses: Certificate: Create page, click the Delete button

5. Click the Save & Close button in order to navigate back to the Courses page
6. A pop-up will appear stating Entry successfully removed and you will be navigated

back to the Courses page

Changing Deployment Time

Note: You must be logged into your hub in order to complete the following tasks.

1. Click the Components tab and then select the Courses button located in the drop-
down

2. On the Courses page, locate the course
3. After locating the course, under the Offerings column, select the number of offerings
4. On the Courses: Offerings page, locate the offering
5. Locate the Sections column and select the number under the column
6. Check the box of the section, and then click the Edit button
7. In the Courses: Sections: Edit page, select the Dates/Times tab
8. Locate the course asset and set a date and time for the content of the asset, which is

usually in the third tier inside the asset group
a. Example: Exam> Exam 1> Exam1

9. Set the date and time by clicking the From and To boxes to access the time pop-up
10. Save the changes by clicking Save & Close and a pop-up will appear saying Entry

successfully saved
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Display Number of Users Enrolled in a Course

Note: You must be logged into your hub in order to complete the following tasks.

1. Click the Components tab and then select the Courses button located in the drop-
down

2. On the Courses page, select the Options button in the top-right corner of the page
3. Under the Defaults tab, locate the Show Enrollment Numbers option at the bottom of

the pop-up
4. Select between Yes to show enrollment numbers or No to not show enrollment numbers

from the drop-down
5. Click the Save & Close button to save the new setting and exit out of the pop-up

Course Presentations: HUB Presenter

Hub Presenter is a presentation formatting section available to upload large video files inside of
Courses. An administrator with privileges to workspace is the only one who can upload these
presentation files. 

1. Navigate to the HUB and go to hubname.org/resources
2. Create a new Resources and make the category Online Presentations
3. Fill out the information needed for the Resource and then navigate to the backend of the

HUB to make sure that the Resource is Published
4. Then, navigate to the HUB Workspace and ssh into your HUB account
5. Upload the videos & slides of the presentation

1. Note: Slides must be uploaded in order by appearance as individual images
(.jpg) in a zipped folder called Slides, the video must be uploaded as a .webm,

                         132 / 270



HUB MANAGERS
 

.mp4, and a .ogv
1. Example:  media.webm/media.mp4/media.ogv

6. Create a folder called /slides and then navigate to /hubname/app/site/resources/XX-XX-
XXXX/slides and upload all image slides as a .zip file 

1. Note: "XX-XX-XXXX" is the date of when the resource was created
7. Listed below is an example of the presentation layout:

{
    "presentation": {
        "title": "Career Development",
        "type": "Video",
        "media": [
            {
                "source": "media.mp4",
                "type": "mp4"
            },
            {
                "source": "media.webm",
                "type": "webm"
            },
            {
                "source": "media.ogv",
                "type": "ogv"
            }
        ],
        "slides": [
            {
                "title": "Career Development",
                "type": "Image",
                "media": "slides/001.01.jpg",
                "time": "0",
                "slide": "1"
            },
            {
                "title": "Career Development",
                "type": "Image",
                "media": "slides/001.01.jpg",
                "thumb": "slides/001.01.jpg",
                "time": "8.5752419085752418",
                "slide": "1"
            },
            {
                "title": "Your Career Choices after Graduate School and The Most-Neglected Item in
your Career Development",
                "type": "Image",
                "media": "slides/002.01.jpg",
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                "thumb": "slides/002.02.jpg",
                "time": "50.417083750417085",
                "slide": "2"
            },
            {
                "title": "Your Career Choices after Graduate School and The Most-Neglected Item in
your Career Development",
                "type": "Image",
                "media": "slides/002.02.jpg",
                "time": "64.7313980647314",
                "slide": "2"
            },
            {
                "title": "Questions? I Might have replies….",
                "type": "Image",
                "media": "slides/046.01.jpg",
                "thumb": "slides/046.01.jpg",
                "time": "4506.6733400066732",
                "slide": "46"
            }
        ]
    }
}

 

?

Setting a Course in Preview Mode

You can set a course offering to give users a preview from the administrator interface.

1. Navigate to /administrator for your hub and login
2. Click on "Courses" under "Components"
3. Locate the course where you want to enable preview mode, and click on the number of

offerings
4. Then click on "Sections" for that offering
5. Click on the title of the offering
6. Under "Parameters" change "Preview mode" to "Yes, offer a full preview" or "Yes, offer a

preview of the first unit."
7. Click "Save & Close"
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Cron

Cron Jobs

A complete list of available Cron jobs that can be set up that work with other components and
sections of a Hub.

 

Cron- Activity: Cron events for activity feed. Sends email digests at designated intervals to
users containing their recent activity on the Hub.

Cron – Cache Handler: Cron events for Hub cache. Removes old system CSS files and
trashes expired cache data at designated intervals.

Cron – Courses: Cron events for courses. Runs a specific job(s) at a set interval linked to the
Courses component. Syncs passport badge statuses and can email instructors with a digested
update at designated intervals.

Cron – Forum:  Cron events for forums. Runs a specific job(s) at a set interval linked to the
Forum component. Sends group forum email digests at designated intervals.

Cron – Groups: Cron events for groups. Runs a specific job(s) at a set interval linked to the
Hub groups. Can remove group asset folders that were abandoned and send group
announcements at intervals.

Cron – Members: Cron events for members. Runs a specific job(s) at a set interval linked to the
Hub members. Can calculate point royalties.

Cron – Newsletter: Newsletter: Cron events for newsletter. Runs a specific job(s) at a set
interval linked to the Newsletter component related to mailing out newsletters. Can process any
newsletter mailings in the queue and process IP addresses to location data for newsletter email
actions.

Cron – Publications: Cron events for publications. Runs a specific job(s) at a set interval linked
to the Publications component. Set to email monthly publication stats to authors, compute
unique user stats from text logs, issue master DOI and achieve publications (via mkAIP) when
grace period expired – PURR ONLY.

Cron – Resources: Cron events for resources. Runs a specific job(s) at a set interval linked to
the Resources component. Issues master DOI and audit resource data.

Cron – Search: Cron events for Search. Runs a specific job(s) at a set interval linked to the
Search component. Set to process queues at set intervals.
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Cron – Support: Cron events for support. Runs a specific job(s) at a set interval linked to the
Support component that processes the support queue based on predetermined parameters.
Has the ability to close tickets, email reminders for open tickets, email for tickets with specified
parameters and remove temporary upload files and directories at set intervals.

Manually Running a Cron Job

1. Log into the /administrator interface 
2. Hover over the Components tab and from the drop-down select Cron 
3. Search for the cron job and check the box beside the cron job's title
4. Select the Run icon on the top of the Cron main page
5. The Cron job will automatically run the predetermined job

Deleting a Cron Job

1. Log into the /administrator interface 
2. Hover over the Components tab and from the drop-down select Cron 
3. Search for the cron job and check the box beside the cron job's title
4. Select the Delete icon on the top of the Cron main page
5. The Cron job will be deleted
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Events

What is an event?

Do you have an upcoming event that you would like to share with other hub users? The Events
component allows you to submit the details of these events and share them with your
community.

Note: Administrators must first log in to the backend of the hub in order to complete the tasks
below.

Creating an Event

1. On the backend, click the Components tab, and select Events from the drop-down
menu

2. In the Events Manager, select the New icon
3. Fill in the title of the event
4. Select the category of the event

General: an event is the broadest category for events.
Workshop: is an event that is a clinic for users.
Seminar: is an event that hosts a speaker or presentation.
Meeting: is an event similar to conferences.

5. Add a description in the Activity field that includes details about the event and include
whom the event is intended for

6. Fill in the location of the event, the website/URL that pertains to the event or where
event information is stored, and add tags to connect the event to tag topics

7. Set the date and time of the event using the drop down calendar from the boxes. An
event can last multiple dates as an expanded time frame. The time span of the event is
calculated in military time

8. Select the time zone that the event is held in for this helps set up the time frame of the
event for users in different time zones

9. If the event has registration, fill in the information in the registration section
Select Register by date
Enter contact email address. This is the email address to which registration
forms will be sent
 If registration is restricted for the event (Invite Only), enter a password users
must enter to gain access to the registration form into the Restricted field
To choose certain registration fields for your event, select the Hide or Show
icons by clicking on the radio buttons in the Registration Fields area

    10. Click Save to add the event to the Hub calendar. The event will be automatically
published and will appear on the frontend
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Editing an Event

1. On the backend, click the Components tab, and select Events from the drop-down
menu

2. In the Events Manager, locate the event that needs editing, and click the select the
checkbox next to it

3. Once the event has been selected, click on Edit icon to edit the content of an event
4. Fill in the Event details, and then click Save & Close to save the changes

Deleting an Event

1. On the backend, click the Components tab, and select Events from the drop-down
menu

2. In the Events Manager, locate the event that needs editing, and click the select the
checkbox next to it

3. Once the event has been selected, click the Delete icon. The event will be permanently
removed from the Hub

Unpublishing an Event

1. On the backend, click the Components tab, and select Events from the drop-down
menu

2. In the Events Manager, locate the event that needs to be unpublished
3. In the State column, a green check mark icon indicates the event is currently published
4. Click the green check mark icon in the state column of the event you’d like to unpublish
5. The state column will now show a circle with a line through it icon, indicating that it has

been unpublished

Viewing Event Respondents

If registration was set up for an event, a hub administrator can view the registrant information by
logging into the backend.
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1. On the backend, click the Components tab, and select Events from the drop-down
menu

2. In the Events Manager, find the event, and select the check box next to it
3. Once the event has been selected, click on View Respondents button in the upper right

4. Now all of the respondents to the Event can be viewed along with information that they
filled out when they registered for the event

Adding a Page to an Event

1. On the backend, click the Components tab, and select Events from the drop-down
menu

2. On the Events Manager, click the Events tab and select the box of the event you are
editing

3. Once the event has been selected, click on Add a Page (plus icon +)
4. Add the details of the page for the event. Here extra information can be added to the

event, including details of the event and key information for the participants
5. Click Save & Close to save the new page to the event
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Feed Aggregator

What is the feed aggregator?

The Feed Aggregator is a component which allows feed managers to collect articles from
several RSS feeds and to selectively combine them into one site-sponsored RSS feed.

 Users must also be logged into the hub to see any of these controls.

Adding a Feed Manager

In order to access the feed controls, a user must be added as a feed manager.

The feed aggregator controls are only available to those given either the Author, Editor, or
Published role. Users must also be logged into the hub to see any of these controls.

1. Click on Users Menu and select Members
2. Check the box next to the user whom shall be promoted
3. In the drop-down, select the permission level as Author, Editor, or Publisher, for the user
4. Once the group has been selected, click save and close to save the changes
5. The user will now have access to sort posts from the feeds

Adding a Feed URL (RSS)

1. Navigate to the URL https://yourhubname.org/feedaggregator
2. Click the Add Feed button in the upper right hand corner of the page
3. Add the Feed Name, the Feed URL, and enter the description of the feed
4. Click the Submit button to add the feed to the source feed collection

Retrieving and Managing Posts

1. Navigate to the URL https://yourhubname.org/feedaggregator
2. Click the Retrieve New Posts button to pull new posts from the URLs that have been

added to the Feed Aggregator. New posts will be added to the list
3. Once new posts have been added to the list, manage the new posts by selecting

approve, mark for review, or remove
1. Approve - Add the post to the generated feed.
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2. Review - Allow other managers to review the post before adding it to the
generated feed.

3. Remove - Remove the post permanently from the collect posts.
4. Once a selection has been made from the three options the choice that was made the

button will turn gray
5. To change the selection, click one of the other options

Accessing the Feed URL

1. Navigate to https://yourhubname.org/feedaggregator
2. To view the feed URL, click on the Generate RSS Feed button
3. The aggregator link will be generated into a pop-up box with a blue highlighted link
4. Copy the link into any readers that accept RSS feeds as input

Disabling a Feed

 

1. Navigate to https://yourhubname.org/feedaggregator
2. Click the View Feeds button
3. Locate the feed that is to be disabled
4. Click the Disable button.  It will then be disabled, and new posts will no longer be

retrieved from the feed and added to the feed aggregator

Enabling a Feed

1. Navigate to https://yourhubname.org/feedaggregator
2. Click the View Feeds button
3. Locate the feed that is to be enabled
4. Click the Enable button.  Any new posts will be retrieved from the feed and added to the

feed aggregator

Editing a Feed
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1. Navigate to https://yourhubname.org/feedaggregator
2. Click the View Feeds button
3. Locate the feed to be edited, and click the feed’s Edit button
4. Edit the content of the feed, and then click Submit
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Forum

What is a Forum?

A forum, or message board, is an online discussion area where people can hold conversations
in the form of posted messages.

Forums have a specific set of jargon associated with them; e.g. a single conversation is called a
thread or discussion.

A discussion forum is hierarchical or tree-like in structure: a forum can contain a number of
sections, each of which may have several categories. Within a forum's category, each new
discussion started is called a thread, and can be replied to by as many people as so wish.

 

What is a section?

Sections are a way to organize or group related categories (topics). By default, sections are
sequenced alphabetically by title.

 

What is a category?

Forum categories are a simple way to group related threads or discussions together. When a
category is locked, no new threads may be created within that category. Typically, a locked
category will be indicated as such by a padlock icon.

 

What is a thread?

A thread (sometimes called a discussion) is a collection of posts displayed from oldest to latest.
A thread is defined by a title, an additional description that may summarize the intended
discussion, and an opening or original post (common abbreviation OP, which can also mean
original poster), which opens whatever dialogue or makes whatever announcement the poster
wished. A thread can contain any number of posts, including multiple posts from the same
members, even if they are one after the other.

Note: Users must be logged in to the hub in order to participate in the forum.
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Creating a Category

1. Navigate to the Component tab and click on Forum
2. On the Forum component, select the Category tab and then click on the New button on

the top of the page
3. Fill in the title of the new category
4. Fill in the alias or title that will be displayed in the URL
5. Fill in the scope or site and the scope ID or site identification number for the new

category
6. Select the state of publish from the drop-down

a. Unpublished: The category will be removed from the frontend Hub but available
on the backend of the Hub.

b. Published: The category will be available of the frontend and backend of the
Hub.

c. Trashed: The category will be removed from the Hub.
7. Select the access level from the drop-down

a. Public: All visitors or users of the Hub can access the category.
b. Registered: Only registered users of the Hub can access the category.
c. Special: Only registered users with special permissions can access the

category.
d. Protected: Only users with protected rights can access the category.
e. Private: No users besides the creator of the category can access the category.

8. The Category can be locked so that no new posts will be allowed by checking the box in
Details

9. Click Save & Close to save the new section and to return to the Forum dashboard

Creating a Section

1. Navigate to the Component tab and click on Forum
2. On the Forum component, select the Section tab and then click on the New button on

the top of the page
3. Fill in the title, alias (URL ending), scope (site), and scope ID for the new section
4. Select the state of publish (unpublished, published, or trashed) from the drop down and

the access level (public, registered, special, protected, or private)
5. Click Save to remain on the Forum: New Section edit page or click the Save &

Close to save the new section and to return to the Forum dashboard
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Creating a Discussion Thread

1. Navigate to the Component tab and click on Forum
2. In the Forum component, select Threads
3. Click the New icon
4. Fill in the title, alias (URL ending), scope (site), and scope ID for the new section
5. Select the state of publish (unpublished, published, or trashed) from the drop down and

the access level (public, registered, special, protected, or private)
6. Click Save to create the thread

Deleting a Discussion Post

1. Navigate to the Component tab and click on Forum
2. In the Forum component, find and select the Forum thread post to be edited by clicking

the Delete icon
3. The forum post will be automatically deleted and saved. Once a post is deleted, the

material cannot be retrieved

Limiting Thread Viewing Access

(Note: You have to be logged into your hub in order to complete the following tasks)

1. Click the Components tab and then select the Forum button located in the drop-down
2. On the Forum page, click the Threads tab
3. Select the title of the thread and then click the discussion post’s title
4. Under the Publishing Options, selecting from the drop-down can change the 

Access of the discussion thread
a. Public: All users or visitors to the Hub can view the discussion thread
b. Registered: Only logged in users can view the discussion thread
c. Private: Only certain members have access to the discussion thread

5. Save these changes by clicking the Save & Close button
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Tools

Managing Tools

While Tools can only be managed through the tool pipeline,  tool sessions can be managed on
the backend in the /administrator interface.

Managing the Maximum Open Tool Sessions per User

User session limits (and tool preferences) can be found by following these steps:

1. Navigate to /administrator interface
2. Hover over Components and from the drop-down select Tools
3. Click on User Preferences
4. Number of sessions is dictated by the session class

1. Default Class = 3
1. Add another class by clicking "Custom" class, then enter the number for

the user
5. If a user doesn't have an entry, you can create one for them
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Content

Overview

Good content is unique, engaging, and easy-to-use. You may have a bunch of old tech reports
sitting around as PDF files. You could load those onto the hub. Are they good content? It
depends.

As for creating places for your community members to learn about the Hub or the community's
workflow, start with an article page. You can create article pages from the backend of the Hub. 

Let's start with some definitions. An Article is some written information that you want to display
on your site.  It normally contains some text and can contain pictures and other types of content.

It is important to understand that the content of the site (article pages, modules, groups, etc.) is
totally separate from the visual formatting (template) of the site.  It is best to think of text entered
in the Administrator Interface as pure content and there is no need to style each individual
component. 
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Article Manager

Creating an Article

1. First login to the administrative Interface
2. Once logged in, find Content in the main menu bar located toward the top of the page.

You should be presented with a drop-down menu containing items such as Article
Manager, Category Manager, and Media Manager

3. Click on Article Manager
4. Click the + sign to add a new article page. The New Article screen contains options for

categorizing and naming the article, editing content and selecting parameters
5. Enter a title in the Title field. This is used when the article title is displayed
6. Enter an alias in the Alias field. This is the alias that will appear in the URL. For

example, choosing hubzero as the alias will result in https://yourhub.org/hubzero
7. Select a Category using the appropriate drop down menu

If no category applies, choose Uncategorized.
8. Select the status of the article. If you would like to see it on the frontend immediately,

choose Published
9. Select Access level:

Public: All hub visitors can access the article page.
Registered: Users must be registered and logged in to see the page.
Special
Protected
Private

10. In the Article Text field, enter the content of the article
11. Click the Save and Close (star) toolbar button to save your changes and to return to the

Article Manager screen
Alternatively, you may click the Save (check in a circle) toolbar button to save
your article but leave it open for editing.

12.  To find view your article on the frontend, navigate to yourhub.org/alias. If you chose a
category, this alias might be slightly different. See URL documentation under Content for
more information

Editing an Article

1. First login to the administrative Interface
2. Once logged in, find Content in the main menu bar located toward the top of the page.

You should be presented with a drop-down menu containing items such as Article
Manager, Category Manager, and Media Manager

3. Click on the Article Manager link
4. You should now be presented with a list of all the content articles. There are a few

methods to find the specific entry you want to edit. You can filter by state, category,

                         150 / 270



HUB MANAGERS
 

author, etc., or search for the title of the article page. A third option would be to look
through the list manually, if you really want

5. Please find the About Us page as we will use that as an example. Once found, click the
article title to edit it

6. You now should be presented with a page where you can edit the text, title and other
page parameters similar to the image below

7. When your edits are complete, click the Save and Close (star) toolbar button to save
your changes to return to the Article Manager screen

8. Alternatively, you may click the Save (check in a circle) toolbar button to save your
article but leave it open for editing

Deleting an Article

Moving to the Trash:

1. First login to the administrative Interface
2. Once logged in, find Content in the main menu bar located toward the top of the page.

You should be presented with a drop-down menu containing items such as Article
Manager, Category Manager, and Media Manager

3. Click on the Article Manager link
4. Check the box next to the article you want to trash
5. Then click Trash (trashcan) toolbar button. This will move the article to a trash bin so

that it can be retrieved later if needed. It does not permanently delete the article

 

To retrieve the trashed article, select the status filter of the article list to trashed. This will show
all the articles with a status of trashed. Click on the article’s title and choose the status that you
require – typically published.

 

Permanently Deleting:

1. If you want to make sure the Article is completely gone from the system (so no further
roll back is available), select the status filter of the article list to trashed.  This will show
all the articles with a status of trashed

2. Check the box next to the article you want to delete
3. Click the Empty Trash (trashcan) toolbar button to remove the article

permanently. Recovery is not possible after this action
Note: Articles in the Trash Manager are not the same as Archived Articles.

4. Check the box next to the article you want to unarchive
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Article Pages: Can articles be assigned to multiple categories or sections?

No, articles and other content items cannot be assigned to multiple categories or sections.
Possible work-arounds include:

Creating duplicate articles in multiple categories.
Using menus rather than dynamic lists of content items.
Using various third party extensions that simulate assignment to multiple categories.
Using key words to simulate categories and sections.
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URLs

Understanding URLs for Sections, Categories, and Articles

When SEF URLs are being used, it can become tricky at times to discover which article a URL
path leads to. HUBs try to simplify some of this and make the association(s) of the path to
sections, categories, and articles a little more obvious.

For the purposes of this explanation, we assume every section, category, and article has an
alias. In its simplest form, a URL will map to a path of
http://yourhub.org/{SectionAlias}/{CategoryAlias}/{ArticleAlias}. So, a URL of
http://yourhub.org/about/this/site would map to a section with an alias of about, a category with
an alias of this, and an article with an alias of site.

The resulting URL will start to collapse, or shorten, when sections, categories, and articles have
the same alias. For instance, if you have a section with alias about, a category with an alias of 
this, and an article with an alias of this– notice it is the same as the category–the resulting URL
will be http://yourhub.org/about/this.

If all three portions have the same alias, the http://yourhub.org/about/this/site shortens further. A
section alias of about, category alias of about and article alias of about will simply produce
http://yourhub.org/about.

Quick ReferenceSection Category Article URL
about this site http://yourhub.org/about

/this/site
about this this http://yourhub.org/about

/this
this this site http://yourhub.org/this/s

ite
about this about http://yourhub.org/about

/this/about
about about about http://yourhub.org/about

URL Redirects

If you find yourself wanting to redirect a certain URL to another page, then Joomla! has a
solution for you. And fortunately, the solution is as simple as creating a menu.

 

1. Navigate to Menus -> Menu Manager on the Joomla! backend
2. At this point, you can either create a new Menu or use an existing one. If you prefer the

former, click New in the upper right-hand corner, and give your new Menu a name such

                         153 / 270



HUB MANAGERS
 

as Redirects. Alternatively, you could use the Default menu. The only thing to
remember is that you should use a menu that is not displayed on the site (e.g. the Main
Menu and About menus or displayed on the standard hub)

3. Irrelevant of which option you chose, select the icon in the Menu Item(s) row to add a
new Menu Item to your Menu to handle the redirect

4. Next, fill in the necessary fields
Add a Title
The Alias will be the address that a user would enter into the address bar of
their browser
The Link will be the page where the actual content exists

Example: According to the image below, if a user types
http://myhub.org/example, though that page does not exist, they will get
the content found at http://myhub.org/example/examplearticle1

5. Select Save
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Menus

Overview

A Hub menu is a website navigation menu where users go to navigate around the Hub. The
Main Menu is the first navigation path that users interact with from your landing page and
usually lives in your template header. Additional menus can be added to content pages on the
Hub in order to link like pages together for easier navigation. The general rule of thumb is that if
a content page is not linked to a menu, the likelihood of the page being discovered by users is
diminished. 

Organizing Your Articles Using Menus

If you have a set of articles that you would like to group together, you can use menus to
organize those articles in an easy-to-navigate fashion.

An example of this can be found on the default hub under the About section (see also below).

1. To begin, find the URLs of the articles that you're interested in grouping together
1. Note: If you can't find, or don't know the URL, it comes from the article alias, the

section, and the category (see below and view these documentation pages: 
Categories, URLs).

2. With your article pages created, you'll need to make the menu structure
3. Navigate to Menus -> Menu Manager on the Joomla! backend and select New
4. Give your new menu a unique name and title, then click Save 
5. Now you will see your new menu in the list
6. Click the icon indicated below to start adding menu items to your new menu

Note: It is important to realize, for clarity's sake, that there is a
difference between Menu and Menu Item.

1. Menu Item: represents an instance, or individual menu link
2. Menu: represents the entity as a whole

7. Now click the New button to add new menu items to your menu
8. After clicking New, scroll down and select Link
9. Next, fill in the necessary information:

This is where you'll need to remember the URLs for the articles that you've
created (you'll add the URL to the Link field)
After creating this menu item, you'll be able to access this article page via the
URL for the article, or the Alias of the menu item

For example: according the screenshot below, both
http://yourhub.org/example/examplearticle1 & http://yourhub.org/article1
will work when trying to access this page via the browser (See URL
Redirects for more details). For the navigational menus to display
properly, though, you'll want to use the menu item alias when trying to
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access your article page.
10. Click Save in the upper right-hand corner
11. If you switch over to the front-end and navigate to your article page (via the menu item

URL), you should see a page similar to this one:
12. At this point, simply repeat the previous steps to create menu items for all of the articles

that you want to use together
13. The final step in this process is to assign the menu items that you've created to display

on the article pages
14. To do this, navigate to Extensions -> Module Manager on the backend Joomla!

interface
15. Next, select New
16. Scroll down and select Menu from the list (either click on the link, or select the radio

button then scroll back up and click Next)

Now fill in the correct information...make sure to:??

Give it a Title
Be sure Enabled is set to Yes
Give it the position Left
Set it to display on the correct pages

Under menu assignment, control click the menus items that we made in the
preceding steps. This is what tells Joomla! which pages to display our new menu
on.

Under Module Parameters, Menu Name should be the title of the menu that we
created earlier (example in this case)
Menu Style should be List?

17. When all of this has been done, click Save

Redirecting a URL to Another Existing Hub Component

Redirecting a URL to Another Existing Hub Component Previously created groups and other
components can have URL redirects added to other components instead of transferring all the
files and data that live in the previous area to a new section. For example, a professor can
redirect a group called Mainclass to another group called Springclass. In order to set up a
redirect, follow these steps:

1. Navigate to /administrator, locate the tab Menus and select Menu Manager from the
drop-down

2. Locate the Default menu group
3. Click on the Default group to enter its menu interface
4. Try and locate the Parent group 
5. In this case we want groups, however, this is not listed, so let’s create it by clicking
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the New in the top right corner
6. Create the “groups” part of the URL /groups/mainclass
7. Click the Select button next to the field Menu Item Type Select External URL
8. To create the groups part of the URL, fill in the form as follows:

1. Menu Item Type: External URL Menu Title: Groups Link: groups 
9. Click Save & Close from the top right corner

10. To create the redirect portion, follow step 5 again except fill out the Menu Title as
mainclass and the link as spring2016class

11. This will redirect users from /groups/mainclass to /groups/springdefaultclass 
12. Nest mainclass under groups to create the end result from the redirect
13. This is done in the Menu Item Details under Parent
14. Set the Parent to Groups
15. Click Save & Close

 

 

Creating a New Menu

1. Navigate to /administrator 
2. Hover over Menus -> Menu Manager and click on Add New Menu
3. Fill out the new menu information 
4. Click Save & Close
5. From Menu Manager: Menus, locate your new menu and click on Add a module for

this menu type under Modules linked to the menu
6. Create the new module for your menu by filling in the module configuration information

1. Note: Most menu modules are left aligned
7. Click Save & Close
8. Create new menu items, either linked to articles you have created or linked to various

components, by navigating to Menus and clicking on your new menu
9. Click on the Menu Items tab and click the New button to create menu items

1. Note: Once you have linked menu items to your new menu, navigate back to
"Extensions" -> Module Manager -> Click on your new menu module ->
Confirm the Menu Assignment for your module is affiliated with the new menu
items you created
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Users

Overview

By default casual visitors are allowed to register themselves on your website to gain access to
additional resources. For example, registered users might be allowed to submit resources or
simulation tools. Your website implements a user registration policy which can be adapted to
suit your particular requirements so you decide what additional resources are made available.
You can disable user registration altogether if you prefer.

Users register themselves on your website using the Register link typically found in the upper
right-hand portion of every page (position may vary). Once registered, users will log in to your
website by entering their username and password using the login form found at
http://yourhub.org/login. There are also links on the form to manage users who forget their
usernames or passwords.

See Configuring Registration to learn more about changing registration settings.
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Members

Members Breakdown

A breakdown of all the tabs on the /administrator interface inside of User: Members. 

Members: Manage all member accounts 
Notes: Manage user notes and note categories
Access: Manage access levels
Points: Manage user points
Passwords: Set and manage password rules
Quotas: Manage user quotas for tool usage
Registration: Manage registration process
Import: Import a CSV file of new users
Export: Download CSV of all users
Plugins: Manage all member related plugins

New features added to the sub toolbar on the /administrator interface inside of User: Members. 

De-identification of Members

Members: Editing an Account

Note: Editing of users is done through the HUBzero Members Manager component, not the
User manager. Any changes made via the Members Manager will also be reflected in the User
tables. Making changes with the User Manager can lead to data becoming out of sync.

1. First login to /administrator
2. Once logged in, hover over Users and select Members from the drop-down

3. You should now be presented with a list of all the members on your site

1. There are a variety of methods to find the specific person you wish to edit:
Searching or Manually scrolling through the list to find the use

4. Once found, click the person's name to open up their profile

1. Account: General details about the users account and assigned access groups

2. Profile: Profile details

3. Password: Where an administrator can manually reset a user's password and
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check on how many days are left before current password expires

1. Warning: If you have an automatic password filler turned on in your
browser, check this section if you are editing a user's account before
saving for you might reset their password with one of your saved
passwords

4. Groups: List of groups that the user is involved in either as a member or
manager

5. Hosts: List of hosts that the user has access

6. Messaging: The user's messaging settings 

5. Once you feel ready to save your changes, scroll back to the top of the page and
click Save (the icon that looks like a floppy disk) in the upper right portion of the page

Members: Manually Confirming a User

Users by default have the option to confirm their accounts unless an administrator changes this
to administrator approval only. An administrator will need to follow these steps to confirm any
new users:

1. Navigate to /administrator and hover over the Users tab 
2. Click Members from the drop-down
3. Search for the user you wish to confirm
4. Check the box beside their account and click the Confirm button
5. The user's account will be confirmed

Members: Clearing Existing Terms of Use Agreements

When terms of use are changed on the hub, it may be necessary to require users to re-accept
the new terms. To reset all existing agreements, and force re-acceptance, follow these steps:

1. Go to /administrator interface
2. Navigate to the Users tab and select Members from the drop-down 
3. Click the Reset terms of use agreements for all users button
4. Navigate to the frontend of the Hub and login to double check that the Terms &

Conditions acceptance pop-up appears 
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Members: Blocking a User's Account

Sometimes spammers can attack your Hub and create multiple accounts. In order to prevent the
spammers from access these accounts again, you can block their accounts. This also is a way
to
"unpublish" accounts of users who don't wish to have accounts on the Hub anymore versus
deleting their account. This way, if they ever need access again, you only have to unblock them.
Follow these steps to block a user's account: 

1. Navigate to /administrator and hover over the Users tab 
2. Click Members from the drop-down
3. Search for the user you wish to confirm
4. Check the box beside their account and click the Block button
5. The user's account will be blocked

User Manager: Customize Profile

Allows an administrator to define profile/registration fields. To edit the profile schema, navigate
to the Members Manager (Users ? Members). Then click the button in the toolbar labeled 
Profile. In this screen, you have the ability to define user profile fields, if said fields are required
or optional, what values are allowable, and what fields are dependent upon a value from
another field being chosen.

Field Type Breakdown:
 
Text

A single-line textbox.
Paragraph

A multi-line textbox (a.k.a. textarea).
Checkboxes

A list of options where the user may select one or more.
Multiple Choice

A list of options where the user can only choose one of the available options.
Date/Time

A textbox specifically for entering timestamps.
Dropdown

A dropdown (select box) of options where the user can only choose one of the available
options.

Country
A dropdown (select box) of countries. The list of countries is automatically populated.
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Website
A textbox specifically for entering URLs.

Hidden
A hidden input.

ORCID
A textbox for entering entering ORCIDs.
 

Toolbar Breakdown:

Save. Saves the user and stays in the current screen.
Save & Close. Saves the user and closes the current screen.
Save & New. Saves the user and keeps the editing screen open and ready to create
another user.
Cancel/Close. Closes the current screen and returns to the previous screen without
saving any modifications you may have made.
Help. Opens this help screen
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How to Build with the Profile Manager:

1. Navigate to /administrator and hover over the Users tab and click on Members from
the drop-down

2. Click the Profile button
3. Manage the current Profile breakdown with the following actions:

1. Add a new field:
1. Select the field type then fill in the label information while under the Edit

field section
2. Determine the Access level and the information will automatically save

2. Duplicate a field:
1. Hover over the field you want to duplicate and then click the Duplicate

field button
3. Remove a field:

1. Hover over the field you want to remove and then click the Remove field
button

4. Move fields:
1. Select the field you want to move and drag it up or down depending on

your preference
4. Click Save & Close to save your changes

Notes

Notes are a function where users can create and store notes on the Hub. On the /administrator
interface, an administrator can manage the notes created by users.

User Notes: Where an administrator can view notes make by other users and edit,
approve, publish, unpublish, along with other actions to curate the notes
Note Categories: Where an administrator can create new note categories and batch
process selected categories

 

Access

An area where access groups can be managed. Access groups are the various permission
levels assigned to different groups of users based on their roles in the Hub. Generic default
levels are: Public, Manager, Administrator, Registered, Author, Editor, and Publisher. These
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levels are broken up by the levels of responsibility and what the access the group has to
different areas of the Hub. An administrator can see the number of users in the group in the 
Users in Group column.

 

An administrator can add new access groups by clicking the New button and following these
steps:

1. Navigate to /administrator and hover over the Users tab and click on Members from
the drop-down

2. Inside of Members, select the Access tab and click the New button
3. Add a Group Title and then select the Group Parent 
4. Click Save & Close

 

An administrator can also can manage the viewing levels available on the Hub by following
these steps:

1. Navigate to /administrator and hover over the Users tab and click on Members from
the drop-down

2. Inside of Members, select the Viewing Level tab and click the New button
3. Add a Level Title and select the Access Groups that have this viewing access
4. Click Save & Close

 

 

Points

Points are the Hub’s currency system. Hub administrators can provide royalties to active and
helpful users who interact with a Hub’s community. 

Summary: Check out top users and statistics of how points are earned
Look up User Balance: Look up a users Point total by searching with their user I.D.
Configuration: Configure the amount of points you want to reward users when
completing specific tasks which are assigned in the Alias. NOTE: There are only seven
point alias' you can use, see Point Configuration listed below.

Description: Add a short description describing why these points were being
rewarded
Alias: The alias of the rule affliated to the awarded points
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Points: Define the amount of points
Batch Transaction: Deposit or Withdraw points from user accounts through batch
transactions

Configure Points

1. To set up Points on your Hub, follow these steps: 
2. Log into the /administrator interface
3. Hover over the Users tab and select Members
4. Select the Points tab and then the Configuration tab
5. Fill out the form to add points in seven specific areas of the Hub:

1. Question posted: Award points when a user posts a question
1. Points: Determine the amount of points you want to award a user when

they complete this task
2. Alias: ask
3. Description: Question posted

2. Answer posted: Award points when a user posts an answer
1. Points: Determine the amount of points you want to award a user when

they complete this task
2. Alias: answer
3. Description: Answer posted

3. Question rating posted: Award points when a user posts a rating to a question
1. Points: Determine the amount of points you want to award a user when

they complete this task
2. Alias: questionvote
3. Description: Question rating posted

4. Answer rating posted: Award points when a user posts a rating to an answer
1. Points: Determine the amount of points you want to award a user when

they complete this task
2. Alias: answervote
3. Description: Answer rating posted

5. Answer accepted as best: Award points when a user who asked a question in
Answers accepts another user’s best answer (the user who submitted the
answer earns the points)

1. Points: Determine the amount of points you want to award a user when
they complete this task

2. Alias: accepted
3. Description: Answer accepted as best

6. Abuse report granted: Award points when a user reports abuse and an
administrator grants the abuse report

1. Points: Determine the amount of points you want to award a user when
they complete this task

2. Alias: abusereport
3. Description: Abuse report granted

7. Review rating posted: Award points when a user rates a post
1. Points: Determine the amount of points you want to award a user when
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they complete this task
2. Alias: reviewvote
3. Description: Review rating posted

6. After filling out the form, click Save & Close to save the new point configuration

Passwords

Password Rules and Password Blacklist are two sections that are already set up at default. The
Password Rules comply with our latest security scan and are suggested to be turned enabled at
all times so that all users meet the same rules when creating their accounts. As an
administrator, you can blacklist passwords if you do not want users creating simple or Hub
related passwords.

 

Blacklisting a Password:

1. Navigate to /administrator and hover over the Users tab and click on Members from
the drop-down

2. Inside of Members, select the Passwords tab, then select Password Blacklist 
3. Click the New button
4. Add the password in the Word text box 
5.
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Quotas

Managing user quotas is simplified on the backend into three main areas. As an administrator,
you can increase or decrease a user's quota, create quota classes, and import quotas, by
following these steps:

 

Increasing/Decreasing a User's Quota:

1. Navigate to /administrator and hover over the Users tab and click on Members from
the drop-down

2. Inside of Members, select the Quotas tab and select the Member disk quotas tab
3. Search for the user and then click on their name
4. Increase or decrease the user's quota by changing their quota class or by changing their

limits
5. Click Save & Close

 

Creating a Quota Class:

1. Navigate to /administrator and hover over the Users tab and click on Members from
the drop-down

2. Inside of Members, select the Quotas tab and select the Quota classes tab
3. Click the New button
4. Fill in the Class Options form

1. Alias: Class alias
2. Soft blocks limit: Soft limit for quota blocks
3. Hard blocks limit: Hard limit for quota blocks
4. Soft files limit: Soft limit for quota files
5. Hard files limit: Hard limit for quota files
6. User Access Groups: Select what access groups are automatically associated

with this quota class
5. Click Save & Close 

 

Importing Quotas:

1. Navigate to /administrator and hover over the Users tab and click on Members from
the drop-down

2. Inside of Members, select the Quotas tab and select the Import Quotas tab
3. Import existing filesystem quotas by copy and pasting a quota.conf file in the text box
4. Check the box next to Overwrite matching existing entries
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5. Click Import

Registration

An administrator can configure a user's registration fields from the /administrator interface on
the Hub. Read more about this on Member Registration article. 

Import

An administrator can manually import users if they are wanting to complete this process for a
large research group needing access to the Hub immediately or for a classroom of students
where the instructor already knows the students' information. To import users and set up import
hooks, follow these steps on the Member Import Article.

 

Export

Exporting the current list of Hub users can be done by visiting the Export tab inside of 
Members. From that tab there will be a button that states Download CSV of all users. By
clicking this button, you can download a list of all members and archive the file for your own use
as an administrator or for safe keeping. 

Plugins

Plugins are used to turn on various parts of the Members interface which includes their profile
and dashboard. An administrator can manage these plugins by unpublishing and publishing
various plugins to limit or expand a users Member area on the frontend of the Hub. Specifically
in the Member Dashboard Configuration plugin, an administrator can manually change
rearrange the member dashboard modules to fit the message of the Hub. 

 

Publishing/Unpublishing Plugins:
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1. Navigate to /administrator and hover over the Users tab and click on Members from
the drop-down

2. Inside of Members, select the Plugins 
3. Check the box next to the plugin and click the Publish or Unpublish button
4. The plugin will change stats under the Published column

 

Managing Member Dashboard Configuration:

1. Navigate to /administrator and hover over the Users tab and click on Members from
the drop-down

2. Inside of Members, select the Plugins tab
3. Locate the Members-Dashboard plugin and click Manage under the Manage column
4. Manage the modules inside of the Members-Dashboard plugin

1. Drag and drop to move modules
2. Drag the lower-right corner to expand or contract the size of the module
3. Add more modules by clicking the Add Modules button and selecting a module
4. Push Modules to Users by clicking this button and filling out the form, then

clicking Push Module
5. All changes will be automatically saved for every new user

1. Users who have already adjusted their Dashboards will not be affected by these
changes

 

Toolbar Features

De-identification of Members

Release: 2.2.26

Purpose: Mechanism to remove Personally Identifiable Information (PII) from the CMS
databases. Some database rows are simply deleted, and in other cases fields are deleted or
replaced with anonymized values that are unrelated to the original PII (e.g., username), in which
case no record or mapping is kept of the original value.  Accounts will not be entirely deleted,
but some data will be kept for statistics.  

1. Navigate to the top toolbar in  /administrator and hover over the Users tab and click
on Members from the drop-down

2. Make sure under the Options modal window, under the Permissions tab, the "De-
identify" option is set to 'allowed'. Save and Close the Options window. 

3. Inside of Members, on the Members table, in the 1st column, select different members
to de-identify

4. Navigate to the sub toolbar on the top right and click the 'eye-closed' icon button (next to
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the trash icon button), which will de-identify those specific members 
5. Changes in the database will be reflected in the displayed Members information
6. The previously selected members will have had their information deleted from the

following tables:
User Profiles
Support Tickets
Session and Session Geo
Profile Completion Awards
All related to Newsletter Mailing
Messages
All related to Media Tracking
All related to Jobs
Feedback
Event Registration
Blog Entries and Comments
All related to Cart
All related to Authentication
All related to Groups and Profiles
Users Quotas Log
All related to Attachments
Users Password and Password History
Points Subscription

7. Also, the previously selected members will have had their home directory deleted from
our servers

8. Lastly, the previously selected members have had account information updated with
generic info. 

9. A "success" alert message should be displayed for the previously selected members. 
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Registration

Disabling Registration

In some circumstances, it may be desirable to disable user registration entirely. To do so,
navigate to the members manager (Administrator > Users > Members) and click the "Options"
button in the toolbar. The first available configuration option if "Allow User Registration". Set this
to "No" to disable registration entirely.

Registration Fields

1. First log in to the administrative backend
2. Once logged in, find Users in the main menu bar located toward the top of the page. 
3. Choose Members from the drop down menu
4. Click on the Registration tab
5. You should now be presented with a table of available user fields and their status for a

particular action. This controls what fields the user will see, must fill in (required) or can
fill in (optional) depending upon which action or state they are currently in. That is, you
can make the username field required for the registration page (create column) but may
not wish for your users to be able to edit this after creation (read only for the 
update and edit columns).

Create column: What the user sees on the registration page
Proxy column: What columns an administrator sees or must fill in when creating
an account by proxy (i.e., for someone else)
Update column: What fields the user will see and/or must fill in if something has
changed with what information is required at registration. An example of this
would be if the citizenship field was, at one point, optional for registration but is
now required. Setting this field to Required for the Update column will now
require logged-in users to fill this information out.
Edit column: What fields the user will see and can edit for their user profile
Field Option Definitions:

??Required = Must fill in
Optional = Can fill in, but are not required 
Hide = Not visible 
Read only = Can view but cannot change

6. Once you feel ready to save your changes, scroll back to the top of the page and click 
Save in the upper right portion of the page. Changes take affect immediately.

Customizing Confirmation Email

All component layouts can be customized through overrides. Except for files that are provided in
the Joomla! distribution itself, this method for customization eliminate the need for designers

                         171 / 270



HUB MANAGERS
 

and developers to hack core files that could change when the site is updated to a new version.
Because they are contained within the template, they can be deployed to the Web site without
having to worry about changes being accidentally

User Authentication Plugins

A Hub can offer multiple ways for users to login through other services like LinkedIn, Facebook,
ORCID, etc.

Authentication-Certificate: Handles user authentication against client side SSL
certificates
Authentication-Facebook: Handles user authentication against Facebook
Authentication-Google: Handles user authentication against Google
Authentication-Hubzero: Default user authentication
Authentication-LinkedIn: Handles user authentication against LinkedIn
Authentication-ORCID: Handles user authentication against ORCID
Authentication-Picas: Handles user authentication against Purdue's CAS
Authentication-Twitter: Handles user authentication against Twitter

 

To activate these authentication plugins acquire a customer secret and customer key from the
other service by registering your App on the service and selecting the Web format. Once you
have the keys you can enable the plugins from the backend of the Hub. 

1. Navigate to the backend of the Hub and locate the Extensions Tab and click on Plug-in
Manager

2. Inside of the Plug-in Manager, search for the authentication plugin
3. Click on the title of the plugin and inside the plugin insert the customer secret and 

customer key
4. Change the Status of the plugin to Enabled and then click Save & Close

TLS Certificate Authentication

Certificate Authentication Plugin:

This plugin is in charge of actually checking the certificate, and creating new accounts or linkingexisting ones to the identity presented in the certificate. With this plugin on, users can loginusing their certificate credentials. If a link between those credentials exists, the process iscomplete and the user is logged in. If a link does not exist, the user is allowed to create a newaccount, thus linking their current certificate to the newly created hub account. A user can alsoelect to link their current certificate to an existing account, assuming they are able to provide thepassword for that existing account (in the event that someone already has an account on thesystem). This plugin is called: Authentication - Certificate.

Enable the Authentication - Certificate Plugin:
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1. Navigate to the backend of the Hub and locate the Extensions tab

2. Click on the Extensions tab and from the drop-down click on the Plug-in Manager
3. Locate from the plugin list or through search the Authentication - Certificate plugin
4. Click on the title of the plugin then locate the Status section inside the plugin
5. From the Status drop-down, select Enabled then click Save & Close

 

Certificate routing plugin:

This plugin handles the requirement for a certificate to be present while browsing the site.  While
the authentication plugin is what checks and links the user to the cert, other authentication could
still be allowed. With this plugin enabled, a certificate must be present and authentication
options are limited to just certificate based authentication. This plugin is called: System -
Certificate.

Enable the System - Certificate plugin by following the same steps listed out above.

 

New account approval:

This allows admins to require approval of new accounts prior to their being able to access the
site. When this is enabled, accounts pending approval can be found in the users manager on
the backend. You can also elect to turn on an administrative dashboard module that lists
accounts pending approval. And in the users manager parameters, you can enable
administrator notifications to receive an email when new accounts are created. This allows the
certificate->user link to be user initiated (rather than admin initiated), but still gated and admin
approved.

In terms of apache configuration, SSLVerifyClient optional should be set. This will allow the
certificate to be included, but also allow the CMS to handle the requirement for the certificate
through the use of the certificate routing plugin mentioned above. 
SSLOptions +StdEnvVars should also be set, as I’m sure it already is for you all. Lastly, make
sure the site is forced to SSL via the Joomla global configuration on the backend.

 

Note: In order for this feature to be useful, all users need to gain a TLS Certificate and have it
implemented in their browser prior to utilizing this authentication process.
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Member Import

Overview

The members bulk importer/ updater is designed to allow a site administrator to bulk import or
update member data. Due to its ability to mass upload/ modify accounts, it is an administrator
only feature.

 

Warning!

The improper use of this feature can have damaging consequences. Use with caution.

The importer should only be used in special circumstances. Minimum requirements for the CSV
(first name, last name, username, password, etc.) and any additional registration fields (member
demographics) must be gathered by an administrator for every account to be affected. In most
cases, it is more time effective and less error prone for a new members to enter this information
in the registration form instead of passing the information through the administrator.

Please note, if you are using Member Import on a HIPAA hub, please complete the extra
steps on delivering passwords to members.

 

Registration Fields

The member importer follows the parameters set in the registration component.  If a registration
field is required during the initial registration form (organization, for example), the field must be
included in the uploaded CSV file in addition to the required fields for the CSV.  Not all
registration fields are available via the member importer, those should be collected from the new
member on the next login, if desired.
 

CSV Preparation

1. Log into hub's administrator portal, e.g. https://hubname.org/administrator
2. Navigate from the main menu to Users -> Members
3. From the page menu under the title Members, click on the Import tab
4. Click on the button that looks like a grid, located on the top right of the page, to
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download the example CSV
5. Save the file with a different name that represents the group of members to be imported

1. Note: Do not save it in Excel format, the import only accepts CSV files.
6. Edit the CSV

1. Fill required fields and any supplementary fields

      
CSV Field Descriptions

id: User's ID (leave blank when creating new accounts)
name: User's full name e.g. First Last
middleName: User's middle name
surname: User's surname
username: User's hub username
email: User's email (only use valid email addresses as emails will be sent to the user)
password: User's temporary password
block: User's blocked status (1 for blocked, 0 for not blocked)
approved: User's account approval status (1 for approved, 0 for not approved)
sendEmail: User's preference for receiving email from the hub (1 to accept, 0 to decline)
activation: User's email confirmation status (1 for confirmed, 0 for unconfirmed)
usageAgreement: User's acceptance of hub's terms of service (1 for accepted, 0 for
declined)
homeDirectory: User's hub home directory e.g. /home/hub/user
organization: User's organization (depends on hub's registration configuration)
orgtype: User's organization type (depends on hub's registration configuration)
phone: User's phone number (depends on hub's registration configuration)
groups: A comma separated list of the aliases for the groups that the user is a member
of
projects: A comma separated list of the aliases for the projects that the user is a member
of

Creating a new import and uploading a completed CSV

1. Login to the hub's administrator portal
2. Click the Members tab and from the drop-down
3. Click on the Import tab
4. Click on the button with the plus icon located on the top right of the page
5. In the new page that opens, enter a name for the import and a short description
6. Click the file selection button in the Upload fields to upload a CSV file

1.  Select the desired CSV
7. Save the import using one of the save buttons in the top right
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Testing an import

It is always a good idea to do a test run before actually importing or updating members'
accounts.

1. Select the import you wish to test run by checking the box for the import row
2. Click on the Test Run button
3. After the test has completed, you will see the results displayed below the progress bar 
4. Click on each item will display details for each record

 

Running an import (after a test run)

1. Click on the Run for Real button (under the countdown)
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Groups

Overview: Managing Groups

Groups are a unique feature that allows communities to grow inside of the Hub. Groups are
more commonly used to share information between specific individuals. The /administrator
interface allows you to set up permissions for groups and manage active groups all from the
backend of the Hub. 

Creating a Group

1. Navigate to /administrator interface
2. Hover over Users and select Groups from the drop-down
3. Click the New button
4. Fill out the form then click Save & Close

1. Details: General information about the Group
1. Membership: Settings that determine how users can join the new Group
2. Page Settings: General settings that determine Group page setup
3. Email Settings: General email settings that related to emails sent from

the Group
2. Files: A new group must be saved first before you can upload files from the

backend of the Hub and store the files into the Group

Editing a Group

1. Navigate to /administrator interface
2. Hover over Users and select Groups from the drop-down
3. Click the Title of the Group
4. Change the Group's information then click Save & Close

Deleting a Group

1. Navigate to /administrator interface
2. Hover over Users and select Groups from the drop-down
3. Check the box next to the Group's Title 
4. Click the Delete button
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Publishing a Group

1. Navigate to /administrator interface
2. Hover over Users and select Groups from the drop-down
3. Check the box next to the Group's Title
4. Click on the Publish button

Unpublishing a Group

1. Navigate to /administrator interface
2. Hover over Users and select Groups from the drop-down
3. Check the box next to the Group's Title
4. Click on the Unpublish button

Configuring Groups

1. Navigate to /administrator interface
2. Hover over Users and select Groups from the drop-down
3. Click on the Options button
4. Make changes to the following sections:

1. General: Determine if Groups can be auto-approved or manually approved by
an administrator

2. Info Page: Determine what Groups can show on the Information Page for
Groups

3. Membership & Access: Determine the default discoverability and join policy for
new Groups

4. Email: Enable emailing from the Group from discussion comments and forum
digest 

1. Note: If you determine Groups can email out Forum digest you will need
to set up the Cron plugin that sends out these emails

5. Upload: Determine file upload path
6. Pages: Determine if pages need to be approved and who can approve Group

pages, determine other specifics related to Groups
7. Super Groups: Determine if Super Groups can have components, the Super

Group Group Owner and Repo Management options
8. Permissions: Change the viewing and interactive permissions for Groups

5. Click Save & Close to save the changes made
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Access Groups

Access

An area where access groups can be managed. Access groups are the various permission
levels assigned to different groups of users based on their roles in the Hub. Generic default
levels are: Public, Manager, Administrator, Registered, Author, Editor, and Publisher. These
levels are broken up by the levels of responsibility and what the access the group has to
different areas of the Hub. An administrator can see the number of users in the group in the 
Users in Group column.

 

An administrator can add new access groups by clicking the New button and following these
steps:

1. Navigate to /administrator and hover over the Users tab and click on Access Groups
from the drop-down

2. Click the New button
3. Add a Group Title and then select the Group Parent
4. Click Save & Close
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Access Levels

Access

An area where access groups can be managed. Access groups are the various permission
levels assigned to different groups of users based on their roles in the Hub. Generic default
levels are: Public, Manager, Administrator, Registered, Author, Editor, and Publisher. These
levels are broken up by the levels of responsibility and what the access the group has to
different areas of the Hub. An administrator can see the number of users in the group in the 
Users in Group column.

 

An administrator can also can manage the viewing levels available on the Hub by following
these steps:

1. Navigate to /administrator and hover over the Users tab and click on Access
Levelsfrom the drop-down

2. Click the New button
3. Add a Level Title and select the Access Groups that have this viewing access
4. Click Save & Close
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User Notes

Notes

Notes are a function where users can create and store notes on the Hub. On the /administrator
interface, an administrator can manage the notes created by users. This section allows
administrators to manage and view notes make by other users and edit, approve, publish,
unpublish, along with other actions to curate the notes. 
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User Note Categories

Categories

Notes are a function where users can create and store notes on the Hub. On the /administrator
interface, an administrator can manage the notes created by users. This section allows an
administrator to create new note categories and batch process selected categories.
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Super Groups

Overview

Super Groups are advanced Hub Groups, that have their own webspace within the Hub to
showcase their Group. Super Groups have a lot of extra functionality built in to allow them to
customize their group. 

Super Groups have the ability to include PHP and javascript code into Group pages and
modules. Pages or modules that contain PHP or Javascript code will then need to be approved
by a Group page approver. Notifications are sent to approvers when a page needs to be
approved. Another notification will be sent to the Group managers when the page has been
approved.

Super Group templates must follow HUBzero's Super Group Template rules.

Creating a Super Group

 

1. Log in to the backend of the Hub and hover over the Users tab and select Groups
2. Click New to create a group
3. Select the group type from the drop-down to be Super
4. Fill in the CN or group alias, the title and logo of the group, along with the public and

private group descriptions
5. In Membership Control, check the box if the membership is to be controlled. The

membership Join Policy determines access level for the group
a. Public: Any user on the Hub can join the group.
b. Restricted: Qualifications are given that predetermines who can join. These

restrictions have to be added into the credentials. 
c. Invite Only: A group manager has to send an invite any new group members to

the group.
d. Closed: No one can join the group unless they are added from the back-end of

the Hub.
6. Determine the access level of the group from hidden or visible. A hidden group is not

listed on the front-end of the Hub, and any content is unavailable to any user that is not
a member of the group. A visible group can be found on the Hub through regular
searches

7. Once all the group’s content has been filled in, then save the new group by
clicking Save & Close. The group will be automatically approved and visible on the Hub

8. The following will be automatically created when making the super group:
a. Base template with custom error handling & login
b. Separate database for super group related components, data, etc
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c. If Gitlab integration is enabled, all needed connections will be made and super
group folder will be controlled via Git.

 

Frontend Module Management in Super Groups

 

Accessing the Module Manager:

1. Log in to the Hub and access the Super Group home page
2. Click on the Manage Group Pages link in the group manager toolbar, to get to the page

manager
3. Select the Manage Modules tab to view the module manager
4. Search for modules by using the search drop-down that searches for a module based on

location and title

 

Adding a Module:

1. Log in to the Hub and access the Super Group home page
2. Click on the Manage Group Pages link in the group manager toolbar, to get to the page

manager
3. Select the Manage Modules tab to view the module manager
4. Click the New Module button in the toolbar
5. Fill in all required fields and click Save Page

 

Publishing a Module:

1. Log in to the Hub and access the Super Group home page
2. Click on the Manage Group Pages link in the group manager toolbar, to get to the page

manager
3. Select the Manage Modules tab to view the module manager
4. Publish the module by clicking on the Unpublished icon. The icon will become a 

Published icon
5. The module will now be available on the front interface of the Hub
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Unpublishing a Module:

1. Log in to the Hub and access the Super Group home page
2. Click on the Manage Group Pages link in the group manager toolbar, to get to the page

manager
3. Select the Manage Modules tab to view the module manager
4. Unpublish the module by clicking on the Published icon. The icon will become an 

Unpublished icon
5. The module will now be removed from the front interface of the Hub

 

Editing a Module:

1. Log in to the Hub and access the Super Group home page
2. Click on the Manage Group Pages link in the group manager toolbar, to get to the page

manager
3. Select the Manage Modules tab to view the module manager
4. Click on either the Manage Module button or hover over the arrow next to the button to

see more options, including Edit Module
5. One of the new features with the module manager is the page content WYSIWYG

editor. It now uses CKEditor and HTML to manage your page content
6. Modify the module with new changes, and then click the Save Page

 

Reordering a Module:

1. Log in to the Hub and access the Super Group home page
2. Click on the Manage Group Pages link in the group manager toolbar, to get to the page

manager
3. Select the Manage Modules tab to view the module manager
4. Click on either the Manage Module button or hover over the arrow next to the button to

see more options, including Edit Module
5. One of the new features with the module manager is the page content WYSIWYG

editor. It now uses CKEditor and HTML to manage your page content
6. Modify the ordering of the module by using the drop-down, and then click the Save

Page

Super Groups: Resource Template Inheritance

Originally when viewing a Resource from a Super Group, the Resource is seen with the master
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site template rather than the Super Group's custom template. Resource Template Inheritance
allows users, when viewing a Resource from a Super Group, the Resource to inherit the Super
Group's template to maintain consistent look and feel of the Super Group. '
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Configuring

Overview

One of the many advantages to HUBzero is the level of configuration that can be applied. Not
only can you configure some global site settings, but individual components, modules, and
plugins as well.

HUBzero also adds many other configuration options for extended registration information and
more.
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Registration

Overview

HUBs allow for considerable customization of the registration form for new members. While one
HUB may present fields for filling in phone, website, and organization, another may take a more
minimal approach and require only a username, password, and email address. This is all
configurable.

Making Changes

1. First login to the administrative back-end.
2. Once logged in, find “Users” in the main menu bar located toward the top of the page.

You should be presented with a drop-down menu containing a list of User related items.

3. Choose “Members” from the available options. On the resulting page, there should be a
sub-menu (tabs).

4. Choose “Register” from the available options.

5. You should now be presented with a table of available user fields and their status for a
particular action. This controls what fields the user will see, must fill in (required) or can
fill in (optional) depending upon which action or state they are currently in. That is, you
can make the username field required for the registration page (“create” column) but
may not wish for your users to be able to edit this after creation (“read only” for the
“update” and “edit” columns).

Create column
What the user sees on the registration page

Proxy column
What columns an administrator sees or must fill in when creating an account by
proxy (i.e., for someone else)

Update column
What fields the user will see and/or must fill in if something has changed with
what information is required at registration. An example of this would be if the
“citizenship” field was, at one point, optional for registration but is now required.
Setting this field to “Required” for the “Update” column will now require logged-
in users to fill this information out.

Edit column
What fields the user will see and can edit for their user profile

Field Option Definitions:
Required = Must fill in
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Optional = Can fill in
Hide = Not visible
Read only = Can view but cannot change

6. Once you feel ready to save your changes, scroll back to the top of the page and click
“Save” (the icon that looks like a floppy disk) in the upper right portion of the page.

Changes take affect immediately.

Customizing Confirmation Email

All component layouts can be customized through overrides. Except for files that are provided in
the "Joomla!" distribution itself, this method for customization eliminate the need for designers
and developers to "hack" core files that could change when the site is updated to a new version.
Because they are contained within the template, they can be deployed to the Web site without
having to worry about changes being accidentally overwritten when your System Administrator
upgrades the site. Some emails sent by the system, such as registration confirmations, are
component layouts for just this reason of customization.

Quick Overview of Output Overrides
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Layout overrides only work within the active template and are located under the /html/ directory
in the template. For example, the overrides for "corenil" are located under
/templates/corenil/html/.

It is important to understand that if you create overrides in one template, they will not be
available in other templates. For example, "rhuk_milkyway" has no component layout overrides
at all. When you use this template you are seeing the raw output from all components. When
you use the "Beez" template, almost every piece of component output is being controlled by the
layout overrides in the template. "corenil" is in between having overrides for some components
and only some views of those components.

The layout overrides must be placed in particular way. Using "Beez" as an example you will see
the following structure:

/templates
  /hubbasic
    /html
      /com_register  (this directory matches the component directory n
ame)
        /emails        (this directory matches the view directory name
)
          confirm.php (this file matches the layout file name)

The structure for component overrides is quite simple:
/html/com_{ComponentName}/{ViewName}/{LayoutName}.php.

Customizing The Confirmation Email

To override the component layout for the registration confirmation email, copy:

/components/com_register/views/emails/tmpl/confirm.php  (the email sen
t if the user resends a confirmation)
/components/com_register/views/emails/tmpl/create.php  (the email sent
 upon registration)

to:

/templates/{YourTemplate}/html/com_register/emails/confirm.php
/templates/{YourTemplate}/html/com_register/emails/create.php

                         190 / 270



HUB MANAGERS
 

If the destination directories do not exist, create them. And then edit the contents of the file(s)
you just copied.

See Template Overrides for more information on customizing layouts and CSS.

Confirmation Return URL

By default, members who have just completed the confirmation process will be directed to a
"Thank you" page. It is possible, in HUBzero, to change the redirection URL to something else.

Note: This only applies to the initial page the user sees upon confirmation of their email. To
customize the return URL members are redirected to upon login see Hub Configuration.

1. First login to the administrative back-end.
2. Once logged in, find “Components” in the main menu bar located toward the top of the

page. You should be presented with a drop-down menu containing a list of your installed
components.

3. Choose “Register” from the available options.

4. Once the page has loaded, select the “Parameters” button in the toolbar, found in the
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upper right-hand portion of the screen. Click it.

5. You should now be presented with a pop-up panel for various settings and
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configurations of your site.

Look for the option titled "Confirmation Return URL". This will most likely be the second
item in the list.

6. Enter in the textbox the URL you wish members to be redirected to and then click
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"Save".
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Components

Overview

Many components will have a set of parameters that can be configured. These parameters can
determine what functionality is presented to the user, be a default set of user options (what
profile fields are visible to site visitors by default, for instance), or settings needed for the
component to function properly. Accessing and adjusting these parameters is quick and easy. 

Note: Not all components will have configurable parameters. For those that do, the
configurations apply only to that component and should not affect any other components, site
settings, or module settings.

1. First login to the administrative back-end.
2. Once logged in, find “Components” in the main menu bar located toward the top of the

page. You should be presented with a drop-down menu containing a list of your installed
components.

3. Choose the component you wish configure from the available options. Here we've
chosen the "Hub" component.

4. Once the page has loaded, select the “Parameters” button in the toolbar, found in the
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upper right-hand portion of the screen. Click it.

5. You should now be presented with a pop-up panel for various settings and
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configurations of your site.

6. Adjust the available parameters as needed and then click "Save". Changes take affect
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immediately.
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Note: Very often a component will not function properly until component parameters have been
first inputted and saved. For instance, HUBzero tools will not work properly unless the
middleware configuration has first been defined in the tools component entry.
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Modules

Overview

Most modules will have a set of parameters that can be configured. These parameters can
determine what functionality is presented to the user, be a default set of user options, or
settings needed for the module to function properly (setting the URL to a feed for a feed reader
module, for instance). Accessing and adjusting these parameters is quick and easy. 

Note: Not all modules will have configurable parameters. For those that do, the configurations
apply only to that module instance. You may have multiple instances of a module with different
parameter configurations.

1. First login to the administrative back-end.

2. Once logged in, go to the "Module Manager." The Module Manager can be found by
selecting "Extensions" > "Module Manager" from the drop-down menu on the back-end
of your HUB installation.

3. Choose the module you wish to configure from the available list.
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4. Once the page has loaded, find the “Parameters” grouping, found on the right-hand
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portion of the screen.

5. Adjust the available parameters as needed and then click "Save" (the icon that looks like
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a star) in the upper right portion of the page. Changes take affect immediately.
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Plugins

Overview

Some plugins will have a set of parameters that can be configured. These parameters can
determine what functionality is presented to the user, be a default set of user options, or
settings needed for the plugin to function properly. Accessing and adjusting these parameters is
quick and easy. 

Note: Not all plugins will have configurable parameters. For those that do, the configurations
apply only to that plugin and should not affect component configuration, module configuration,
or site configuration.

1. First login to the administrative back-end.

2. Once logged in, go to the "Plugin Manager." The Plugin Manager can be found by
selecting "Extensions" > "Plugin Manager" from the drop-down menu on the back-end of
your HUB installation.

3. Choose the plugin you wish configure from the available list.
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4. Once the page has loaded, find the “Parameters” grouping, found on the right-hand
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portion of the screen.

5. Adjust the available parameters as needed and then click "Save" (the icon that looks like
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a floppy disk) in the upper right portion of the page. Changes take affect immediately.
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External Authenticators

Single sign-on (SSO) is a element of access control of multiple related, yet independent,
software systems. A user logs in with a single ID and password to gain access to a system
without using different usernames or passwords, or in some configurations seamlessly sign on
at each system.

Benefits of using single sign-on include:

    Mitigate risk for access to 3rd-party sites (user passwords not stored or managed externally)
    Reduce password fatigue from different user name and password combinations
    Reduce time spent re-entering passwords for the same identity
    Reduce IT costs due to lower number of IT help desk calls about passwords

SSO shares centralized authentication servers that all other applications and systems use for
authentication purposes and combines this with techniques to ensure that users do not have to
actively enter their credentials more than once.

 

CILOGON

A hub administrator must register at http://cilogon.org/oauth2/register

Enter a Client Name.
Enter a Contact Email Address.
Enter a home URL (the URL of your hub - hubzero.org, for example).
Callback URLS should be:

**<hostname> should be replaced with the HUB URL.  If you have more th
an one hub instance, include a redirect URL set for each host that you
 will wish to use CiLogon.
   
https://<hostname>/index.php?option=com_users&task=user.link&authentic
ator=cilogon
https://<hostname>/index.php?option=com_users&task=user.login&authenti
cator=cilogon
https://<hostname>/administrator/index.php?option=com_login&task=login
&authenticator=cilogon

Select all SCOPES (email, edu.., openid, profile, org.cilogon...).
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Leave blank - Refresh Token Lifetime.
Leave blank - Issuer.

CiLogon will process the registration and if approved a client id and client secret will be provided
and must be added to the "Authenticator - CILogon" plugin in the Adminstrator Interface
(/administrator) to enable to plugin.  Once enabled, users may log into your hub via credentials
provided by CiLogon.
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Frequently Asked Questions

Article Pages: How do you set parameters for articles and other content
items?

Many Article parameters, such as Show Title, Show Author, and so on, can be set form the
backend of the Hub. This can be done by logging in to the backend, navigating to the Article
Manager: Articles page (Content-> Article Manager), and then selecting the article you would
like to adjust the parameter for. By clicking the box beside the title of the article, and then
clicking the Edit button to open up the article for editing.

Typically, parameters at the individual article and menu item levels can be set to a specific value
or to a value of Use Global. If the individual article's parameter is set, then that value controls
the setting. If this is set to Use Global then the menu item parameter is checked. 

Courses: How can I view the outline a student would see in a course?

If you wish to view and check any prerequisites that have been set as an instructor you have to
enroll in the course as a student. Currently the instructor’s view of the course outline and the
outline students see are not the same. An instructor or a manager of a course will be able to
view all of the content and see that it is published or unpublished. For students, the outline they
view depends on the prerequisites for the parts of the course and what is available to them
during the course.

The best way for an administrator of a course to view what a student can see, would be to
create a testing account and enroll as a student in the course.

Groups: How do you send a group message?

Group messaging allows you to send out a message as an email to all the group members. A
Group Manager is the only one with the permissions to send out messages from the group to all
group members. To send out group messages follow these steps:

1. Navigate to https://yourhub.org/groups and log into the Hub
2. Navigate to the group page and click on the Members tab
3. Click on the email icon to send a message to all of the group members

a. To email only a specific group member, select the same icon next to the
individual’s name.

4. Compose the message by:
a. Selecting whom the message is for from the drop-down.
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b. Fill in the subject title.
c. Write up the message.

5. Click the Send button to send the message to the group                   

 

 

Projects: How do you connect Google Drive in a Project?

Note: Managers and Collaborators of a Project can connect their Google Drives, but the creator of the Project

must connect their Google Drive account prior to others adding on their accounts to the project.

1. Navigate to https://yourhub.org/projects and log into the Hub
2. Access the project that you wish to add your Google Drive to
3. Inside of the project access the Files tab and locate the Connect button
4. Click the Connect button and then click the second Connect button
5. Then choose the account or login to your Google account
6. You will be relocated to a new page where you will accept the project files to Google

Drive for various access levels. Click Accept to confirm the last step
7. Then you will be relocated back to the project confirming your Google Drive connection

to the project

Support: How do I add other attachment file extensions for tickets?

1. Navigate to https://yourhub.org/administrator and login to the as an administrative
user

2. Click on the Components tab and then click on Support
3. On the Support: Tickets page, click on the Options button
4. Inside of Support Configuration click on the Files tab
5. Under Extensions, add the new file extension that can be uploaded to a ticket
6. Click Save & Close to save the changes and to exit out of the Support

Configuration pop-up

Wishlist: How do I change the status of a wish?
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The status of a wish serves to indicate to the general site users whether the wish was
accepted/rejected for implementation and when to expect the proposed feature online. Once a
wish is submitted, an administrator of the Hub can change the status of the wish. To change the
status simply open up the wish and then click Change status which is located under the wish.
From the drop-down box select the new status of the wish:

Pending: The wish is pending a response.
Accepted: The wish had been accepted and is currently being worked on.
Rejected: The wish has been rejected due to other contributing factors that disallow the
ability to create the wish. Example: Practicality or User use case
Granted: The wish has come true and is now available to the Hub.

Once the status has been selected, click Change Status to save the new status and inform the
user who submitted the wish what stage their wish is in right now.

How do I redirect a URL to point to another existing Hub component?

Scenario: A professor has a group called "mainclass" and wants sutdents to use another group
called "spring2016class"

1. Navigate to /administrator and hover over the Menu tab and select Menu Manager
from the drop-down

2. Locate the Default menu and click on the title to enter the menu interface
3. Locate the Parent group, in this case, locate the Groups menu

1. If you can not find the parent "Groups", it might have not been created. Follow
these additional steps to create the new group:

1. Click the New button
2. Click Select and from the list select External URL from the System

Links section
3. Fill in the form:

1. Menu Title: Groups
2. Link: groups 

4. Click Save & Close to save the new menu item
4. Create the redirect portion, repeat steps 1-9 except fill out the Menu Title as 

Mainclass and the link as spring2016class
1. This will redirect users from /groups/mainclass to /groups/spring2016class

5. Nest the Mainclass under Groups to create the redirect 
1. This is done in the Menu Item Details under Parent
2. Set the Parent for Mainclass as Groups
3. Click Save & Close
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Daily Maintenance

The Dashboard

Every HUB comes with an administrative dashboard that gives you a quick overview of some
activity or items on the site that need attention.

1. Login to the /administrator interface.

2. Once logged in, you should be presented with a dashboard of categories and the activity
within them, such as “Abuse Reports”, “Support Tickets”, etc.
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Approving Content

Approving Pending Content

Depending on whether auto-approval for user-submitted resources on a Hub is turned On/Off,
which can be done in each component's settings (Options), you may need to watch for newly
submitted content awaiting for administrator approval to be published on the Hub. The
administrative dashboard shows whether content is pending approval by component.

You can publish a pending piece of content just by clicking on the title and select appropriate
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status from the detailed page, as shown below.

As soon as new content is published, it will be available for Hub users to access and search the
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item, depending on access restrictions. 
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Tools

Tool Pipeline (a.k.a. Contribtool)

The tool pipeline is the process that manages the publishing process for tool resources on the
hub. There are nine states of a tool within the tool pipeline: 

 

Each state is associated with a set of tasks that either the tool developer or the hub
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administrator must perform. We will refer to tasks the tool developer must perform as "user
tasks", and tasks the hub administrator must perform as "admin tasks". 

Preparation

To accomplish many of the admin tasks, the user acting as the admin must be a part of the
"apps" group. To be added to the "apps" group:

1. Login to the hub's administrative back end and find the "Groups" component.
2. Type "apps" into the search box.
3. Click on the number under the column "Total Members"
4. Type the admin's username into the Add input box, choose "Members" from the drop

down menu, and push the "Add users" button.

Registering a Project

The first step in the tool pipeline is for the tool developer to register the tool by filling out the tool
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contribution form. This is a user task. Go to the web page https://yourhub.org/contribute
(substituting "yourhub.org" with the name of your hub). Use the "Getting Started" button in the
upper right side of the web page to start the contribution process. On the left side of the web
page, a list of contribution types will be shown. Choose the TOOLS contribution type.

 

The tool registration form will be presented. The form asks for some basic information regarding
the name of the tool, a short description of the tool, and who can access the source code
repository. There are also fields available to add restrictions on who can run the tool once it has
been published, and who can access the Trac project area. All of the information on this page
can be changed at a later date, except for the tool name. Once the tool name has been
registered, it cannot be changed, so pick a good one. When the registration form has been
completed, push the "Register Tool" button at the bottom of the page, and the state of the tool
will be changed to "Registered"

 

Registered to Created

Once the tool has been registered by the tool developer, it is up to the administrator to create
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the project. Creating the project is an admin task. Start by going to the web page
https://yourhub.org/tools/pipeline. This page lists out all tool contributions on the hub. Tools that
require administrator attention are highlighted. If a tool has been registered by a tool developer,
but there are no tool contributions listed on the tool pipeline web page, there may be a
privileges related error. Make sure the administrator account being used is a member of the
"apps" group. Instructions on how to do this are in the section labeled "Preparation".

 

The newly registered project should be highlighted on the tool pipeline web page. Choose this
project by clicking on the tool name, which is a link to it's tool status page. The tool status page
contains the tool information that the developer provided on the registration form and a set of
Developer Tools on the left side of the web page. On the right side of the web page, the "What's
next?" status is provided, which gives information regarding the steps that need to be completed
before the tool can be published on the hub. Any tasks that have been checked off have been
completed. Tasks that have an arrow next to them are tasks that can be completed now.

 

Special for the administrator, there is a section of "Administrator Controls" on the left side of the
page, under the Developer Tools. To create the tool project, the admin must press the link
labeled "Add Repo". This starts a process that creates a Subversion source code repository,
Trac project wiki pages, and sets up access for the tool for the users listed on the development
team. When the process has completed, the results are displayed for the administrator to see. A
green box generally means nothing catastrophic has happened and the tool project are has
been successfully created. In the case something fails, a red box will be displayed listing the
errors encountered. Running the process multiple times by repeated presses of the "Add Repo"
link generally has no harmful effects, in that if the pieces of the project area already exist, they
will not be overwritten, and if they do not exist, they will be created.

 

The last step to creating the tool project area is to flip the status of the project from Registered
to Created and pressing the "Apply change" button at the bottom of the Administrator controls.

Created to Uploaded

 

 

After the tool project has been created, the tool developer needs to upload their tool source
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code into the source code repository. This is a user task. Instruction listing out the commands
involved with upload source code to the project's source code repository are easily accessible
from the tool status page in the tool pipeline. Start by accessing the tool pipeline web page
https://yourhub.org/tools/pipeline. Find the tool project on the tool pipeline web page, and click
on the tool project's name. This is a link which leads to the tool status page. While in the
Created state, the "What's next?" section on the right side of the web page contains a link to the
instructions. We will review the requirements for installing a tool in the HUB environment and
the process of doing so. 

 

 

There are four requirement for installing a tool in the HUB environment: 
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1.  Source code
2.  Graphical User Interface
3.  Makefile
4.  Invoke script

 

Source code includes all files related to running the application with the tool.xml and possibly a
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wrapper script as the exceptions. Source code is needed as a part of the installation process.
No binaries from the source code of the application should be stored in source code repository.
It is alright to store binary data files, like images, in the source code repository, but in most other
cases, storing binaries from the application instead of the actual source code leads to future
compatibility problems, even when the binaries claim to be platform independent. 

 

All tools need a graphical user interface. There are several toolkits available including Qt, GTK,
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wxWidgets, and Tcl/Tk. If your tool does not already have a graphical user interface, we suggest
using Rappture (http://rappture.org). With Rappture, you can quickly develop a graphical user
interface that can guide users through the process of running the tool and viewing results, all in
one application. Rappture also include many hooks into the HUB infrastructure, which makes it
a great choice for tool developers. 

 

All tools need a Makefile. The Makefile holds the instructions for compiling and installing binary
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files. Even tools that do not have source code that needs to be compiled still need a Makefile. 

 

All tools need an invoke script. Invoke scripts hold details about how to launch to the tool in the
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HUB environment. Generally, invoke scripts are very simple, one line calls to the HUB invoke
script with a few options. 

While generating the source code and graphical user interface are outside of the scope of this
tutorial, details will be given later regarding creation of a typical Makefile and invoke script. 

There are eight steps related to uploading source code to the source code repository. 

1.  Checkout a copy of the tool's source code repository.
2.  Add source code to the src directory of the tool's repository.
3.  Add a Makefile in the src directory of the tool's repository.
4.  Add tool.xml to the Rappture directory of the tool's repository.
5.  Check the middleware/invoke script.
6.  Test the code in the workspace.
7.  Clean the directories before committing.
8.  Commit the changes from the local copy of the repository.

All of these steps can be performed from within the workspace. 

The first step of uploading source code to the source code repository is to checkout a copy of
the tool's source code repository. This can be done by using the svn checkout command. 

 

svn checkout https://yourhub.org/tools/toolname/svn/trunk toolname
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In the example, replace "yourhub.org" with the name of the hub hosting the tool's source code
repository. Also, substitute the term "toolname" with the shortname of the tool. Executing this
command will download a copy of the tool's source code repository from the repository server,
hosted on "yourhub.org", and place the copy on the machine where the command was
executed. If the command was executed inside of a workspace, the copy of the tool's repository
server will be made inside of the workspace. This copy will be referred to as the local copy of
the tool's source code repository. The local copy of the repository will be stored in a directory,
with the name substituted for "toolname". 

The second step of uploading source code to the source code repository is to add source code
to the src directory of the tool's repository. This can be done with the svn add command. This
step involves (1) changing directories into the local copy of the repository, here referred to as
toolname, (2) copying source code files into the src directory, and (3) lastly using the svn add
command to notify the local repository that files need to be added to the source code
repository. 

 

Line    Example:
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  1       cd toolname
  2       cp /apps/rappture/examples/zoo/curve/curve.tcl src/curve.tcl
  3       svn add src/curve.tcl

All files will need to be added to the source code repository. They can be done one by one, as
shown above, or by directory. 

The third step of uploading source code to the source code repository is to add a Makefile to the
src directory. The svn add command will be used to complete this task. If a Makefile does not
exists, one can easily be created using a text editor. In the workspace, the gedit program is a
convenient text editor. From within the toolname directory, issue the command: 

 

gedit src/Makefile
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If no Makefile exists, add the following text to the file. 

 

Line    Example:
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  1       all: curve.tcl
  2
  3       install: curve.tcl
  4           install --mode 0644 -D curve.tcl ../bin/
  5
  6       clean:
  7
  8       distclean: clean
  9           rm -f ../bin/curve.tcl

In this example, the source code is a single tcl script named curve.tcl. Since the source code
does not need to be compiled in this case, the "all" target is empty. If there was source code to
be compiled, line 2 would be tabbed in once and include a compile line like "gcc -o curve
curve.c". The install target, starting on line 3, is responsible for installing the executables and
related scripts into the ../bin directory. Executables should be placed in the bin directory. Line 4
is the action of the install target. It uses the shell program named "install" to move the files from
the src directory to the bin directory, and appropriately set the permissions of the file. The clean
target, on line 6, is responsible for removing files temporary files, usually left over from
compilation. The distclean target, on like 8, calls the clean target from line 6, and then removes
the tcl script that was placed in the bin directory by the install target. The distclean target is
responsible for removing any files that were generated be install target. After running the
distclean target, the local repository should be in the same state as when it was first checked
out. 

Once the Makefile has been created, save the file and exit the gedit program. Lastly run the svn
add command on the file src/Makefile to add it to the local copy of the source code repository. 

The fourth step of uploading source code to the source code repository is to add the tool.xml file
to the Rappture directory. To add the tool.xml file to the local copy of the source code
repository, first copy the file into the Rappture directory, then use the svn add command to
notify the local copy of the repository that a file needs to be added. 

 

Line    Example:
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  1       cp /apps/rappture/examples/zoo/curve/tool.xml 
            rappture/tool.xml
  2       svn add rappture/tool.xml

The fifth step of uploading source code to the source code repository is to check the
middleware/invoke script. Inside of the middleware directory, there should exist a file named
invoke. If the file does not exist, use gedit to create it, then add it to the repository using the svn
add command, just as was done for the Makefile in step 3. The invoke script is responsible for
setting up the tool environment and launching the tool when a user clicks the Launch button
from the tool resource page. The default invoke script looks like this: 

 

Line    Example:
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  1       #!/bin/sh
  2
  3       /apps/rappture/invoke_app "$@" -t toolname

In the example above, the invoke script calls the HUB invoke script located at
/apps/rappture/invoke_app. On older hub setups, /apps/rappture/invoke_app is a file that only
supports launching rappture applications. On newer hub setups, /apps/rappture/invoke_app is a
link to /apps/invoke/current/invoke_app, which is capable of launching all rappture applications
and a majority of non-rappture applications. 

The invoke_app script accepts a number of flagged options. Some of the more popular ones
include: 

-r  Rappture version (current, dev)
-t  tool name
-T  tool root directory
-e  environment variable to set
-p  add a path to the PATH environment variable
-C  command to launch the tool
-A  additional arguments to add to the command for launching the tool
-c  commands to start in the background before launching the tool, lik
e filexfer

The example above takes advantage of the -t flag to tell invoke_app that the name of the tool is
"toolname". The invoke_app script contains more details about the available flags and how to
use them. 

The last task of this step is to ensure the middleware invoke script has execute permissions.
This is accomplished by using the shell's chmod command: 

chmod 755 middleware/invoke

The sixth step of uploading source code to the source code repository is to test the tool in a
workspace. If the tool runs properly in a workspace when started from an invoke script, it is very
likely that it will run properly when installed in the hub environment. Testing the code in the
workspace also exercises the Makefile and invoke script, ensuring they are also functioning
properly. Here are the commands: 
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Line    Example:
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  1       cd src
  2       make all install
  3       cd ../
  4       ./middleware/invoke -T $PWD

In the above example, the code is compiled and installed by (1) changing directories into the src
directory, and (2) issuing the command "make all install". The shell command "make" looks for a
file named Makefile, and runs the targets specified as its arguments. In this case, it runs the all
and install targets. Next (3) change directories back to the tool's root directory and run the
middleware/invoke script, providing the option "-T $PWD". Recall from earlier, the -T option
specifies the tool root directory. The $PWD environment variable hold the present working
directory, which in this case also happens to be the tool's root directory. When the Rappture
GUI appears, press the simulate button to make sure the tool runs correctly. 

It is important that this step is successfully completed by the tool developer. This is the same
sequence of events that the administrator will do when installing the tool in the HUB
environment. Any failures encountered while running this step will most likely be encountered
again when installing the tool in the HUB environment, so they should be resolved prior to
changing the tool status to Uploaded in the tool pipeline. 

The seventh step of uploading source code to the source code repository is to clean up the local
copy of the repository before committing. This will again utilize the Makefile located in the src
directory. Here are the commands: 

 

Line    Example:
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  1       cd src
  2       make distclean
  3       cd ../

Earlier the Makefile was setup with a distclean target to clean up all files generated from the
installation of the tool's source file. In this example, the distclean target of Makefile is called to
do the cleanup of the previous install. It is important to clean up the repository before
committing to avoid placing unnecessary binary and other temporary files into the source code
repository stored on the repository server. 

The eighth and last step of uploading source code to the source code repository is to commit
the changes from the local copy of the repository to the repository server. This is accomplished
by using the command svn commit. The svn commit command accepts the --message flag
along with a message. With every commit to the repository, a message should be included
detailing what is being committed. This will help later when searching for specific versions of the
tool in the source code repository. Commits can be made from any directory in the local copy of
the repository, but will only include files and directories underneath the present working
directory. For this reason it is usually convenient to commit from the local copy of the
repository's root (top) directory. Here is an example commit command with a message: 

 

svn commit --message "initial upload of code"
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After issuing the svn commit command, a prompt may appear requesting a username and
password. Enter the username and password credentials for the HUB hosting the tool's source
code repository. 

Once the tool's source code has been uploaded to the repository server, the tool's status can be
changed to Uploaded. Go to the tool's status web page in the tool pipeline, it can be found
through the tool pipeline web page:  

 

https://yourhub.org/tools/pipeline.
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To make sure the source code was successfully committed, use the Timeline link under the
Developer Tools section on the left side of the web page. The Timeline link will open a web
page with the tool's project area. Note that the tool's project area may have restricted access
that requires the user to login. The timeline lists out the most recent changes to the source code
repository. The most recent changes for uploaded code should be listed at the top. Make sure
the uploaded code is listed in the Timeline. 

Back on the tool's status web page in the tool pipeline, there should be a "We are waiting for
You" section under the "What's next?" section on the right side. When ready to change the
status of the tool from Created to Uploaded, click the link labeled "My code is committed,
working and ready to be installed". Clicking the link will change the status. 

Uploaded to Installed

 

 

Once the tool has been uploaded by the tool developer, it can be installed in the HUB
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environment. This is an admin task. Navigate to the tool's status web page in the tool pipeline.
Under the Administrator Controls section, on the left side of the web page, will be a link labeled
Install. Clicking the Install link will start the installation background process which performs an
svn checkout of the tool's source code repository into the /apps directory. The next step requires
that the administrator login to the system, become the "apps" user, and compile the code. This
can all be accomplished within a workspace.  

 

 

Inside of a workspace issue the following commands in an xterm: 
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Line    Example:
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  1       sudo su - apps
  2       cd /apps/toolname/dev/src
  3       make all
  4       make install

Become the apps user by using the shell's sudo command. If there are errors while becoming
the apps user, go back to the beginning of this tutorial and ensure the login account being used
is a member of the "apps" group. Change directories to the tool's installed dev directory,
/apps/toolname/dev. Inside of the src directory, run the "make all" and "make install" commands
to compile and install the code. 

When the source code has been compiled and installed, go back to the tool's status page in the
tool pipeline, flip the status from Uploaded to Installed, and press the Apply change button.
Pressing the Apply change button will update the tool status web page. 

 

 

On the updated page, a Launch tool link will be made available, on the right side of the page, in
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the "What's next?" section. Click the Launch tool link and verify that the tool properly launches
and runs. 
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Installed to Updated

 

 

It is the tool developer's responsibility to test the operation of the tool and validate that it
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generates acceptable results. The tool developer may find an error or otherwise needs to
update the code in the source code repository and have the tool reinstalled. Updating the tool is
a user task. Any new changes to the tool should be committed to the source code repository.
Next, the tool's status in the tool pipeline should be changed to the Updated state. Changing the
status will notify the administrator that the tool is ready to be installed again. 

Installed to Approved

 

 

When the tool developer feels the tool is working properly, the approval process can be started.
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Tool approval is a user task. To approve a tool, the tool information page must be created. The
tool information page is the web page listing the authors of the tool, credits, publications, and
screen shots. To create the tool information page. Click the "Create this page" link in the
"What's next?" section on the tool status page in the tool pipeline. 

 

 

During the process of creating the tool information page, the necessary information will be
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collected and formatted. At the end of the process a preview page will be provided. The tool
developer will need to confirm the layout and information on the preview tool page. 

 

 

The tool developer will also need to choose a license under which the project will be published.
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Be sure to replace the template text in the license with the appropriate information. 

 

 

Finally, approve the tool by pushing the button labeled "Approve this tool". The status on the
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tool's status page in the tool pipeline will automatically be updated. 
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Approved to Published

 

 

To publish a tool in the Approved state, the administrator must click the Publish link in the
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Administrator Controls on the tool's status page in the tool pipeline. This is an admin task.
Clicking the Publish link updates the database, exposing the tool information page on the HUB.
From the tool information page, the tool can be launched using the Launch tool link. The Publish
link will run the publishing process and return the results to the administrator. Similar to the
Installed state, successful completion will result in a green box with results. Failure will result in
a red box with errors. After the results have been presented, flip the status from Approved to
Published. and press the Apply change button. 

 

 

                         249 / 270



HUB MANAGERS
 

Published to Updated

 

 

When the tool developer is ready to start testing a new release of the tool, they will commit all
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changes to the source code repository, and change the status on the tool's status page in the
tool pipeline, from Published to Updated. Changing the status from Published to Updated does
not unpublish of otherwise change the state of the already published tool. Changing the status
will notify the administrator that the tool needs to be reinstalled. From here, the Install-Approve-
Publish cycle continues. 

Published to Retire

 

 

The tool developer has the option of retiring a tool. Generally, published tools are not retired,
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and live in perpetuity. Changing the status from Published to Retired places the tool in a state
where nobody can run it from the tool information page. The tool information page will still exist,
as a placeholder for the previously published resource. 

                         252 / 270



HUB MANAGERS
 

Support Tickets

Tickets: Best Practices

Users can create tickets when they experience a problem on the Hub that is not answered in 
Questions and Answers or Knowledge Base. Tickets are ways to report bugs or issues that
they experienced with the Hub. Administrators are then able to access the Support component
to help solve these issues.

In order to understand how tickets are submitted by users, read our Hub User Support
Documentation. It is important to learn about giving Hub Managers/Administrators the proper
permissions to access the Hub's tickets and setting up custom ticket messages and categories.
Learn about how you can complete these tasks by reading our Hub Manager Support
Documentation.

When a new ticket is submitted by a user, it is best if a Hub Manager/Administrator tries to
respond with an initial message which notifies the customer that their ticket has been received
by the Hub team and will be worked on shortly.

The Hub Manager/Administrator would then review the ticket and see if the user provided
enough information to understand either the Issue, Request or Question.

Issue: A problem ("bug") the user experienced on the Hub or "bug"; a matter or situation
regarded as unwelcome by the user.
Request: An act of asking for a change in feature design or permission to access an
area of the Hub currently restricted.
Question: An inquiry about a feature or item related to the Hub or Hub's community.

Best practices indicate that these three questions should be answered either by the user of can
be filled in by the Hub Manager/Administrator after reviewing the ticket:

1. What was the user trying to do?
2. What did they expect to happen?
3. What actually happened?

For example, John Doe submitted this ticket:

The Hub Manager/Administrator understands that from John Doe's description, he has reported
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an Issue and can answer the following questions:

1. What was the user trying to do?

                    Trying to search for the word 'test' in the Forums feature.

2. What did they expect to happen?

                    The user expected to page to load with search results related to 'test'

3. What actually happened?

                    The user received a 500 error (see screenshot provided by user)

Once the ticket has been appropriately addressed and understood by a Hub
Manager/Administrator, it can then be assigned to the appropriate individual or group (i.e.
software developers, Hubzero Development Team, etc.). By following these best practices, both
users and Hub management teams can experience an efficient and professional service
relationship.
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Site Notices

Overview

1. Login to the Hub's /administrator.
2. Hover over Extensions and then click Module Manager from the drop-down.

3. You should now be presented with a list of all the modules installed on your site. There
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are a variety of methods to find the specific module you wish to edit: you can filter by
selecting position, type, or even state (enabled, disabled). The site notice module would
be in position notices and of type mod_notices. You may also search for notices in
the filter search box or scroll to the bottom of the page and navigate your way through
the entire list. Once found, click the module name to edit it.

4. Once in edit mode you will be presented with some options such as the title, position,
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etc. Typically, you will not need to edit anything found in the Details section. The items
that will most often be changed are under Parameters. Here you can set the following:

Start Publishing
This determines when you wish the site notice to start’ showing on the site.

Finish Publishing
This determines when you wish the site notice to stop showing on the site.

Alert Level
3 levels available: low, medium, and high. This determines the appearance of
the site notice (such as eye-catching red for “high”).

Module ID
A CSS ID to be applied to the module. Typically, you will not need to change
this.

Message
The notice you wish to display.

Note: The “Position” must be set to Notices, otherwise the banner will not show up, or it
will not show up where you intended it to.

5. Once your parameters are set, move down to the Menu Assignment portion. This
section determines what pages of your site you wish the notice to appear on. This will
typically be set to All.

Note: If the menu assignment is set to none, your notice will NOT appear on any page
of the site, even if it is published and the timeframe is within the publishing window set in
the Parameters section.

6. Return to the top of the page and click Save in the upper right portion of the page.
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Scheduled Tasks

Overview

A cron component is available for managing and running scheduled tasks for your Hub.

The Cron Job Manager can be found by logging into the /administrator interface. Once logged
in, hover over Components and clicking on Cron from the drop-down.

What is cron?
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Cron is the name of program that enables unix users to execute commands or scripts (groups of
commands) automatically at a specified time/date. It is normally used for sys admin commands.

A hub has a specific cron job that calls to the CMS. From there the code executes a list of jobs
that can be created, published/unpublished, modified, and deleted via the administrator
interface.

Create/Edit Jobs

When you create a new job, you will select the event to trigger. Each event calls to a specific
plugin and performs its own set of tasks.

All jobs have two sections that are the same: Details and Recurrence. The Parameters are
different for each event.

Details

Event
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This displays the system name of the module. No entry is allowed.
Title

The Title of the Module.
State

Whether or not the job is enabled. If "No", the job will not be run.
Recurrence

This is how often a job should be run. Several common values are provided--such as
"run once a day, midnight"--with the option to specify your own by selecting "custom"
front he drop-down list.

Recurrence

Parameters
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This will vary between events.
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Getting Started: Advanced Setup

Your Hub's Getting Started Page

Your hub should have a getting started page at <your hub url>/gettingstarted. Most of the items
addressed on this page are discussed in further detail below.

Editing "About You", "How to Contact", & "Terms of Use" Pages

1. First login to the administrative interface of your hub
2. Once logged in, find Content in the main menu bar located toward the top of the page
3. Click on the Article Manager link
4. You should now be presented with a list of all the content articles. There are a few

methods to find the specific entry you want to edit. You can filter by state, category,
author, etc. or search for the title of the article page.  A third option would be to look
through the list manually, if you really want

5. Please find the About Us page as we will use that as an example. Once found, click the
article title to edit it

6. You now should be presented with a page where you can edit the text, title and other
page parameters similar to the image below

7. When your edits are complete, click the Save & Close toolbar button to save your
changes and return you to the Article Manager screen

8. Alternatively, you may click the Save toolbar button to save your article but leave it open
for editing

 

Facebook Authentication

Step 1: Setting Up Facebook 

1. Navigate to (https://developers.facebook.com)
2. Begin by logging into a Facebook account or creating a new Facebook account for your

hub
3. After successfully logging into Facebook, click the My Apps tab, then in the drop-down

select Register as a  developer
4. Read through the Facebook policies and accept the policies by changing the answer

from No to Yes with the switch button, and then click Register
5. Select the My Apps tab again and from the drop-down click Add a New App
6. Select the platform of the new app by clicking the WWW or "Website" icon
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7. In the upper right corner of the page, select the Skip and Create App ID button
8. Fill in the Display Name in the name field and select the category of the application

depending on your field
9. Fill in the rest of the New App ID information or leave it blank depending on your

preference, then click Create App ID
10. On the application dashboard, copy the App ID and App Secret. In order to copy the App

Secret you will have to click Show in order to access the full secret code

Step 2: Enabling Facebook

1. Navigate to your hub, and access the /administrator interface
2. Click the Extensions tab and then from the drop-down select Plug-in Manager
3. Locate the Authentication-Facebook plug-in and open the plug-in by clicking the plug-

in name
4. Inside the plug-in, change the status of the plug-in from Disabled to Enabled
5. Insert the App ID and Consumer Secret into the corresponding fields and click Save &

Close
6. The Facebook Authentication will be available for users to use in order to login into the

hub

 

LinkedIn Authentication

Step 1: Setting Up LinkedIn

1. Navigate to (https://www.linkedin.com/secure/developer)
2. Begin by logging into a LinkedIn account or creating a new LinkedIn account for your

hub
3. After successfully logging into LinkedIn, under the list of applications click Add New

Application
4. Fill out the form to register a new application

Under Default Application Permissions, check "r_basicprofile" and
"r_emailaddress".
Under OAuth 2.0, add your hub's URL (e.g., https://yourhub.org) as an 
Authorized Redirect URLs.

5. Click Add Application once you have finished filling out all the required fields in the
application form

6. Once you receive a message stating, Your application was successfully created,
copy the API key and the Secret key

Step 2: Enabling LinkedIn
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1. Navigate to the /administrative interface of your hub
2. Under the Extensions tab select from the drop-down Plug-in Manager
3. Inside the Plug-in Manager, locate the Authentication-LinkedIn plug-in
4. Select the title of the plug-in, then inside the plug-in fill in the API key and the Secret key
5. Enable the plug-in by selecting from the Status drop-down, then click Save & Close to

save the changes that were made
6. The LinkedIn plug-in will be successfully enabled and available for users to use as

another option to log in to your hub

 

Google Authentication

Step 1: Enable the Google+ API

1. Navigate to the Google Developers Console (https://console.developers.google.com/)
and log into a Google Account or create a new Google account for your hub

2. Select Credentials and click Create Credentials and then click OAuth Client ID
3. Add the following URLs as redirects

1. https://yourhub.org/index.php?option=com_users&task=user.login&authenticator
=google

2. https://yourhub.org/index.php?option=com_users&task=user.link&authenticator=
google

4. Save and collect your Client ID and Client secret

Step 2: Enable the Authentication-Google Plug-in

1. Once you have collected your Client ID and Client secret, log into the /administrator
interface for your hub 

2. Select the Extensions tab and then from the drop down select the Plug-in
Manager button

3. Locate the Authentication-Google plug-in and select the plug-in's title
4. Inside the plug-in, locate the Status section and select Enable from the drop-down
5. Fill in the Client ID and Client Secret into the appropriate fields
6. Save all the changes by clicking Save & Close
7. Your users will be able to log into your instance with Google authentication

 

ORCID Authentication
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Step 1: Set Up ORCID Authentication on ORCID

1. Navigate and sign-in to ORCID
2. Once signed-in, navigate to https://orcid.org/developer-tools
3. Complete the developer form:

a. Name of application
b. Website URL
c. Description
d. Redirect URLs

i. https://yourhub.org/index.php?option=com_users&task=user.link&authen
ticator=orcid

ii. https://yourhub.org/index.php?option=com_users&task=user.login&authe
nticator=orcid

4. Click the “Save” icon on the right side
5. Copy Client ID and Client secret

Step 2: Enabling ORCID

1. Navigate back to your hub and log into the /administrative interface
2. Click on the Extensions tab and the and select from the drop-down the Module

Manager
3. On the Plugin Manager page and locate ORCID from the new module list
4. Fill in the Client ID and Client Secret into the appropriate fields
5. Save all the changes by clicking Save & Close

 

CI Logon

Step 1: Set Up CI Logon

1. Navigate to cilogon.org/oauth2/register and begin filling out the form:

1. Client Name: Name of the Hub

2. Contact Email: Main email to receive information; best if we use our mailman set-
up for the support contact list (support@hubname.org)

3. Callback URLs:

1. https://hubname.org/index.php?option=com_users&task=user.login&auth
enticator=cilogon

2. https://hubname.org/users?authenticator=cilogon
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3. https://hubname.org/administrator/index.php?option=com_login&task=log
in&authenticator=cilogon

4. https://hubname.org/index.php?option=com_users&task=user.link&authe
nticator=cilogon

4. Client type: Confidential

5. Scopes: Select all in the list

6. Refresh Token: No

2. Click “Register Client”

3. You will receive on the next page the client ID and client secret; save both

Step 2: Enabling CI Logon

1. Navigate to hubname.org/administrator and sign in as an administrator

2. Once signed in, navigate to “Extensions” and then “Plugin Manager” 

3. Search and click on the “CI Logon Authentication” plugin

4. Add in the client ID and client secret and set-up the plugin to use the site login and
optionally also allow administrator login

5. Click “Save & Close”

6. CI Logon will email the contact once they have confirmed the request and you can now
use CILogon to sign into the hub

 

Google Analytics

Step 1: Set Up Google Analytics on Google

1. Navigate to (google.com/analytics) and select Access Google Analytics
2. You will be required to login to a Google account.

1. We suggest creating a Google Account for your hub
3. Click Sign Up and begin filling in the required fields in the analytics form
4. Select Get tracking ID, and then read and accept the terms of Google Anayltics by
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clicking I accept
5. You will receive a tracking ID. This ID will be used on the hub in order to finish the set up

process 

Step 2: Enabling Google Analytics 

1. Navigate back to your hub and log into the /administrative interface
2. Click on the Extensions tab and the and select from the drop-down the Module

Manager
3. On the Module Manager page click the New button and locate Google Analytics from

the new module list
4. Open the new module by clicking on it's title then fill in the tracking ID, title, and the

position of the module to be in the footer (typically, this module should be in a position
present on every page--for HUBzero-built templates, that tends to be position footer)

5. Click Save & Close and Google Analytics will be installed in your hub

 

Google Drive

Step 1: Configuring Google Drive in Projects on a hub

1. Navigate to console.developers.google.com and log in with your hub Gmail account
2. Click Create Project to create a new project for your hub

1. Enter the Project Name. We suggest using your hub name
2. Enter the Project ID.  The Project ID is a globally unique identifier that cannot be

renamed.  Use the ID given, or specify a new one in the field
3. Click Create

3. Once created, click the link to your project to open it
4. From the Dashboard, click “Enable an API” to select services for the project. From this

list, find and turn on Drive API and Drive SDK services by clicking Off next to each to
switch them to On.   Be sure to accept Terms of Service if asked

5. Next, navigate to the left hand menu to find APIs & auth. Click Consent Screen to set
up the branding information. Fill in all required fields

1. Choose the hub email account from the Choose your email dropdown
2. In Product name, type Project Files to Google Drive Connector
3. Click Save

6. Next, click  Credentials under APIs & auth
7. Click Create new Client ID
8. On the Create Client ID screen, choose Web Application under Application Type
9. In the Authorize Javascript orgins field, type your hub URL (i.e. https://yourhub.org)

10. In the Authorized Redirect URIS field,  type your hub URL and add /projects/auth (i.e.
https://www.yourhub.org/projects/auth)
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11. Click Create Client ID
12.  Under Client ID for web application, note the Client ID and Client Secret, as these will

be needed
13. Under Public API Access, click Create New Key
14. Choose Browser key from the Create a new key pop-up
15. In the HTTP Referrers field, type in your hub name followed by/* 

Example: yourhub.org/*
16. Click Create. Note the API Key: After this step, you will navigate back to the hub to

configure

Step 2: Turning on Google Drive in Projects

1. Navigate the /administrator interface for your hub and log in
2. Navigate to the Extensions menu, and click Plug-in Manager
3. In the search, type Projects, and click Search
4. In the results, find the Projects – Files plugin. Click the title to edit
5. Scroll down until you see the Google Connection Enabled option
6. Choose Yes from the drop-down
7. Fill in the Google Client ID, Client Secret, and API Key fields with the information from

your account
8. Choose when to auto-sync
9. If you would like to only make Google Drive available to certain projects, type the alias of

the project into the Connected Projects
10. Click Save & Close

 

CKEditor

CKEditor is a HTML text editor designed to simplify web content creation. It’s a WYSIWYG
editor that brings common word processing features directly into the web pages being built.
After a hub has been updated to R1.3.0 various settings need to be adjusted on the
administrator backend of the hub to allow CKEditor for all users.

Step 1: Global Configuration

1. Navigate to the /administrator interface for your hub, and log in
2. Select the Site tab from the top menu
3. Click on the Global Configuration from the drop-down to open up the global

configuration settings
4. Under the Site tab navigate to Site Settings and then locate Default Editor
5. Select Editor-CKEditor from the drop-down
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6. Click Save & Close to save the newly changed settings

Step 2: HTML Format Handler Plug-in

1. Navigate to the /administrator interface for your hub, and log in
2. Select the Extensions tab from the top menu
3. Click on the Plug-in Manager from the drop-down
4. Enter Content – HTML Format Handler into the search box and click Search
5. Click on the Content – HTML Format Handler title to open up the plug-in
6. In Details change the status to Enabled and then click Save & Close

 

ReCAPTCHA

Step 1: Set Up ReCAPTCHA on Google

1. Navigate to (https://www.google.com/recaptcha/intro/index.html) and select Get
reCAPTCHA

2. You will be required to log in to a Google account, at this point consider creating a new
account for your hub or use a previously created account

3. Fill in the Label field and Domain field with the appropriate information
4. Copy the Site key and Secret key

Step 2: Enabling ReCAPTCHA 

1. Navigate to the /administrator interface for your hub, and log in
2. Select the Extensions tab and from the drop-down select Plug-in Manager
3. Locate the CAPTCHA-ReCAPTCHA plug-in and click on the title
4. Change the status of the plug-in from Disabled to Enabled, then fill in the Public key

and the Secret key
5. Save the changes by clicking Save & Close, then ReCAPTCHA will be activated on

your hub
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